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Congratulations on choosing our product!
Thank you very much for purchasing our product. To obtain the best performance from this device
and to ensure safe and correct operation, please read this Instruction Manual carefully, and then
keep it in a safe place together with your warranty.

Please read before using this product
For designing beautiful embroidery designs
•

This system allows you to create a wide variety of embroidery designs and supports a wider
range of sewing attribute settings (thread density, sewing pitch, etc.). However, the final result
will depend on your particular sewing machine model. We recommend that you make a trial
sewing sample with your sewing data before sewing on the final material.

For safe operation
•
•

Do not save any files on the "Palette Software Key" for transferring or storage.
Do not plug the "Palette Software Key" into your sewing machine.

For a longer service life
•
•
•

When storing the "Palette Software Key", avoid direct sunlight and high humidity locations. Do
not store the "Palette Software Key" close to a heater, iron or other hot objects.
Do not spill water or other liquids on the "Palette Software Key".
Do not drop or hit the "Palette Software Key".

For repairs or adjustments
•

In the event that a malfunction occurs or adjustment is required, please consult your nearest
service center.

Notice
•
•

Since this "Palette Software Key" device is required to run the software, its replacement value
is the retail price of the software. Please keep in a safe place when not in use.
Neither this Instruction Manual nor the Reference Guide explains how to use your computer
under Windows®. Please refer to the Windows® manuals.

Copyright acknowledgment
Windows® is a registered trademark of Microsoft Corporation. Other product names mentioned in
the Instruction Manual and Reference Guide may be trademarks of registered trademarks of their
respective companies and are hereby acknowledged.

Caution
The software included with this product is protected by copyright laws. This software can be used
or copied only in accordance with the copyright laws.

SAVE THESE INSTRUCTIONS
This product is intended for household use.
For additional product information and updates, visit our website at:
www.babylock.com
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How To Use Manuals
The following manuals are included with this software.

Reference Guide
Read this guide before using the software. This guide contains instructions and precautions necessary to
begin using the software. The second half is filled with tutorials that use key features to create embroidery
patterns as well as project examples.

Instruction Manual
This manual contains instruction on how to use the Palette software.
First, read "Palette Software Key", "Starting Up/Exiting Application", "Comparison of Types of Data Created
With Palette Ver.10", "Example of Importing Embroidery Data" and "Understanding Windows" to gain a
general understanding of the basic software applications.
Next, read "Basic Layout & Editing Operations". This chapter provides procedures for creating embroidery
patterns as examples for performing basic Layout & Editing operations and transferring patterns to the
embroidery machine. Follow the procedures to create actual embroidery patterns.
The chapters dedicated to each application provide descriptions of the useful functions and the various
settings. Each descriptive title allows you to easily find the information that you need. In the chapters
containing tutorials, follow the procedures to practice the various operations. Afterward, read the detailed
descriptions.
Additional information is provided in the following chapters. Read the appropriate chapter when necessary.
Support/Service: Provides warranty information for this product in addition to the procedure for updating the
software.
Supplement: Provides function introductions, details on the settings available in the [Options] dialog box and
troubleshooting procedures in addition to tips and precautions to maximize the use of this software.
Menus/Tools and Reference: Provides lists of sew types, sewing attributes and fonts in addition to the various
commands.
The procedures in this manual are written for use in Windows® 8.1. If this software is used on an operating
system other than Windows® 8.1, the procedures and appearance of the windows may differ slightly.

■ Opening the Instruction Manual (PDF format)
This manual is provided in a PDF format on the included "Palette Software Key". The Instruction Manual is
also installed during software installation.
Click the down arrow in the bottom-left corner of the [Start] screen to show the [All Apps] view, and then Click
[Instruction Manual] under the title [Palette Ver.10] in the screen. (For Windows® 7 or Windows Vista®
users: Click [All Programs], then [Palette Ver.10], then [Instruction Manual].)
Otherwise, with any application other than Design Database, click

, then [Instruction Manual].

With Design Database, click [Help], then [Instruction Manual].

b
• Adobe® Reader® is required for viewing and printing the PDF version of the Instruction Manual.
• If Adobe® Reader® is not on your computer, it must be installed. It can be downloaded from the Adobe
Systems Incorporated Web site (http://www.adobe.com/).
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Support/Service
Technical Support
Contact Technical Support if you have a problem. Go to www.babylock.com, then click on Customer Support.

a
• Have the information ready before contacting Technical Support.
 Make sure your computer's operating system is current with all updates.
 Have the make and model of your computer and Windows® Operating System. (Refer to the Reference
Guide for system requirements.)
 Information on error messages that appear. This information will help expedite your questions more
quickly.
 Make sure Palette Ver.10 is current with any updates.

Online Registration
If you wish to be contacted about upgrades and provided with important information such as future product
developments and improvements, you can register your product online by following a simple registration
procedure.
Click
in Layout & Editing, then [Online Registration] to start up the installed Web browser and open the
online registration page on our Web site.
The online registration page on the Web site appears when the following address is entered in the address bar
of the Web browser.
www.babylock.com/register

b
Online registration may not be available in some areas.
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Support/Service

Checking for the Latest Version of the
Program
Click
in Layout & Editing, then [Check for Updates].
The software is checked to determine whether or not it is the latest version.
If the message shown below appears, the latest version of the software is being used.

If the message shown below appears, the latest version of the software is not being used. Click [Yes], and
then download the latest version of the software from the Web site.

b
If the [Always check for most recent version at startup] check box is selected, the software is checked
at startup to determine whether or not it is the latest version.

6

Palette Software Key
In order to use Palette Ver.10, the included "Palette Software Key" must be plugged into a USB port of the
computer.
The "Palette Software Key" prevents unauthorized use of this software. The software cannot be started if the
"Palette Software Key" is not plugged in.

a
• The "Palette Software Key" cannot be used as USB media. Do not save embroidery files on the "Palette
Software Key" for transferring or storage.
• When the "Palette Software Key" is plugged into a USB port of the computer, the [AutoPlay] dialog box
appears. Do not use this dialog box. Click

to close the dialog box, and then start up Palette Ver.10.

• When the message "Do you want to scan and fix Removable Disk (E:)?" appears, select [Continue
without scanning] and then start up Palette Ver.10. The drive name for the Removable Disk differs
depending on computers.

• To unplug the "Palette Software Key" from the computer, click [Start] - [Computer], right-click the "Palette
Software Key", and then click [Eject].
• Do not format the "Palette Software Key".
• We recommend that you back up this software in order to prepare for unexpected problems.
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Comparison of Types of Data Created
With Palette Ver.10
Three types of data are used in Palette Ver.10.
Stitch pattern: Built-in embroidery data (created through a conversion in Palette Ver.10)
Text pattern: Data created with the [Text] tools
Shape pattern (Outline pattern): Data created with the [Shapes] tools. A uniform/multiple sewing
direction(s) are applied to the entire region.
Each data can be converted to another type as shown below. The arrows indicate the directions in which data
can be converted. The methods of editing the data differ depending on the data type.

Shape pattern
Change the shape by
editing needle drop points.

You can specify region and line sew types as well as
sewing attributes, edit paths (by moving/deleting
points, reshaping through handle movements or by
splitting/connecting lines at points), change the
sewing direction, input/edit stamps, apply
embossing/engraving effects, remove/merge
overlapping regions, set hole sewing, split outlines
and create offset lines and floral patterns.
For example, when a stitch pattern is converted to
shapes, the sew types and sewing attributes can be
changed, and the shapes can easily be edited and
resized. When text pattern is converted to shapes,
the sewing direction and character shapes can be
edited and offset lines can be created.

Stitch pattern

Change the shape
by editing paths.

Text pattern

Shape pattern

Edit the text or
change the font.

Stitch pattern
You can edit (reshaping by moving/deleting points
or splitting/connecting lines at points) points (needle
drop points) and split stitches; however, you cannot
specify region and line sew types or sewing
attributes.

Functions that are not available with one data type
may be performed if the data is converted to a
different type. Convert data to the type that allows
you to perform the operations necessary for creating
the desired embroidery data.

Text pattern
You can edit text by entering/deleting characters,
specify text attributes (such as the font or the
transformation shape) and specify sewing
attributes.
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Starting Up/Exiting Applications
Starting Up the Application
Click the down arrow in the bottom-left corner of the [Start] screen to show the [All Apps] view, and then Click
[Palette Ver.10 (Layout & Editing)] under the title [Palette Ver.10] in the screen.
When the application starts up, the Startup Wizard appears.
cc "About the Startup Wizard" on page 10

b
For Windows® 7 or Windows Vista® users: Click
click [Palette Ver.10 (Layout & Editing)].

, then [All Programs], then [Palette Ver.10], and then

Exiting the Application
Click

9

, then [Exit].

Starting Up/Exiting Applications

About the Startup Wizard
h

When [Layout & Editing] starts up, the following
wizard appears.
b

a

c

g

j

Open Embroidery Design
Click this button to open embroidery data
(.pes).

cc "Opening a Layout & Editing file" on
page 90
i

Start Design Database to Manage
Embroidery Files
Click this button to start up Design
Database.

cc "Design Database" on page 240
j

d

a

e f

l

k

i

Click this button to open the Instruction
Manual (in PDF format).

h

Use Template Designs
Click this button to start the [Template
Wizard].

cc "Tutorial 2: Using Templates" on
page 101
b

Create Embroidery Patterns Using
Images
Click this button to start the wizard for
creating an embroidery pattern from an
image.

cc "Stitch Wizard: Automatically Converting
an Image to an Embroidery Design" on
page 131 and "Importing Image Data" on
page 150
c

k

Always show Wizard at Startup
Select this check box to start up the
wizard each time Layout & Editing is
started up.

l

Close this Wizard
Click this button to close the Startup
Wizard without performing an operation.

b
To open the wizard while you are using the
[Layout & Editing], click
at the top of the
window (in the [Quick Access Toolbar]), or click
and then select [Wizard] from the command
menu.

Set Hoop Size and Fabric
Click this button to specify the size of the
Design Page (embroidery hoop size).
The fabric to be embroidered can be
selected, and the sewing attributes
appropriate for that fabric can be
specified.

cc "Specifying the Design Page Settings" on
page 14 and "Recalling a group of
settings from the list" on page 192
d

,e
,f
Click these buttons to import the pattern
shown on the button from the [Import]
pane.

g

Most Recently Used Files
Select a thumbnail of the most recently
used file from the list, and then click
[Open] to recall the file.
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Understanding Windows
Layout & Editing Window
3

4

5

1
2

7

6

10
8
11

12

9
1

Application button
Click to display a menu containing commands
for file operations, such as [New], [Save],
[Print] and [Design Settings].

2

Ribbon
Click a tab at the top to display the
corresponding commands.
Refer to the name below each group when
selecting the desired command. Clicking a
command with the
mark displays a menu
containing a choice of commands.
Some other tabs may appear depending on the
tool or embroidery pattern that is selected.
These tabs contain various commands for
performing operations with the selected tool or
embroidery pattern.

11

13

14

15

Example: When the Shapes (Rectangle) tool is
selected

3

Quick Access Toolbar
This contains the most frequently used
commands. Since this toolbar is always
displayed, regardless of the Ribbon tab that is
selected, adding your most often used
commands makes them easily accessible.
cc "Customizing Quick Access Toolbar" on
page 300

4

Option button
Click this button to start up other applications
and specify application settings, such as user
thread charts.

Understanding Windows
5

Help button
Click this button to display the Instruction
Manual and view information about the software.

6

Sewing Order pane
This pane shows the sewing order. Click the
buttons at the top of the pane to change the
sewing order or thread color.

7

Import/Color/Sewing Attributes/Text
Attributes panes
This pane combines tabs for importing
embroidery patterns as well as for specifying
thread colors, sewing attributes and text
attributes. Click a tab to display the available
parameters.

8

Stitch Simulator pane
The Stitch Simulator shows how the pattern will
be sewn by the machine and how the stitching
will appear.

9

Design Page
The actual part of the work area that can be
saved and sewn.

b
• Panes 6, 7 and 8 can be displayed or hidden
from the [Show/Hide] group in the [View] tab. In
addition, these panes can be displayed as
separate dialog boxes (Floating) or attached to
the main window (Docking).
• Position the pointer over a command to display
a ScreenTip, which provides a description of the
command and indicates its shortcut key.

10 Work area
11 Status Bar
This displays the size of the embroidery data,
the number of stitches or a description of the
selected command.
12 View mode buttons
Click a button to change the View mode.
13 Show grid button
Click to switch between displaying and hiding
the grid.
14 Design Property button
Click to display a dialog box containing sewing
information for the embroidery data.
15 Zoom slider
This displays the current magnification ratio.
Click to specify a value for the magnification
ratio.
Drag the slider to change the magnification ratio.
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Example of Importing Embroidery Data
Using the Import pane
Embroidery data can be imported by using the
[Import] pane.

Using Import commands
1
2

a
b

Click the [Home] tab.
Click [Import Patterns] in the [Import] group,
and then click [from Design Library], [from
File], [from Card] or [Decorative Pattern]
from the [Import] menu.

c

d

a

From
Select a pattern location.

b

Category
Select a pattern category.
The categories in the pattern location
selected in the [From] selector are listed.

c

The patterns in the category selected in
the [Category] selector appear in the list.
Pointing to a pattern and holding down the
left mouse button displays a dotted box in
the Design Page. This allows you to
check the size of the pattern.

d

Import
Click this button to import the selected
pattern.

b
• The pattern can also be imported by doubleclicking it in the list or by dragging it to the
Design Page.
• Multiple files cannot be selected to be imported
at the same time.
cc "From a folder" on page 91 and "From an
original card" on page 92
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 The [Import] pane appears on the right
side of the screen.

b
The [Import] pane can also be displayed by
selecting the [Import Pane] check box in the
[View] tab.

When the [Color] pane, [Sewing Attributes]
pane or [Text Attributes] pane is displayed, click
the [Import] tab to display the [Import] pane.

Basic Software Settings
Specifying the Design Page Settings
The color and size of the Design Page can be changed. You can select a Design Page size according to the
size of hoop that you will be using with your embroidery machine. You can also specify a custom size for the
Design Page for embroidery patterns that will be split and embroidered in multiple sections.

1

Click

d

, then [Design Settings].

Custom Size
Specify a custom size for split embroidery
patterns.
Select this option, and then type or select
the desired width and height for the
Design Page.

cc "Tutorial 9-1: Creating Split Embroidery
Designs" on page 177

2

Specify the settings for the Design Page, and
then click [OK].
c b a

h

e

Page
Select the desired color for the Design
Page.

f

Background
Select the desired color for the work area.

g

Default
To return to the default settings, click this
button.

h

Edit User Hoop
Click this button to display the [User
Hoop Settings] dialog box, where a user
hoop size can be added. The added user
hoop size appears at the bottom of the list.

cc "Specifying a user hoop size" on page 15

g

d

f

e

a

Machine Type
Select your machine type. The settings
available in the [Page Size] selector differ
depending on the selected machine type.

b

Hoop Size
Select the desired hoop size from the
selector.

c

Rotate 90 Degrees
Select this check box to arrange the
pattern in a Design Page rotated 90°.
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a
• The Design Page sizes 130 × 300 mm, 100 ×
172 mm indicated by the "*", are used to
embroider multi-position designs using a special
embroidery hoop attached to the embroidery
machine at three installation positions.

Specifying a user hoop
size
d
e
f

a

c

b

cc "Tutorial 9-2: Creating Design for MultiPosition Hoops" on page 183
• Do not select a hoop size larger than the
embroidery hoop that can be used with your
machine.
• When Cap Frame, Cylinder Frame or Round
Frame has been selected, the Design Page
cannot be rotated 90°.

a

Width, Height
Type in the size of the hoop to be added.

b

Comment
If text was entered in this box, that text
appears beside the size.

c

Add Hoop
Click this button to add the hoop size.

d

User Hoop List
The added hoop size appears in the list.
Select a hoop size in this list to change the
display order or to delete it.

e

Up, Down
Click these buttons to move the selected
hoop size up or down in the display order.

f

Delete Hoop
Click this button to delete the selected
hoop size.

a
• A User Hoop cannot rotate 90°.
• A User Hoop cannot be added to the Section
Size (for Hoop Size) selector under Custom
Size.
• Do not create a Custom Hoop larger than the
embroidery hoop that can be used with your
machine.
• Embroidery data created in a user hoop size
cannot be saved in a format for a previous
version.
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Specifying the sewing area
The pattern drawn in the Design Page is sewn
differently depending on the sewing area setting.

1
2

Click [Output] tab.

Optimize hoop change
This setting can be selected if a multi-position hoop
(100 × 172 mm or 130 × 300 mm) has been selected
as the Design Page size.

Select the desired sewing area ([Design
Page area] or [Use existing design area]).

Select the check box to optimize the sewing order/
order of hoop position changes so that the number
of times that the hoop position is changed is
reduced to the minimum.
This reduces the risk of misalignment in the
embroidery pattern or uneven stitching from
changing the hoop position too often.

Design Page area
The patterns will be sewn so that the needle
position when you start sewing is aligned with
the center of your Design Page. The
dimension of the pattern matches the size of
the Design Page, therefore reducing the ability
to move a pattern around the layout screen of
your embroidering machine.

Design Page (on
your screen)

Jump Stitch Trimming
These settings are applied only when embroidering
with our multi-needle embroidery machines. Before
these settings can be specified, select

under

[Machine Type] in the [Design Settings] dialog
box.

Sewing area =
Design Page area

Use existing design area
The patterns will be sewn so that the needle
position when you start sewing is aligned with
the center of the actual patterns. The actual
pattern size is maintained, therefore allowing
greater mobility when using the layout
functions of your embroidering machine.

Design Page (on
your screen)

Sewing area = Use
existing design area

Specify the minimum jump stitch length for thread
trimming.

a
These settings are not applied with any other
embroidery machine. For details, refer to the
Operation Manual provided with your machine.
cc "Jump Stitch Trimming" on page 87,
"Specifying trimming settings in Layout &
Editing" on page 297 and "Adding jump
stitch trimming to new patterns" on
page 302
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Using Fabric Selector
A group of sewing attribute settings appropriate for the major types of fabric can be recalled from the [Fabric
Selector] dialog box. Select the fabric to be embroidered to view a description of the fabric and advice on
embroidering.

1

Click

, then [Fabric Selector].

a
• The sewing attributes of imported shapes and
text are not changed.
• Perform a trial sewing before embroidering your
project.
cc "For Basic Operations" on page 295

b
Original settings can be saved to be later used in

2

Select the group of settings to be recalled.

the [Fabric Selector]. Click
in the [Sewing
Attributes] tab, click [Save As], and then click
[OK] without changing the name for the settings.
The group of settings that you have saved will
appear with “*” beside its name.
cc "Saving the settings in a list" on page 192

a

a

3

Select the type of fabric to be
embroidered to specify the recommended
settings for that fabric.
When a fabric type is selected, a
description appears.

Click [OK].
When shapes and text are entered, the
sewing attributes will be set to those
recommended for the selected fabric.
cc "Specifying sewing attributes" on page 54

17

Basic Software Settings

Specifying Basic Display Settings
Changing the grid settings

Changing the ruler settings

A grid of dotted lines or solid lines can be displayed
or hidden, and the spacing for the grid can be
adjusted.

1

1

Click [View] tab.

2

2

Specify the grid settings.

The ruler can be displayed or hidden.
Click the [View] tab.
To display the ruler, select the [Ruler] check
box in the [Ruler] group.
To hide the ruler, clear the [Ruler] check box.

a
c

b
d

a

Show Grid
Select this check box to display the grid.

b
b

with Axes
Select this check box to display the grid as
solid lines.

c

Interval
Specify the grid spacing.

d

Snap to Grid
Select this check box to align patterns
with the grid. The snap feature works
whether or not the grid is displayed.

Click
to switch the measurement units
between millimeters and inches.

b
The
button can also be used to switch the
grid between being displayed or hidden.
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Changing the guideline
settings
Guidelines can also be used when the ruler is
displayed.

1

b
When a pattern is saved, the guidelines are saved
with it. However, the guidelines are deleted if the
pattern is saved in a format for a version earlier
than version 10.

Click the [View] tab.

2

Select the [Ruler] check box, and then select
the [Guideline] check box in the [Ruler]
group.

Adjusting on-screen
measurements (Screen
Calibration)
Measurements can be adjusted so that objects will
be displayed at the same size as the actual
embroidery at a zoom ratio of 100%. Once this
adjustment is made, it will not need to be done again
later.

3

1

Click a ruler in the Design Page.


Click

, then [Options].

appears, and a guideline is drawn.

1

1 Guideline

• To move a guideline, drag

.

• To delete a guideline, click

.

b
• A guideline is added each time the ruler is
clicked. In addition, up to 100 guidelines each
can be added to the horizontal and vertical
rulers.
• While a guideline is being dragged, its position is
shown in the status bar.
• When the [Ruler] check box or the [Guideline]
check box is cleared, the guidelines are hidden.
• If both the [Show Grid] and [Snap to Grid]
check boxes are selected, the guidelines will be
added/moved along the lines of the grid.
cc "Changing the grid settings" on page 18
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2

Click [Screen Calibration]. Hold a ruler
against the screen to measure the length of
a. Next, enter the value at b, and then click
[OK].

a

b

Be sure to enter the length in millimeters. A
value in inches is invalid.

Basic Software Settings

System unit
1

2

Click

, then [Options].

Click [System Unit], and then select the
desired measurement units ([mm] or [inch]).
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Basic Layout & Editing Operations

This section describes the basic operations
performed in Layout & Editing, such as drawing
shapes, editing the embroidery design, specifying
sewing attributes, saving the file and printing it.

Tutorial 1: Drawing shapes to create an embroidery design

Tutorial 1: Drawing shapes to create an
embroidery design
This section will describe how to combine various shapes to create an embroidery design.
We will use an Outline tool to draw the stem. Then, we will create the leaves, flower and flower pot by importing
shape patterns.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_1.
Step 1

Drawing, importing and moving shapes

Step 2

Duplicating, flipping and moving shapes

Step 3

Specifying hole sewing

Step 4

Applying a pattern to stitching

Step 5

Editing points and modifying shapes

Step 1 Drawing, importing and
moving shapes
Shapes can be created either by drawing them with
the Shapes tools or by importing sample shape
patterns.

1

To import a shape, select [Outline Shapes]
from the [From] selector of the [Import] pane,
then [Basic Shapes] from the [Category]
selector. Select the shape, and then click
[Import].

To draw a shape, select a Shapes tool, and
then drag the pointer in the Design Page to
draw the shape.

1

1 Shapes tools
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2

Specify the sew types for the shape on the
[Shapes] tab, and the thread colors on the
[Shapes] tab or the [Color] pane.

Tutorial 1: Drawing shapes to create an embroidery design

1

2

3

4

(D) Click [LIME GREEN].
If the desired color is not displayed, move
the scroll bar until it appears.

b
To view the thread colors in a list so that the
desired color can more easily be found, click [To
list mode].

1
2
3
4
5
6

1

6

cc "Setting the sew type" on page 49

Line color button
Line sew type selector
Region color button
Region sew type selector
Selected thread color and color name
Thread color palette

(E) Click the [Line sew type] selector, and
then select [Zigzag Stitch].

Draw the stem.
(A) Click the [Home] tab.
(B) Click [Shapes] in the [Tools] group, and
then click

.

(F) Click the start point 1, and then doubleclick the end point 2.

1
(C) Click the [Color] tab to display the color
palette.

2

b
The color, sewing attributes and size can also be
changed after the shape is drawn.
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5

Tutorial 1: Drawing shapes to create an embroidery design
2

Create the leaf on the right.
This time, we will import a shape pattern. We
will also specify the color and sew type for the
region.

b
The thread colors being used are listed under
[Colors Used].

(A) Click the [Import] tab.
(H) Drag the handle to adjust the leaf to the
desired size.

(B) Select [Outline Shapes] from the [From]
selector and [Basic Shapes] from the
[Category] selector.
(C) Select [BS_shapes27.pes], and then
click [Import].

(I) Place the pointer over the leaf so that the
shape of the pointer changes to
, and
then drag the leaf to the desired position.

Step 2 Duplicating, flipping and
moving shapes

(D) Click the [Shapes] tab.
(E) Click

for line sewing, and then click
under [Colors Used] to select [LIME

GREEN].
(F) Click the [Line sew type] selector, and
then select [Zigzag Stitch].

Now, we will duplicate the leaf on the right side, flip
it horizontally, and then move it to the left side of the
stem.

1

To duplicate the leaf on the right.

(A) Select the leaf.

(G) As with the line color, click
sewing, and then click

for region
under [Colors

Used] to select [LIME GREEN].
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(B) While holding down the <Ctrl> key, drag
the leaf to move it.
(C) Release the mouse button.

Tutorial 1: Drawing shapes to create an embroidery design
2

To flip the duplicated leaf horizontally.

b
• Multiple embroidery patterns can be selected in
any of the following ways.
 Click the first pattern, and then, while holding
down the <Ctrl> key, click the next pattern.
 Drag the pointer to draw a selection frame
around the patterns to be selected.
• Flipped copies can also be created by clicking
[Arrange Copy] in the [Clipboard] group of the
[Home] tab, then clicking [Vertical Mirror
Copy].

(A) Right-click on the duplicated leaf.
 A drop down menu will appear.
(B) Click [Flip], then [Horizontal].

3

Drag the duplicated leaf to the left side of the
stem.

cc "Using the Mirror Copy tool" on page 35.

Step 3 Specifying hole sewing

1

Create the flower petals.
(A) Click the [Import] tab.
(B) Select [BS_shapes26.pes], and then
click [Import].

b
To move an object horizontally, hold down the
<Shift> key while dragging the object.

4

Align the leaves on the left and right sides.

(C) Click the [Shapes] tab.

(A) While holding down the <Ctrl> key, click
the leaf on the right side, then the leaf on
the left side to select the two leaves.
Then, right-click the selected leaves.
(B) Right-click the leaves, and then click
[Align], then [Top].
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Now, we will create the flower and a circle at the
center. Then, we will apply a setting so that the
overlapping areas are not sewn twice.

Tutorial 1: Drawing shapes to create an embroidery design
(D) Select [RED] in the color palette as the
line color and [Zigzag Stitch] as the sew
type a.

(D) Select [YELLOW] in the color palette as
the line color and [Zigzag Stitch] as the
sew type a.

a

a

b

b

c
c

(E) Select [YELLOW] in the color palette as
the region color and [Concentric Circle
Stitch] as the sew type b.

(E) Select [Radial Stitch] as the sew type
b.
(F) Drag the handle (c) to adjust the flower
petals to the desired size.

(F) Drag the circle to the center of the flower
petals.

(G) Drag the flower petals to adjust their
position.

2

(G) While holding down the <Shift> key, drag
the handle (c) to adjust the circle to the
desired size.

Create the circle at the center.
(A) Click the [Import] tab.
(B) Select [BS_shapes01.pes], and then
click [Import].

a
If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.

3

Select the patterns where hole sewing is to be
applied.
(A) While holding down the <Ctrl> key, click
the yellow circle a and the flower petals
b.

(C) Click the [Shapes] tab.
a
b
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4

(B) Select [BS_shapes13.pes], and then
click [Import].

Specify hole sewing.
(A) Click the [Home] tab.
(B) Click [Modify Overlap] in the [Edit]
group, and then click [Set hole sewing].

Hole sewing cannot be applied if one of the
patterns is not completely enclosed within the
other pattern.

(C) Click the [Shapes] tab.

cc "Hole sewing" on page 39.

(D) Select [CLAY BROWN] in the color
palette as the line color and [Zigzag
Stitch] as the sew type a.

Step 4 Applying a pattern to
stitching
Detailed line and region attribute settings can be
specified from the [Sewing Attributes] pane. Now,
we will specify settings for region sewing for the
flowerpot.

1

Specify the color and sew type for the line and
region of the flowerpot.

a
b

(E) Select [DEEP GOLD] in the color palette
as the region color and [Prog. Fill Stitch]
as the sew type b.

(A) Click the [Import] tab.
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a

Tutorial 1: Drawing shapes to create an embroidery design
2

(F) Select [net4], and then click [OK].

Specify the sewing attributes.
(A) Click the [Sewing Attributes] tab.
If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then
[Attributes], then [Sewing Attributes].
(A)

(C)

(D)

(G) Type "7.6" to specify the pattern size.

(E)

(B)
1
1 The selected pattern is displayed.
The effects of the specified settings
can be previewed. This preview can
be displayed/hidden by clicking the
Show Hint/Hide Hint button.
Click this button to return the attribute
to its default setting.

b
• If the dialog box is displayed in Expert mode,
click [To Beginner mode] to display the dialog
box in Beginner mode.
• More detailed settings can be specified in Expert
mode.
cc "Specifying sewing attributes" on page 54

(B) There are two display modes for the
[Sewing Attributes] pane. For this
example, we will specify settings in
Beginner mode.
(C) In the [Density] box, type "5.0".
(D) In the [Direction] section, drag the red
arrow to 90°. Otherwise, type "90".
(E) Click
section.

29

in the [Programmable fill]

Tutorial 1: Drawing shapes to create an embroidery design

Step 5 Editing points and
modifying shapes

(D) Right-click the top point to be deleted, and
then click [Delete].

Now, we will delete one corner from the pentagon to
create a flowerpot.

1

(D)

Drag the handle to adjust the flowerpot to the
desired size.
Drag the flowerpot to adjust its position.

(C)

 The point is deleted to form a trapezoid.

Basic Layout & Editing Operations

2

Delete a point.
(A) Click the [Home] tab.
(B) Click [Select] in the [Select] group, and
then click

.

(A)
(B)

If you want save or export

(C) Click the shape for the flowerpot.
 The points in the shape appear.

cc For details on saving embroidery
patterns, refer to "Saving" on page 95.
For details on transferring designs to an
embroidery machine, refer to
"Transferring Embroidery Designs to
Machines" on page 201.
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Editing Embroidery Designs
■ Selecting all embroidery patterns
1 Click the [Home] tab.

Selecting patterns
1

Click the [Home] tab.

2

Click

3

Click the pattern.

2

in the [Select] group.

Click [Select] in the [Select] group, and then
click [Select All].

1
2

b
• All patterns can also be selected by pressing the
shortcut keys <Ctrl> + <A>.
• Locked embroidery patterns cannot be selected.

1 Rotation handle
2 Handles

Moving patterns

b
• If
is not displayed in the [Select] group,
click the arrow at the bottom of the button, and
then click
.
• The status bar shows the dimensions (width and
height) of the pattern.

4

To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

b
• You can also select patterns by dragging the
pointer across the pattern.
• Press the <Tab> key to select the next pattern in
the order that they were created.
• If multiple patterns are selected, a pattern can
be deselected by holding down the <Ctrl> key
while clicking the pattern.
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cc "Locking embroidery patterns" on page 86

■ Moving manually
Drag the selected pattern(s) to the desired location.

b
• To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.
• Pressing the arrow keys moves the selected
pattern.
• Holding down the <Ctrl> key and dragging the
pattern creates a duplicate of the pattern at the
destination.

Editing Embroidery Designs
■ Moving embroidery patterns to
the center
1 Select the pattern(s), and then click the
[Home] tab.

2

1

Click [Arrange] in the [Edit] group, and then
click [Layout], then [Move to Center].
2

3

4

■ Aligning embroidery patterns
1 Select the patterns, and then click the [Home]
tab.

2

Click [Arrange] in the [Edit] group, click
[Layout], and then click the desired command
under [Horizontal] or [Vertical].

6

Top
Middle
Bottom
Left
Center
Right
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1
2
3
4
5
6

5

Scaling patterns
■ Scaling manually
1 Select the pattern(s).
1

1 Handles

2
 The selected patterns are aligned as
shown below.

Drag the handle to adjust the selected
pattern(s) to the desired size.

a
We recommend not scaling patterns imported from
original cards.
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b
• If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.
• As you drag the handle, the current size is
displayed on the status bar.
• When scaling stitch patterns, the number of
stitches remains the same, resulting in a loss of
quality. To maintain the density and fill pattern of
the embroidery pattern, hold down the <Ctrl>
key while scaling. Even stitch patterns with a
non-uniform stitch density and needle drop point
pattern can be scaled while maintaining the
density and fill pattern.
cc "Enlarging/Reducing Stitch Patterns" on
page 295.

■ Scaling numerically
1 Select the pattern(s), and then click the
[Home] tab.

2

b

To change the width and height
proportionally, select the [Maintain
aspect ratio] check box.

c

To resize the selected pattern while
maintaining the original density and fill
pattern, select the [Keep density and fill
pattern] check box.

b
The [Keep density and fill pattern] check box is
available only if stitch pattern is selected.
cc "Enlarging/Reducing Stitch Patterns" on
page 295

Rotating patterns
■ Rotating manually
1 Select the pattern(s).
2

Drag the rotation handle.
a

Click [Arrange] in the [Edit] group, and then
click [Size].

1

b

3

Specify the size, and then click [OK].

a

The shape of pointer changes to

b

Rotate

1 Rotation handle

b
To rotate the pattern in 15° increments, hold down
the <Shift> key while dragging the handle.

a

b
c

a
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Select the whether the width and height
will be set as a percentage (%) or a
dimension (millimeters or inches). Set the
width and height.

Editing Embroidery Designs
■ Rotating numerically
1 Select the pattern(s), and then click the

Flipping patterns
horizontally or vertically

[Home] tab.

2

Click [Arrange] in the [Edit] group, and then
click [Rotate], then [Rotate].

1
2

Select the pattern(s), and then click the
[Home] tab.
Click [Arrange] in the [Edit] group, and then
click [Flip], then [Flip Vertically] or [Flip
Horizontally].

b
Click [Rotate Right] or [Rotate Left] to rotate the
pattern 90° clockwise or counterclockwise.

Basic Layout & Editing Operations

3

Type or select the rotation angle. Click [OK].

b
An angle can also be selected by dragging
the [Rotate] dialog box.

in

a
Some patterns imported from original cards cannot
be flipped.
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Arrange Copies

3

Move the pointer, and then click when the
patterns are arranged as desired.

a
It may not be possible to create mirror copies of
some embroidery data read from original cards.

■ Using the Mirror Copy tool
■ Using the Circle Copy tool

1
2

Select the pattern(s), and then click the
[Home] tab.
Click [Arrange Copy] in the [Clipboard]
group, and then click [Vertical Mirror Copy],
[Horizontal Mirror Copy] or [Four-Way
Mirror Copy].

1
2

35

Select the pattern(s), and then click the
[Home] tab.
Click [Arrange Copy] in the [Clipboard]
group, and then click [Circle Copy].

Editing Embroidery Designs
3

Specify the pattern arrangement and spacing.

5

Move the pointer to select the desired angle.

a

b

Select the desired arrangement.

b

Specify the spacing between patterns.
The higher the value, the wider the
patterns are spaced from each other.

Drag the pointer to draw a circle or an oval.

Rotating the line changes the orientation of
the patterns.

b
b
• To draw a circle, hold down the <Shift> key
while dragging the pointer.
• To redraw the ellipse, right-click the Design
Page to return to before the ellipse was drawn.

• To rotate the line in 15° increments, hold down
the <Shift> key while moving the pointer.
The angle of the line appears in the status bar.
• While changing the orientation by moving the
pointer, the pattern arrangement and spacing
can still be changed in the [Circle Copy] dialog
box.

6

Click to finish the copies.
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4

a

Editing Embroidery Designs
■ Using the Matrix Copy tool

4

Click in the Design Page, and then move the
pointer.
A rectangle and the patterns that can be
arranged within it appear as dotted lines.

1
2

Select the pattern(s), and then click the
[Home] tab.
Click [Arrange Copy] in the [Clipboard]
group, and then click [Matrix Copy].

b
• To redraw the rectangle, right-click the Design
Page to return to before the rectangle was
drawn.
• While resizing the rectangle by moving the
pointer, the pattern spacing can still be changed
in the [Matrix Copy] dialog box.

5
3
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Specify the spacing between patterns. The
higher the value, the wider the patterns are
spaced from each other.

Click to finish the copies.
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■ Optimizing the sewing order
Before using an [Arrange Copy] tool, optimizing the
sewing order adjusts the sewing order of the
patterns created with the [Arrange Copy] tool in
order to reduce the number of thread color changes.
[Optimize Sewing Order]
not selected

[Optimize Sewing Order]
selected

Adding a decorative
pattern
A decorative pattern can be added to selected
embroidery pattern.

1
2
3

1
2

Display the [Import] pane, and select
[Decorative Pattern] from the [From]
selector.
Select a category from the [Category]
selector, select the desired decorative pattern
from the list, and then click [Decorative
Import].
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The sewing order is the
order in which patterns
are created.

Select the pattern(s).

Patterns will be sewn so
that those with the same
thread colors will be
connected.

Select the pattern(s), and then click the
[Home] tab.
Click [Arrange Copy] in the [Clipboard]
group, and then click [Optimize Sewing
Order] so that the check mark appears.

a

a

3

Perform the Arrange Copy operation.

Maintain aspect ratio
When the check box is selected
The original height-to-width proportion of
the added decorative pattern is
maintained.
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When the check box is cleared
The height-to-width proportion of the
decorative pattern changes with the
height-to-width proportion of the selected
embroidery pattern.

■ Ungrouping patterns
1 Select grouped patterns, and then click the
[Home] tab.

2

Click [Group] in the [Edit] group, and then
click [Ungroup].

b
If no pattern is selected, the button will appear as
the [Import] button. Clicking this button will import
the decorative pattern at its standard size.

Grouping/Ungrouping
embroidery patterns
■ Grouping patterns
1 Select several patterns, and then click the
[Home] tab.

2

Click [Group] in the [Edit] group, and then
click [Group].

■ Editing grouped patterns
individually
Even after patterns are grouped, they can be edited
individually.

1
2

To select a single pattern within a group, hold
down the <Alt> key while clicking the pattern.
Edit the pattern.

Hole sewing
By specifying hole sewing, the stitching in
overlapping regions will not be sewn twice. Hole
sewing can be set only when one region completely
encloses another.
Embroidery patterns created with the Shapes tools
can be selected to set hole sewing.
1

Hole sewing not set
1 Sewn twice
2 Sewn once
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2

Hole sewing set
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1

Select a pair of patterns, for example, a star
included in a pentagon.
While holding down the <Ctrl> key, click the
star, then the pentagon.

■ Canceling hole sewing
1 Select a pattern that has been set for hole
sewing.

2
3

Click the [Home] tab.
Click [Modify Overlap] in the [Edit] group,
and then click [Cancel hole sewing].

1
1 Valid

2

a
Hole sewing cannot be specified with the following
shape patterns.
• Patterns with an intersecting outline.
• Patterns with multiple sewing direction lines.

2
3

Click the [Home] tab.
Click [Modify Overlap] in the [Edit] group,
and then click [Set hole sewing].

Changing shapes of
overlapped patterns
Embroidery patterns created with the Shapes tools
can be selected to remove overlapping regions or to
be merged.

■ Removing overlapping
Overlapped patterns can be set so that the
overlapping region is removed.

1
2

While holding down the <Ctrl> key, click two
or more overlapped patterns to select them.
Click the [Home] tab.

b
To see better what the hole sewing setting does,
preview the patterns before and after setting hole
sewing.
cc "Stitch View" on page 78
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2 Invalid
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3

Click [Modify Overlap] in the [Edit] group,
and then click [Remove Overlap].

■ Merging
Overlapped pattern can be merged together.

 The color and sew type of the last pattern
drawn (topmost pattern) is applied to the
merged pattern.
• When partially overlapped

1
2
3

While holding down the <Ctrl> key, click two
or more overlapped patterns to select them.
Click the [Home] tab.
Click [Modify Overlap] in the [Edit] group,
and then click [Merge].

• When enclosed
 If this cannot be applied to the selected
patterns, an error message appears.
• When partially overlapped

First pattern in the sewing order
Second pattern in the sewing order
Third pattern in the sewing order

b
After removing or merging an overlapping region
of patterns with sewing directions specified, the
sewing direction returns to the uniform default
direction.
cc "Specifying the sewing direction" on page 51
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Splitting Shape pattern

b
To remove the last point that was entered, rightclick the mouse button.

5

Double-click in the Design Page to specify the
section to be split off.

a

1

Select a shape pattern, and then click the
[Shapes] tab.
cc For detail on the shape pattern, refer to
page 8
Click [Split Outline] in the [Tools] group to
select the [Split Outline] tool.

cc "Sewing order optimization" on page 83, and
"Changing colors" on page 85
 If the design contains overlapping patterns,
the selected pattern will appear in front of
the others. All patterns other than the
selected pattern will appear in gray.

cc "Checking and Editing the Sewing Order" on
page 82

Creating a floral pattern
Line stitching in a floral pattern can be created
based on the selected shape.

3
4

Click in the Design Page at the point where
you want to start drawing the enclosing lines.
Continue clicking in the Design Page to
specify each corner of the enclosure around
the area to be cut off.

1

Draw a shape, and then select it.

a
Be sure to select a closed line.
cc "Changing the attributes of line ends" on
page 64

2

Click the [Shapes] tab.
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2

• Only closed patterns with no
intersecting lines can be split. The
pattern shown at the right cannot be
split.
• The inside pattern with hole sewing applied
cannot be split.
• If the enclosing line that was drawn intersects
itself, the section cannot be split off, and a
message appears.
• After splitting a pattern with fit text to outline
applied, fit text to outline will be canceled.
• If the entered patterns are not in the desired
sewing order, change it in the [Sewing Order]
pane.
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3

Click [Create Floral Pattern] in the [Edit]
group.

■ Basic mode
1 Drag the [Density] slider to adjust the pattern.

2

■ Detailed mode
More detailed settings can be specified in Detail
mode.

1

2
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Click the desired pattern, and then click [OK].

Click [To detailed mode] in the [Floral
Pattern] dialog box.

Drag the [Density] slider and the [Pattern]
slider to adjust the pattern.

Density 3, Pattern 251

Density 10, Pattern 251

Density 6, Pattern 251

Density 6, Pattern 0

Editing Embroidery Designs
3

After the pattern has been adjusted as
desired, click [OK].

3

4

b

Click [Create Offset Lines] in the [Edit]
group.

Specify the desired settings for the offset line
pattern, and then click [OK].
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The running stitch is specified for the floral line
pattern.

Creating an offset line
pattern
Line stitching in a concentric pattern can be created
based on the selected shape.

1

Draw a shape, and then select it.

a
Be sure to select one closed line.
cc "Changing the attributes of line ends" on
page 64

2

Click the [Shapes] tab.
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Offset Direction
Outward

Inward

Spacing
1 mm

5 mm

Offset Line Count
1 line

5 lines

Rounded Corners
Check box selected.
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Check box cleared.

Specifying Thread Colors and Sew Types for Lines and Regions

Specifying Thread Colors and Sew Types
for Lines and Regions
Setting the thread color
The [Sew] group in the [Shapes] tab allows you to
set the thread color of shapes.
1

■ Color pane
Palette mode
a
b
c

2

d
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1 Line color
2 Region color

■ Color
Click the [Color] button, and then select the desired
color from the list of thread colors.
e

f

List mode
a
b
c

a

Thread brand name or name of user
thread chart and its thread color list:
Displays the brand name and its thread
color chart for the currently selected
pattern.

b

Colors Used
Displays all thread colors being used in
the embroidery design.

c

Show Color Palette
Click to display the [Color] pane.

a
b
c

d

e

f

46

Specifying Thread Colors and Sew Types for Lines and Regions
a

Select the type of stitching ([Line] or
[Region]) to display the corresponding
colors being used.
Line
Line color
Region
Region color

b

Select the check box to apply gradation/
blending. Click the [Pattern] button to
specify a gradation/blending pattern.
(Only available when a shape pattern is
selected)

2

Click the [Color] tab, select the [Gradation]
check box, and then click [Pattern].

cc "Creating a gradation/blending" on
page 47
c

From the [Thread Chart] selector, select
a thread brand or your user thread chart.

d

From the list of thread colors, select the
desired color.

e

Click to switch the mode.

f

Displays all thread colors being used in
the embroidery design. When an
embroidery pattern is selected, a frame
appears around the colors used in that
pattern. The same thread colors can be
specified by selecting them here.

■ Creating a gradation/blending
The density of one or two colors can be adjusted at
various locations to create a custom gradation
pattern.

1

3

Specify the desired settings in the [Gradation
Pattern Setting] dialog box, and then click
[OK].
b

e

c

d

a

f

g

a

To change the thread color, click
.
Select a color in the [Thread Color]
dialog box that appeared, and then click
[OK].

b

To select a preset gradation pattern, click
the desired pattern under [Select
pattern].

c

Move the sliders to adjust the density of
the gradation pattern.
The overall density of the gradation can
be adjusted with the [Max] and [Min]
sliders.
Drag the [Max] slider to adjust the
maximum value and the [Min] slider for
the minimum value. The values between
the maximum and minimum are
automatically adjusted.

d

To blend two colors, select the [Blend]

Select an embroidery pattern with region
sewing specified.

check box, and then click
. Select a
color in the [Thread Color] dialog box
that appeared, and then click [OK].
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e

The preview area shows the setting
changes that you make.

f

Specify the density.

Specifying Thread Colors and Sew Types for Lines and Regions
g

Specify a direction, or drag the red arrow
to adjust it.

b

■ Special colors
a

• Gradation/blending can be specified if satin
stitches, fill stitches or programmable fill stitches
have been selected for the region sewing and
[Manual] has been selected as the sewing
direction.
• If the [Blend] check box is cleared, the
gradation settings are applied to the remaining
color.
• Gradation/blending can also be specified under
[Density] when the [Sewing Attributes] pane
is displayed in Expert mode.

d
c

b

a

NOT DEFINED
If you want to be able to manually select
the color for a monochrome pattern, you
can select [NOT DEFINED].
Colors for creating appliqués:
You can create appliqués using the
following three special colors.
APPLIQUE MATERIAL
marks the outline of the region to cut from
the appliqué material.

c

APPLIQUE POSITION
marks the position on the backing
material where the appliqué must be
sewn.

d

APPLIQUE
sews the appliqué on the backing
material.

b
By using the Applique Wizard, appliqués can
easily be created.
cc "Tutorial 8-1: Creating Appliqués" on
page 161
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■ Region sew types

Setting the sew type
The [Sew] group in the [Shapes] tab allows you to
set the sew type.

Page

a

cc
cc
cc
cc
cc
cc
cc
cc
cc
cc
cc
cc

1

2
1 Line sew type selector
2 Region sew type selector

■ Line sew types
Page

a

cc
cc
cc
cc
cc
cc
cc
cc
cc

b

325
325
325
326
327
327
328
329
329

The sew type for lines in shapes and text can be
selected in the [Line sew type] selector.
Click the [Line sew type] selector, and then select
the desired sew type.
a

Not Sewn (Line)
Select this setting to turn off line sewing
(line will not be sewn).

b

Cutting
Select this setting to specify the line as a
cutting line in a cutwork pattern.

cc "Specifying sewing attributes" on
page 54, "Practical use of Satin Stitch
and Cutting Line" on page 168 and "Line
sewing attributes" on page 325
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331
333
333
336
337
338
338
338
338
338
339
339

The sew type for regions in shapes, and text can be
selected in the [Region sew type] selector.
Click the [Region sew type] selector, and then
select the desired sew type.
 The available region sew types differ
depending on whether a shape pattern or
text pattern is selected.
a

Not Sewn (Region)
Select this setting to turn off region
sewing (region will not be sewn).

cc "Specifying sewing attributes" on
page 54 and "Region sewing attributes"
on page 331
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The codes that appear indicate the following.
L: Line sewing
R: Region sewing
1: Entry point
2: Exit point

Moving entry/exit points,
the center point and stitch
pattern reference point

This is the entry (or exit) point for the
next (or previous) pattern that is
connected to the exit (or entry) point of
the currently selected pattern.
This point is connected to the entry/exit
point with the same code in the
currently selected pattern. In this
example, R1 in the currently selected
pattern and R1 in the previous pattern
are connected.

■ Moving the entry/exit points
1 Click the [Home] tab.
2

Click [Select] in the [Select] group, and then
click
tool.

to select the Select Entry/Exit Point

4

Click the object.
A dotted line appears between the entry (or
exit) point being moved and the cross
indicating the exit (or entry) point of the
previous (or next) pattern.

b
This is the entry point for the outline
stitching. The previous pattern is
connected to this point.
This is the exit point for the outline
stitching. Stitching continues from this
point to the next pattern.

• If the outline or the inside region are set to not be
sewn, the corresponding point does not appear.
• The entry and exit points can be checked in the
[Sewing Order] pane. Select the Select Entry/
Exit Point tool, and then click a frame in the
[Sewing Order] pane. The entry and exit points
of the selected pattern appear.

This is the entry point for the inside
region stitching. The previous pattern
is connected to this point.
This is the exit point for the inside
region stitching. Stitching continues
from this point to the next pattern.

In this case, finish the operation by clicking a
blank area in the [Sewing Order] pane.
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3

Drag the arrow for the point to the desired
location on the outline.

Specifying Thread Colors and Sew Types for Lines and Regions
4

a

Center Point (Radial
Stitch)

Only entry and exit points for patterns created with
the Shapes tool can be edited. Stitch patterns or
patterns created with the Text tools cannot be
edited.

■ Moving the center point and stitch
pattern reference point
The center point and reference point for arranging
the stitch pattern can be repositioned for a more
decorative effect.

b
• Regions with the concentric circle stitch or radial
stitch specified have a center point.
• Regions with the prog. fill stitch, motif stitch,
cross stitch, net fill stitch or zigzag net fill stitch
specified have a stitch pattern reference point.

1

Click the [Home] tab.

2

Click [Select] in the [Select] group, and then
click

3

Stitch pattern reference
point (Motif Fill Stitch)

1
1 Handle

Specifying the sewing
direction
When the Outline tools, Rectangle/Circle/Arc tools
or Shapes tools are used, shapes with a single
sewing direction will be created. When the Manual
Punch tools are used, shapes with multiple sewing
directions are created.
The sewing direction is indicated by a sewing
direction line (red arrow). These lines can be edited
by moving the end points, or new sewing direction
lines can be added.

.

These settings can be adjusted for regions with the
satin stitch, fill stitch, prog. fill stitch, piping stitch or
motif stitch specified.
Click a region with the concentric circle stitch,
radial stitch, prog. fill stitch, motif stitch, cross
stitch, net fill stitch or zigzag net fill stitch
specified.
Center Point (Radial
Stitch)

1
1 Handle
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Drag the handle to the desired location.

Stitch pattern reference
point (Motif Fill Stitch)

a
This feature can be used when [Direction] in the
[Sewing Attributes] pane is set to [Manual]
(default setting).
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■ Specifying multiple sewing
directions
1 Click the [Home] tab.
2

Click [Select] in the [Select] group, and then
click

to select the Select Point tool.

b
• Specify the sewing direction lines as described
below.
 Position both end points outside of the pattern.
 Only the lines can be positioned over the
pattern.
 When specifying multiple sewing direction
lines, they must not intersect within the
pattern.
Sewing direction lines specified in any way other
than described above will not be added.

a
3

Click a shape pattern.
 The sewing direction lines appear.

5

Click the [Shapes] tab.
Click [Add Direction Line] in the [Sewing
Direction Line] group.

■ Changing the sewing angle
1 Select the Select Point tool.
2
3

6

Click a shape pattern, and then click an empty
square or empty triangle on the sewing
direction line to select the point.
Drag the point to the new location.

Click the point for one end of the sewing
direction line being added, and then click the
point for the other end.
2
Selected point

1
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4

If hole sewing has been applied, sewing direction
lines cannot be added.
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b
The sewing angle can also be set to a specific
direction (one sewing direction line) with the
settings under [Direction] in the [Sewing
Attributes] pane.
cc "Specifying sewing attributes" on page 54

■ Deleting sewing direction lines
1 Select the Select Point tool.
2
3
4

■ Reversing the sewing direction
1 Select the Select Point tool.
2

Click a shape pattern.

3

Click the [Shapes] tab.

4

Click a shape pattern, and then click an empty
square or empty triangle on the sewing
direction line to select the point.
Click the [Shapes] tab.
Click [Delete Direction Line] in the [Sewing
Direction Line] group, and then click [Delete
Selected Line] or [Delete Lines Not
Selected].

Click [Reverse Direction Line] in the
[Sewing Direction Line] group.

Delete Selected Line
Click this command to delete the selected
sewing direction line. Otherwise, press the
<Delete> key to delete the sewing direction.
Delete Lines Not Selected
Click this command to delete all sewing
direction lines except the currently selected
one. The sewing direction will become
uniform.
If there are multiple sewing direction lines, all
lines will be reversed.
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Sample patterns with sewing directions
changed
When the sewing direction is changed, the pattern
stitching changes as shown below.
Sewing direction

Satin Stitch

Specifying sewing
attributes
1

Select an embroidery pattern, a Shapes tool
or a Text tool.

2

(default)

Click the [Sewing Attributes] tab.

Beginner mode

Expert mode

a

Fill Stitch

a

Programmable Fill Stitch
(Prog. Fill Stitch)

b

Piping Stitch

Motif Stitch

The sewing direction is also changed when the
pattern size and shape are changed.

d

c

b

d

c

a

Click to return to the default setting.

b

Click to switch the attributes between
those for Beginner mode and those for
Expert mode.

c

Click to load/save the sewing settings.

d

Click to switch between displaying and
hiding the hint view.

e

Hint view
With each change in the settings, a
preview of the stitching can be checked
here. By moving the pointer over each
setting, a preview of the setting can be
displayed.

b
The sewing attributes displayed in the dialog box
depend on the selected sew type.
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3

Change the sewing attributes displayed under
[Line sew] or [Region sew].
 The settings are applied to the embroidery
pattern each time the settings are changed.
cc For details on the different sewing
attributes and settings, refer to "Line
sewing attributes" on page 325 and
"Region sewing attributes" on page 331.

b
Frequently used sewing attributes can be saved.
cc For details, refer to "Saving the settings in a
list" on page 192

Copying sewing attributes
The thread colors, sew types and sewing attributes
can be copied from one pattern and pasted onto
another to apply the same settings to the pattern.
1
1

b
• When copying attributes from a shape, text,
monogram or small text pattern and pasting
them to a pattern of a different type, only the
colors will be pasted. The sew types and sewing
attributes cannot be pasted.
Original

Target

Original

Target

1 Original

1
2

Select the shape pattern or text pattern whose
settings are to be copied, and then press the
shortcut keys <Ctrl> + <C> to copy.
Select the shape pattern or text pattern where
the settings are to be pasted, and then click
the [Home] tab.
cc For details on the shape pattern and text
pattern, refer to page 8.

3

Click [Paste] in the [Clipboard] group, and
then click [Paste Attributes].

• When copying a text pattern with different
sewing attributes applied to each character, the
sewing attributes of the first character will be
copied.

a
This function cannot be used with stitch patterns.

55

Specifying Thread Colors and Sew Types for Lines and Regions
■ Copying only specific attributes
Specific attributes, such as the line thread color, can
be copied and pasted onto another pattern.

1
2
3

4

Select the check boxes of the attributes to be
pasted, and then click [Paste].

Select the shape pattern or text pattern whose
settings are to be copied, and then press the
shortcut keys <Ctrl> + <C> to copy.
Select the shape pattern or text pattern where
the settings are to be pasted, and then click
the [Home] tab.
Click [Paste] in the [Clipboard] group, and
then click [Paste Selected Attributes].
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Embossing/Engraving

4

Click [Emboss/Engrave] in the [Edit] group,
and then click the desired command under
[Convert from Outline].

Multiple shape patterns can be selected to create an
engraved/embossed effect.

1

2

1 Top
2 Bottom

1

Draw a shape.

Example: When the [Engraved Line] command
is selected

Engraved Line
The bottom shape is
engraved with the outline
of the shape on top.
In this example, the fill stitch is selected for
region sewing.

2

Engraved Region
An engraving is made in
the bottom shape from the
shape on top.
For best result, select
[Satin Stitch] for region
sewing of the bottom
shape.

Draw a shape overlapping the shape drawn in
step 1.

Embossed Region
An embossing is made in
the bottom shape from the
shape on top.
For best result, select [Fill
Stitch] for region sewing
of the bottom shape.

3
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Select the two shapes, and then click the
[Home] tab.

b
This effect can be edited with the Edit Stamp tool.

Specifying Thread Colors and Sew Types for Lines and Regions
3

a
• These commands can only be used with shape
pattern.
• The bottom shape pattern must have one of the
following sew types specified for region sewing.
 Satin stitch
 Fill stitch
 Programmable fill stitch
• In order to use the [Engraved Line] command,
[Line sew type] for the shape pattern must be
set to any setting other than [Not Sewn (Line)].
In order to use the [Engraved Region] or
[Embossed Region] commands, [Region sew
type] for the shape pattern must be set to any
setting other than [Not Sewn (Region)].

4

Click [Emboss/Engrave] in the [Edit] group,
and then click [Input Stamp Tool].

Select a stamp pattern (.pas file with stamp
settings applied).
d

a

b

c

You can create engraved/embossed effects by
stamping stamp patterns into a shape. This appears
as stitching sewn in different directions.

■ Applying a stamp
1 Draw a shape.

a

Select a stamp pattern.

b

Specify the size of the stamp pattern.

c

Specify the direction of the stamp pattern.

d

To select a different folder, click

.

b
Engraving and embossing stamp settings appear
as red- and blue-filled areas.

5

Click the shape pattern drawn in step 1 to
select it.
 "Marching lines" appear around the
selected shape pattern.

6
2

Click the desired locations within the shape
pattern.

Click the [Home] tab.

You can preview the effect of the created
stamp in Realistic View.
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Applying and editing
stamps

Specifying Thread Colors and Sew Types for Lines and Regions
5

b

Edit the stamp.

• Stamps can be applied to regions of shape
pattern that have the satin stitch, fill stitch and
programmable fill stitch specified.
• Using Programmable Stitch Creator, you can
edit stamp pattern that have been provided or
you can create your own.
cc "Programmable Stitch Creator" on page 258
• To change the stamp pattern, select a
different pattern, and then click [Apply].

■ Editing a stamp
1 Click the [Home] tab.
2

Click [Emboss/Engrave] in the [Edit] group,
and then click [Edit Stamp Tool].

b

3

Click the shape pattern with the stamp.
 "Marching lines" appear around the
selected shape pattern.

4

Click the stamp.
1

2

1 Rotation handle
2 Scale handles

b
•
•
•
•

Only one stamp can be selected at a time.
To enlarge the stamp, drag a scale handle.
To rotate the stamp, drag the rotation handle.
To delete the stamp, press the <Delete> key.
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• If the size of a shape pattern is changed, the size
of the stamp does not change. Be sure to check
the stamp after editing a shape pattern.
• If a shape pattern containing a stamp is edited,
be sure to check the stamp after editing is
finished.

Drawing Shapes

Drawing Shapes
Drawing rectangle, circle
or arc shape

■

/

/

Drag the pointer in the Design Page.

Rectangle

2

Basic Layout & Editing Operations

Fan shape

1

Arc

Oval

Circle

Arc & string

Click the [Home] tab.
Click [Shapes] in the [Tools] group, and then
click a tool icon under [Rectangle]/[Circle]/
[Arc] to select the desired [Rectangle]/
[Circle]/[Arc] tool.

b
To draw a circle or square, hold down the <Shift>
key while dragging the pointer.

: Rectangle
: Circle or Oval
: Rectangle with rounded corners
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Drawing Shapes
2

b
Rectangles with rounded corners
To change the radius of the corners, click the
[Edge radius] selector in the [Outline] tab. Then,
type the desired radius, or select the desired
value.
Specify the radius of the corners before drawing
the rectangle. The setting cannot be changed after
the rectangle has been drawn.

Move the pointer to the start point of the arc,
and then click.
 The radial line disappears.

3

Move the pointer until the arc/arc & string/fan
has the desired shape, and then click.

b
Dragging the pointer while holding down the
<Shift> key moves it in 15° increments. The
current angle is shown in the status bar.

Arc

Click at start point.
Example 1
Edge radius: 0.0 mm

Example 2
Edge radius: 20.0 mm

Move to end point.

■

/

/

Click at end point.

: Arc & String
: Arc
: Fan

1

Arc & String

Proceed as you would to draw a circle or an
oval.
Click at start point.

Move to end point.
Click at end point.

 A radial line appears on the oval when the
mouse button is released.
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Fan

Drawing various shape
1
Click at start point.

2

Click the [Home] tab.
Click [Shapes] in the [Tools] group, and then
click a tool icon under [Shapes] to select the
desired Shapes tool.

Move to end point.
Click at end point.

• You can change the color and sew type either
before or after drawing the shape.
cc "Setting the sew type" on page 49
• You can also use the settings in the [Sewing
Attributes] pane to define other attributes of the
shape before or after drawing the shape.
cc "Specifying sewing attributes" on page 54

3

Drag the pointer in the Design Page.

b
• To draw the shape while maintaining the original
height-to-width proportion, hold down the
<Shift> key while dragging the pointer.
• Various sample shape patterns are available in
the [Import] pane when [Outline Shapes] is
selected in the [From] selector and [Basic
Shapes] is selected in the [Category] selector.
cc "Using the Import pane" on page 13
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Drawing Shapes

Drawing outlines (straight
lines and curves)

3

Click in the Design Page or drag the pointer to
draw the line.

b
The shortcut keys are available only after an
Outline tool has been selected.

End point
Start point
Open line

Closed line

■ Straight lines/curves
1 Click in the Design Page to specify the start
point.

End point

Start point
Open curve

1
2

Closed curve

Click the [Home] tab.

2

Click in the Design Page to specify the next
point.

Click [Shapes] in the [Tools] group, and then
click a tool icon under [Outline] to select the
desired Outline tool.

 The dotted lines change to solid lines.

b
: Click points to draw a closed line
constructed of straight lines.
(Shortcut key: <Z>)
: Click points to draw a closed curve.
(Shortcut key: <X>)
: Drag the pointer to draw a closed
freehand curve.
: Click points to draw an open line
constructed of straight lines.
(Shortcut key: <Z>)
: Click points to draw an open curve.
(Shortcut key: <X>)
: Drag the pointer to draw an open
freehand curve.

63

• To remove the last point that was entered, rightclick the mouse button, or press the
<BackSpace> key.
• The Curve tool is used in the same way.

3

Continue clicking to specify every point, and
then double-click the last point, or press the
<Enter> key.

Drawing Shapes

b
• You can freely switch between the different line
types either by clicking a different button or by
pressing the shortcut key.
• When drawing a straight line, hold down the
<Shift> key while moving the pointer to draw
vertically or horizontally.
• Even after the pattern is drawn, you can change
the attributes of line ends.
cc "Changing the attributes of line ends" on
page 64.

Changing the attributes of
line ends

After selecting a shape pattern, right-click it, and
then click [Open] or [Close] to change the line
ending.

• Even after the pattern is drawn, you can
transform straight lines into curves and vice
versa.
cc "Transforming straight lines into curves or
curves into straight lines" on page 70.

2

Release the mouse button to finish drawing.

b
In addition, closed shape patterns can be split at
points to create open lines, or the end points of
open shape patterns can be connected to create
closed lines.
cc "Connecting points/splitting outlines (shape
patterns)" on page 67
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■ Freehand lines
1 Drag the pointer to draw the line.

Drawing Shapes

Embroidery attributes of
shapes
The [Shapes] tab allows you to set the embroidery
attributes (thread color and sew type).
Example: When a rectangle is selected.

a

a

c

b

Line color/Region color
Click this button to set the thread color for
lines and regions.
For special colors:

cc "Special colors" on page 48
b

Line sew type selector
All lines in a shape can be set to the same
sew type.
Use these selectors to set the sew type for
lines.

cc "Line sewing attributes" on page 325
c

Region sew type selector
All regions in a shape can be set to the
same sew type.
Use these selectors to set the sew type for
regions.

cc "Region sewing attributes" on page 331
cc "Specifying Thread Colors and Sew
Types for Lines and Regions" on page 46

b
• To turn off line sewing, select [Not Sewn (Line)]
from the [Line sew type] selector.
• To turn off region sewing, select [Not Sewn
(Region)] from the [Region sew type] selector.
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Reshaping Embroidery Patterns
Patterns can be reshaped by moving, adding or deleting points. While creating shape patterns, a clicked
location becomes a point.

Selecting points

Moving points

1

Click the [Home] tab.

1

Select the point.

2

Click [Select] in the [Select] group, and then

2

Drag the point to the new location.

click

to select the [Select Point] tool.

Selected point

Click the pattern.

4

To select a single point, click an empty square.

b
Multiple points can be selected in any of the
following ways.
• Drag the pointer.
 All points within the box are selected.
• Hold down the <Ctrl> key while clicking the
points.
 To deselect a point, click the selected
point.
• Hold down the <Shift> key while pressing an
arrow key to select multiple points.
• Hold down the <Ctrl> key while pressing an
arrow key to change the point that is selected.

b
• To move the point of a broken line, a curve, or
stitch data horizontally or vertically, hold down
the <Shift> key while dragging it.
• A selected point can also be moved with the
arrow keys.
• Points in patterns set for hole sewing can also
be moved. However, the point cannot be moved
to cross an outline. In order to move the point in
this way, cancel hole sewing first.
• If you start dragging by clicking elsewhere on the
outline of the pattern, a new point will be inserted
or the selected point(s) will be deselected.
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Drag

3

Reshaping Embroidery Patterns

Inserting points
1

Click the [Home] tab.

2

Click [Select] in the [Select] group, and then
click

to select the Select Point tool.

Connecting points/
splitting outlines (shape
patterns)
■ Splitting outlines of open shape
patterns
The outline of an open shape pattern can be split at
a point.

1

Select a point in an open shape pattern.

2

Click the [Shapes] tab.

3
3

Click the pattern.

4

Click the outline to add a point.

Click

Deleting points
1

Select the point.

2

Click the [Shapes] tab.

3

Click [Delete Point] in the [Edit Point] group.
Otherwise, press the <Delete> key to remove
the point.

Delete

Selected point
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Click [Split at Point] in the [Edit Point] group
to split the line.

Reshaping Embroidery Patterns
■ Splitting outlines of closed shape
patterns

b

The closed path of a shape pattern can be split. The
closed path consists of the points that are
connected to create the shape pattern.

• When the outline of a closed shape pattern is
split to create an open shape pattern, region
sewing attributes can no longer be specified.

Select a point in a closed shape pattern.

2

Click the [Shapes] tab.

• The [Open] command is also available to
change a closed shape pattern to an open
shape pattern.

Click [Split at Point] in the [Edit Point] group
to split the line.

cc "Changing the attributes of line ends" on
page 64

3
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1

b
• If a shape pattern is split in a shape with hole
sewing applied, hole sewing will be canceled.
• If a shape pattern is split in a shape with fit text
to outline applied, fit text to outline will be
canceled.
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Reshaping Embroidery Patterns
■ Connecting two open shape
patterns

■ Connecting the two end points of
a shape pattern

The end points of two shape patterns can be
connected to create a single shape pattern.

The two end points of an open shape pattern can be
connected to create a closed shape pattern.

1

Select an end point (entry point or exit point).

1

Select an end point (entry point or exit point).

2

Press the <Alt> key.

2

Press the <Alt> key.

 The points that can be connected appear
as ×.

 The other end point appears as ×.

3

b

While holding down the <Alt> key, drag the
selected point to the other end point.

The other end point of the shape pattern whose
point is selected as well as the end points (entry
points and exit points) of other shape patterns
appear as ×.

3

While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.
 The shape of the pointer changes to

4

,

When the two points are overlapping and the
red square appears, release the mouse
button.

and a red square appears when the two
points are overlapping.

a
4

Release the mouse button to connect the two
points.

When a shape pattern is closed, its region sewing
attributes may appear.

b
The [Close] command is also available to change
an open shape pattern to a closed shape pattern.
cc "Changing the attributes of line ends" on
page 64
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Transforming straight
lines into curves or curves
into straight lines
1

Select the point.

2

Click the [Shapes] tab.

3

Changing the curve type
1

Select a point on a curve.

2

Click the [Shapes] tab.

3

Click [Edit Point] in the [Edit Point] group,
and then click [To Smooth], [To Symmetry]
or [To Cusp].

Click [Edit Point] in the [Edit Point] group,
and then click [To Straight] or [To Curve].
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To Smooth
To Curve

To Straight

To Symmetry

To Cusp

4

Drag the solid black handle to adjust the
shape of the line.

b
The shape can be changed by dragging the solid
black handle on either side of the point.
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Editing a Stitch Pattern
Converting shape pattern
or text pattern to a stitch
pattern
Shape pattern or text pattern can be converted into
a stitch pattern, allowing you to make detailed
changes by modifying the position of individual
stitches.

1
2

Select the shape pattern, and then click the
[Shapes] tab.

b
• [Convert to Stitches] can also be used with text
pattern to convert it to stitch patterns.
• In stitch patterns, stitches appears as solid lines
(
), and jump stitches appear as dotted
lines (
).
• If any part of grouped patterns, patterns set for
hole sewing, and text arranged on shapes is
selected, all patterns in the entire group are
converted to stitch patterns.
• Patterns that do not have stitches are deleted
when the pattern is converted to a stitch pattern.

Click [Convert to Stitches] in the [Edit]
group.

Selecting stitch patterns
by thread color
Hold down the <Alt> key and click the thread color
for the stitch patterns that you wish to select.

b
• The thread color can be changed when patterns
are selected using this method.
cc "Setting the thread color" on page 46
• If stitch patterns are grouped, patterns cannot be
selected by color using this method.
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Editing a Stitch Pattern

Selecting stitch points of
stitch pattern
1

Click the [Home] tab.

2

Click [Select] in the [Select] group, and then
click

to select the Select Point tool.

b
• When selecting stitch points, be sure to click the
stitch point (do not click a blank area of the
Design Page), otherwise all of the selected
points will be deselected.
• If you click on a jump stitch, the points at both
ends are selected.
• Multiple stitch points can be selected in the
same way that embroidery pattern points are
selected.
cc "Selecting points" on page 66

a
3

Click the stitch pattern.
To select a single stitch point, click an empty
square.

■ Moving stitch points
Drag the selected stitch points to the new location.

1

2

1 Selected point
2 Unselected point

b
Stitch points are moved in the same way that
embroidery pattern points are moved.
cc "Moving points" on page 66

b
• Press the <Tab> key.
 All stitch points in the next color are
selected.
• Press the <Shift> and <Tab> keys.
 All stitch points in the previous color are
selected.
• Press the <Ctrl> and <Home> keys.
 The entry point of the first thread color is
selected.
• Press the <Ctrl> and <End> keys.
 The exit point of the last thread color is
selected.
• Select at least one point in a given color, and
then press the <Home> key.
 The entry point of the color is selected.
• Select at least one point in a given color, and
then press the <End> key.

■ Inserting stitch points
Click a line between two stitch points to add a new
point at that position.

■ Deleting stitch points
Press the <Delete> key to delete the selected stitch
point.

b
• If the end point of a jump stitch is deleted, that
jump stitch segment is deleted and the stitches
before and after the jump stitch are connected.
• To insert a stitch point and change the previous
line into a jump stitch, hold down the <Ctrl> and
<Shift> keys while clicking on the line.

 The exit point of the color is selected.
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Stitch points cannot be edited if the pattern is not a
stitch pattern. The pattern can be viewed in Solid
View.

Editing a Stitch Pattern

Connecting points/
splitting stitches (stitch
patterns)
A single color pattern can be divided into two by
splitting stitches at a point, and two color patterns
can be combined into one by connecting points. If a
stitch pattern is divided into multiple parts, each part
can be edited separately, such as changed to
different colors.

■ Splitting one stitch pattern into
two at the selected point
1 Select a point in a stitch pattern.
2
3

Click the [Stitches] tab.
Click [Split at Point] in the [Edit] group to split
the stitch pattern.

a
If an entry point or an exit point is selected, the
[Split at Point] is not available.

■ Connecting two stitch patterns to
create a single one
1 Select an end point (entry point or exit point) of
a stitch pattern.

b
Select the entry point of the stitch pattern by
pressing keys <Ctrl> + <Home>. Select the exit
point by pressing keys <Ctrl> + <End>. For
details, refer to "Selecting stitch points of stitch
pattern" on page 72.

2

Press the <Alt> key.
 The points that can be connected appear
as ×.

 The stitch pattern is split at the point.

b
If the entry point of a stitch pattern is selected, the
exit points of the other stitch patterns appear as ×.
If the exit point of a stitch pattern is selected, the
entry points of the other stitch patterns appear as
×.
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3

While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.

2

Click [Split Stitches] in the [Tools] group to
select the [Split Stitches] tool.

 The shape of the pointer changes to
,
and a red square appears when the two
points are overlapping.

 All other patterns will appear in gray.
Selected pattern will appear in front of other
patterns.

4

Release the mouse button to connect the two
points.

4

Click in the Design Page at the point where
you want to start drawing the enclosing lines.
Continue clicking in the Design Page to
specify each corner of the enclosure around
the area to be cut off.

b
After the points are connected, the pattern will
have the thread color of the pattern that was first in
the sewing order before the points were
connected.

b

Splitting off parts of a
stitch pattern

To remove the last point that was entered, rightclick the mouse button.

5

Double-click in the Design Page to specify the
section to be split off.

b
The cutoff piece moves to the end of the sewing
order.

1

Select a stitch pattern, and then click the
[Stitches] tab.

cc "Checking and Editing the Sewing Order" on
page 82
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Editing a Stitch Pattern

Dividing stitch pattern by
color

Convert to Blocks
The pattern is converted while maintaining the
multiple sewing direction lines.
Use this when you want to enlarge or reduce an
embroidery pattern that uses satin or fill stitches.

Before dividing

Convert to Outline
The pattern is converted following the shape of the
outline.

After dividing

b
• After being converted, the outline patterns can
be edited.

1
2

cc "Setting the sew type" on page 49
"Specifying the sewing direction" on
page 51
"Specifying sewing attributes" on
page 54
"Reshaping Embroidery Patterns" on
page 66

Select the stitch pattern(s), and then click the
[Stitches] tab.
Click [Divide by Color] in the [Edit] group.

• For details on the shape pattern and stitch
pattern refer to page 8.

 Dotted lines appear around each part of the
stitch pattern.

Converting stitch patterns
Stitch patterns can be converted into two types of
shape patterns.

■ Converting stitch pattern to
blocks
Stitch patterns can be converted into blocks (group
of shape patterns with multiple sewing direction
lines). In blocks (shapes) pattern, the sew types and
sewing attributes can be changed, and the pattern
can easily be edited.

Stitch

1
2

Blocks

Shapes

*Blocks: A group of shape patterns with multiple
sewing direction lines
After being converted, various editing operations
can be performed.
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Select the stitch pattern(s), and then click the
[Stitches] tab.
Click [Convert to Blocks] in the [Edit] group.

Editing a Stitch Pattern
3

Move the slider to select the desired
sensitivity. Click [OK].

1

Select the stitch pattern(s).

2

Click the [Stitches] tab.

3

Click [Convert to Outline] in the [Edit] group,
and then click [Convert Whole to Outline] or
[Convert Parts to Outlines].

b
The [Normal] setting should provide satisfactory
results in most cases, but depending on the
complexity of the pattern, you may need to select
a setting more towards [Coarse] or [Fine].

cc For details see the following instructions;
"Setting the sew type" on page 49
"Specifying sewing attributes" on
page 54
"Reshaping Embroidery Patterns" on
page 66
"Specifying the sewing direction" on
page 51

a
The [Convert to Blocks] command cannot be
used with some stitch pattern imported from
original cards.

b
• Line sewing in the created outline patterns is set
to [Not Sewn (Line)], and region sewing is set
to [Fill Stitch].
• If the [Convert Whole to Outline] command is
selected, the thread color will be set to the first
thread color in the sewing order for the original
stitch pattern.
• If multiple outline patterns are created from a
single stitch pattern, the outline patterns are
grouped.
• If there is an opening (area with no stitching, but
surrounded by stitching) in the original stitch
pattern, hole sewing may be applied.

■ Converting stitch pattern to
outline pattern
Outline patterns can be created from each color in a
stitch pattern or from an outline around the entire
pattern.
1

2

1 Convert Whole to Outline
2 Convert Parts to Outlines
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 The stitch pattern is converted to grouped
shape patterns. Being converted to shape
patterns, the outlines of the stitch pattern
can be edited.

 The outline patterns are created, and the
original stitch patterns are deleted.

Checking Embroidery Patterns

Checking Embroidery Patterns
Zooming

Using the Pan tool

1

Click the [Home] tab.

The part of the work area that is displayed can easily
be changed by using the Pan tool.

2

Click

1

Click the [Home] tab.

2

Click

3

Drag the work area to view the desired part.

or

in the [Tools] group.

in the [Tools] group.

: Click the Design Page to zoom in.
(Right-click the Design Page to zoom
out.)
: Click the Design Page to zoom out.
(Right-click the Design Page to zoom
in.)
Otherwise, click
beside
, and then
click [Zoom all], [Selected object zoom] or
[Actual size zoom].

Zoom all
The entire Design Page is displayed to fit
within the window. The same operation can be
performed by clicking
group.

in the [Tools]

Selected object zoom
The Design Page is zoomed to display only
the selected objects.
Actual size zoom
The Design Page is displayed at its actual
size.

b
• Zooming is also possible by dragging the
[Zoom] slider in the status bar or clicking the
Zoom ratio.
• You can also zoom in or out when any other tool
is selected by holding down the <Ctrl> key while
rotating the mouse wheel.
cc "Layout & Editing Window" on page 11
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b
• You can also pan the work area when any other
tool is selected by holding down the <Space>
key while dragging the pointer.
• To scroll horizontally, hold down the <Alt> key
while rotating the mouse wheel.

Checking Embroidery Patterns

Using the Measure tool
1

Click the [Home] tab.

2

Click

3

Changing the display of
the embroidery design
1

in the [Tools] group.

2

Click the [View] tab.
Click [Solid], [Stitch] or [Realistic] in the
[View Mode] group.

Click the two points, one on each end of the
distance that you want to measure.
 The length appears in the status bar.
1

■ Solid View

4
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3

2

■ Stitch View
1
2
3
4

Length
Width
Height
Angle

b
When the rulers are displayed, click
/
to
switch the measurement units between millimeters
and inches.
You can display a stitch view of it in order to see how
the stitching is connected.
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■ Realistic View

b
If

is selected under [Machine Type] in the

[Design Settings] dialog box, click the [View] tab,
and then select the [View Thread Trimming]
check box to view the thread trimming locations in
the Design Page.

You can display a realistic view of it in order to see
how the design will appear once it is sewn.
OFF

ON

b
Changing realistic view settings
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1.

Click the [View] tab.

2.

Click [Realistic View Settings] in the [View
Mode] group.

3.

If necessary, specify settings for [Thread
Width], [Contrast] and [Brightness], and
then click [Apply] ([OK]).

Checking Embroidery Patterns

Checking the stitching with the Stitch Simulator
1

Click the buttons to view a simulation of the stitching.
c

f

g

a

a

h

i

, which can be clicked to

temporarily stop the simulation.
Stops the simulation and returns to the
previous display.

c

The slider shows the current location in
the simulation. In addition, the slider can
be moved to change the position in the
simulation.
: Returns to the beginning of stitching
and stops the simulation.
: Advances to the end of stitching and
stops the simulation.

d

Drag the slider to adjust the simulation
stitching speed.

e

Select this check box to automatically
scroll the simulation of the pattern when it
is too large to be fully displayed.

f

Click to hide the bottom section of the
Stitch Simulator. Click
again.

g

to display it

Shows the number of the current stitch/
total number of stitches.
: Reverses the
simulation by the indicated number of
stitches.
: Advances the
simulation by the indicated number of
stitches.

h

e

Shows the currently displayed pattern
section/total number of hoop sections in
the pattern.
(Appears only for split embroidery
patterns.)
: Returns to the beginning of
stitching in the current or previous hoop
section.
: Advances to the beginning of the
design in the next hoop section.

a
If the Stitch Simulator is not displayed at the
bottom of the window, click [Stitch Simulator] on
the [View] tab.

b
• The zoom tools and pan tool can be used while
a simulation is being viewed. If any other
command is selected, the simulation stops.
• If a value is entered at g, h or i, the
simulation is reversed/advanced to the indicated
location.

a
• If a pattern was selected when the stitching
simulation was started, only the selected pattern
is drawn in the simulation.
• The [Auto Scroll] check box is not available in
Realistic View.

Shows the number of the color being
drawn/total number of colors used.
: Returns to the beginning of
stitching for the current or previous thread
color.
: Advances to the beginning of
stitching for the next color.
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b

d

i

Starts the stitching simulation. During
stitching simulation, this button changes
to

b

Checking Embroidery Patterns

Viewing design in the
Reference Window
1
2

■ Zooming
The Reference Window can be switched to display
either the entire Design Page or only the embroidery
pattern.

Click the [View] tab.
Select the [Reference Window] check box in
the [Show/Hide] group.

ON

The display are a frame (red rectangle) indicates the
part of the pattern displayed in the Design Page.
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OFF

Checking Embroidery Patterns
■ Moving/Resizing/Redrawing the
display area frame
The part of the design displayed in the Design Page
can be selected from the Reference Window.

Checking and Editing the
Sewing Order
a

e

1
2

f

g

c

d

h

a

Select how patterns are displayed in the
[Sewing Order] pane.

b

Select the desired command to change
the sewing order.

c

Optimize Sewing Order
Click to rearrange the sewing order so
that the parts of the entered objects with
the same thread color will be sewn
together.

d

Thread Color
Set the color of the selected object.

e

Show/hides in the work area the stitched
objects.

f

Lock
Click to lock the selected object so it
cannot be edited.

g

Jump Stitch Trimming
The Jump Stitch Trimming function can
be turned on or off.

h

Select Patterns
Selects the patterns in the Design Page.

Click the [View] tab.
Click [Sewing Order] in the [Show/Hide]
group.
Clicking the button switches between
displaying and hiding the Sewing Order.

a
With the frame, you can select the area in the
Reference Window to be displayed enlarged.
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Instead of moving the display area frame, the frame
can be redrawn to display the desired part of the
pattern in the Design Page.

b

Checking Embroidery Patterns
3

Click
in the [Sewing Order] pane, and
then click [Zoom] and [Show by color order].

Zoom
Click to enlarge each pattern to fill its
frame.

■ Sewing order optimization
The sewing order and entry and exit points can be
automatically adjusted to reduce the number of
thread color changes and jump stitches.
Click
to optimize the
sewing order.
For the pattern at the right
(the numbers indicate the
sewing order), the sewing
order will be adjusted as
shown below.

1

2

4

3

Show by color order
Click to display in one frame all
patterns of the same color that will be
sewn together.
OFF

ON

The sewing order is adjusted so that patterns of the
same color are grouped in the most optimized
sequence.

b
When multiple same color
patterns are combined into
one frame,
appears to the
left of that frame.
Click
to display the
combined same color patterns
in separate frames.
appears under the first
frame, and each frame is
displayed with a subnumber
following the first, to indicate
its sewing order within the
patterns of the same color.
Click
to recombine all of
the same color patterns back
into one frame.
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In addition, patterns of the same color are optimized
so that the exit point of the previous pattern and the
entry point of the next pattern are the closest points.

a
However, overlapping
patterns will be arranged in
the most appropriate
sewing order.

Checking Embroidery Patterns

b
• The patterns in locked frames and hidden
frames will also be optimized.
• The sewing order of multi-position patterns will
not be optimized.

■ Selecting a pattern
1 Click a frame containing the pattern in the
[Sewing Order] pane.

cc "Optimizing the sewing order" on page 38

■ Editing the sewing order

clicking
in the [Sewing
Order] pane, then clicking the
desired command in the menu
that appeared.

1
1 Blue line
2 Marching line

b
To select multiple patterns, hold down the <Shift>
or <Ctrl> key while clicking the frames for the
desired patterns. In addition, multiple frames can
be selected by dragging the pointer over them.

2

Sew First
Click to move the selected pattern to the beginning
of the sewing order.

2

Click
in the [Sewing Order] pane to
select the pattern in the Design Page
corresponding to the frame selected in the
[Sewing Order] pane. The pattern can also
be selected by double-clicking its frame in the
[Sewing Order] pane.

Sew Previous
Click to move the selected pattern ahead one
position in the sewing order.
Sew Next
Click to move the selected pattern back one position
in the sewing order.
Sew Last
Click to move the selected pattern to the end of the
sewing order.

a
Check the stitching after changing the sewing
order to be sure that overlapping patterns will not
be sewn in the wrong order.
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The sewing order can be
changed by selecting the frame
containing the pattern, then
dragging the frame to the new
location. A red line appears,
indicating the position where the
frame is being moved.
The frame can also be moved by

Checking Embroidery Patterns
■ Changing colors
1 Select one or more frames in the [Sewing
Order] pane, and then click
the [Sewing Order] pane.

at the top of

 The Color pane appears in front of the other
panes.

2

■ Displaying/hiding frames not
sewn
Frames containing patterns that will not be sewn
can be displayed or hidden.
Click

, then [Hide Objects Not Stitched].

Click the desired color in the [Color] pane.

OFF

ON

cc "Color pane" on page 46

■ Changing sewing attributes
1 In the [Sewing Order] pane, select one or
more frames containing a pattern other than a
stitch pattern.
 The sew type selector for the selected
frame appears.

2

Click the [Sewing Attributes] tab.
If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then
[Attributes], and then click [Sewing
Attributes].

3

Change the sewing attributes and sew type.
cc "Line sew types", "Region sew types" on
page 49 and "Specifying sewing
attributes" on page 54
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As a default, frames containing patterns that will not
be sewn will be hidden.
When frames containing patterns that will not be
sewn are displayed, that frame can be selected and
its pattern can be edited.

Checking Embroidery Patterns
■ Displaying embroidery patterns

■ Locking embroidery patterns

Each embroidery patterns can be displayed or
hidden in the Design Page. Overlapping embroidery
patterns can easily be edited if the pattern not being
edited is hidden.

Embroidery patterns can be locked to prevent them
from being moved or deleted. Locked embroidery
patterns cannot be selected or edited in the Design
Page.

Select a frame, and then click

Select a frame, and then click

.

.

b
ON

OFF

• Frames with
contain multiple patterns of the
same color. If these frames are selected to be
locked, all patterns in the frame are locked.
•

appears if the lock setting is not the same for

b
• Frames with
contain multiple patterns of the
same color. If these frames are selected to be
displayed, all patterns in the frame are
displayed.
•

appears if the display setting is not the

same for all patterns in a frame with
beside
it.
• Displaying either the line or region of an
embroidery pattern made up of an outline and
inside region displays the entire embroidery
pattern.
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all patterns in a frame with
beside it.
• Locking either the line or region of an
embroidery pattern made up of an outline and
inside region locks the entire embroidery
pattern.
• Locking any part of a combined pattern, such as
grouped patterns, text arranged on a curve or
patterns with hole sewing specified, locks the
entire embroidery pattern.

Checking Embroidery Patterns

Jump Stitch Trimming
The Jump Stitch Trimming function can be turned on
or off.

a
These settings are applied only when
embroidering with our multi-needle embroidery
machines. Before these settings can be specified,
select

under [Machine Type] in the

[Design Settings] dialog box.

b
•

appears if the thread trimming setting is not

the same for all patterns in a frame with
beside it.
• The thread is cut before the thread color is
changed, even if [Jump Stitch Trimming] has
been turned off for the frame.
• Click the [View] tab, and then select the [View
Thread Trimming] check box in the [View
Mode] group. To view the thread trimming
locations in the Design Page.

cc "Specifying the Design Page Settings" on
page 14
The Jump Stitch Trimming button (
in the [Sewing Order] pane.

Select a frame, and then click

ON

) is available

.

OFF

About Minimum jump stitch length for thread
trimming
• The jump stitch length can be specified on the
[Output] tab into the [Design Settings] dialog
box. (To displayed it, click
Settings]).

, then [Design

• If the jump stitch length is less than the length
specified for [Minimum jump stitch length for
thread trimming], the thread will not be cut,
even if [Jump Stitch Trimming] has been set.
• Whether or not [Minimum jump stitch length
for thread trimming] is available differs
depending on the selected machine model. For
details, refer to the Operation Manual for the
machine.

87

Checking Embroidery Patterns

b
The default setting can be specified for whether or
not thread trimming is applied to objects that are
created.
Click [Option] above the Ribbon, and then click
[Options] to display the [Options] dialog box.
Next, click [Jump Stitch Trimming], and then
select or clear the [Add jump stitch trimming to
the entered patterns.] check box.

You can enter comments and information about the
pattern to a saved .pes file.

b

cc "Jump Stitch Trimming" on page 16,
"Machine thread trimming according to
settings specified in Layout & Editing" on
page 297 and "Adding jump stitch
trimming to new patterns" on page 302

The information shown in the color list can be
switched.
• Color Changes
The thread color information for each color
change is displayed. This allows you to check
the total number of thread color changes.

Checking embroidery
design information
Click

, then [Design Property].

• Total Colors
The thread color information for the necessary
threads is displayed. This allows you to check
the total number of thread colors.
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cc "Adding jump stitch trimming to new patterns"
on page 302

Checking Embroidery Patterns

b
• You can select and check the properties of
individual patterns within the embroidery design
by selecting the pattern before opening this
dialog box. In this case, clearing the [Show
about selected Object(s)] check box switches
the dialog box to display properties for all
patterns in the Design Page.
• If the Design Page was set to [Custom Size] or
[Hoop Size] was set to a multi-position hoop
(100 × 172 mm or 130 × 300 mm) or the jumbo
frame (360 × 360 mm), a [Design Property]
dialog box appears with the sewing information
for each hoop of the pattern in the Design Page.

• Files can be searched for in Design Database
according to the entered information.
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Opening/Importing Embroidery Designs
Creating a new embroidery
design
Click

, then [New].

The size of the Design Page can be changed.
cc "Specifying the Design Page Settings" on
page 14

• To view the data in the selected folder as
thumbnails in the [Browse] dialog box, click
[Browse].

To see a more detailed design, select a file, and
then click [Preview].

Opening a Layout &
Editing file
1

2

Click

, then [Open].

Select the drive, the folder and the file, and
then click [Open], or double-click the file's
icon.

• To open the displayed file, click [Open].
• If no files are listed, there are no .pes files in the
selected folder. Select a folder containing a .pes
file.
• If the selected file is in a format other than the
.pes format, the message "Unexpected file
format" appears in the [Preview] window.

b
A file can be opened in any of the following ways.
• Drag the embroidery design from file Windows
Explorer into the Layout & Editing window.
• Double-click the embroidery design file in
Windows Explorer.
• Double-click the embroidery design file in
Design Database.
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b

b

Opening/Importing Embroidery Designs

Importing embroidery
designs
Embroidery designs can be imported from the
[Import] pane. For more details on the [Import]
pane, refer to "Example of Importing Embroidery
Data" on page 13.

■ From a folder
1 Click the [Home] tab.
2

Click [Import Patterns] in the [Import] group,
and then click [from File].

■ From Design Library
1 Click the [Home] tab.
2

Click [Import Patterns] in the [Import] group,
and then click [from Design Library].

3

Click

.
1

3

From the [Category] selector, select a
category to display the corresponding
embroidery data.

1 Indicates the path to the currently selected
folder.

4
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Select the file icon for the design to be
imported, and then click [Import].

Opening/Importing Embroidery Designs
4

Select a folder, and then click [OK].

■ From an original card
1 Insert an original card into the USB card writer
module.
cc Refer to "Transferring to a machine by
using an original card" on page 202

2
3

5

Click the [Home] tab.
Click [Import Patterns] in the [Import] group,
and then click [from Card].
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Click [File Type] in the [Import] pane. Select
the file name extensions of the corresponding
embroidery data to be displayed, and then
click [OK].
 After the card has been read, the
embroidery designs on the card are
displayed.

6

Select the file icon, and then click [Import].

a
When importing designs from other vendors, be
sure to choose a design that will fit in the Design
Page.

b
Since .dst files do not contain thread color
information, the colors of an imported .dst file may
not appear as expected. You can change the
thread colors by using functions in the [Sewing
Order] pane or by holding down the <Alt> key and
selecting a stitch pattern.
cc "Selecting stitch patterns by thread color" on
page 71
• When importing .dst files, the number of jump
stitches for thread trimming can be specified.
cc "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

4

Select the file icon, and then click [Import].

a
Due to copyright issues, some original cards
cannot be used with this function.
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Importing vector images
(WMF/EMF/SVG)
Vector image data in the ".wmf" (Windows Metafile),
".emf" (Enhanced Metafile) and ".svg" (Scalable
Vector Graphics) file formats can be converted to
shape patterns.

1
2

Click the [Home] tab.

a
• Image, text, width of the line, gradient, opacity,
and any other styles or attributes of graphics will
not be imported. With files in the ".emf" and
".svg" formats, the data is converted while
retaining curves.
• The data on all layers of an SVG file, regardless
of whether it is displayed or hidden, will be
converted into the embroidery pattern.

Click [Import Patterns] in the [Import] group,
and then click [Import from Vector Image].

■ Creating an embroidery pattern
using vector images drawn with
other image-editing applications
Being converted to the ".svg" file format, vector
image files created with other commercially
available applications (e.g., ".ai" (Adobe Illustrator
Artwork) and ".cdr" (CorelDraw file)) can be
imported.

3

Select the drive, folder and file, and then click
[Open].

First convert the vector image files into either of
WMF, EMF or SVG file format with your
applications, and then import them to Palette by
following the steps described in "Importing vector
images (WMF/EMF/SVG)".

b
Raster image files (e.g., ".bmp" and ".jpg") can be
used as background images in Palette, or they can
be converted to embroidery patterns using the
Image To Stitch Wizard.
cc For details, refer to page 131.

 The imported image appears in the Design
Page.
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Importing embroidery
design from Design Center
1

Start up Design Center and open the file.
cc "Original Image Stage" on page 212 and
"Opening a file" on page 223

2

Click the [Home] tab.

3

Click [Import Patterns] in the [Import] group,
and then click [from Design Center].
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4

Specify the desired settings beside [Import],
[Magnification] and [Orientation], and then
click [Import].

Import
As Stitches:
Imports, as stitch patterns, embroidery data
created in Design Center.
As Outlines:
Imports, as outline patterns, embroidery data
created in Design Center. This data can be
edited in the same way as outline patterns
created in Layout & Editing.

a
The maximum magnification ratio that can be
specified is the ratio that enlarges the design to the
size of the Design Page.
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Saving and Printing
Saving

a

■ Overwriting
Click

, then [Save].

If you select a file type of a previous software
version, saved .pes files can be opened with that
version of the software; however, all saved
designs will be converted to stitch pattern.

3

Click [Save] to save the data.
 The new file name appears in the title bar of
the Layout & Editing window.

■ Outputting design in a different
format
The data shown in the Design Page can be exported
as a file of a different format (.dst, .hus, .exp, .pcs,
.vip, .sew, .jef, .csd, .xxx, and .shv).

b
If no file name has been specified or if the file
cannot be found, the [Save As] dialog box
appears.

1

Click

, then [Export].

■ Saving with a new name
1

2
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Click

, then [Save As].

Select the drive and the folder, and then type
in the file name.

2

Select the drive and the folder, and then type
in the file name.

Saving and Printing
3

Select a format (.dst, .exp, .pcs, .hus, .vip,
.shv, .jef, .sew, .csd, or .xxx) that the file will be
exported as.

b
The [Number of jumps for trim] setting can be
specified for outputting to the .dst format. Before
outputting, click the [Option] button, then
[Options], then [DST Settings] to specify the
settings.

a

Specify the paper size.

b

Specify the paper orientation.

c

To print the embroidery pattern, select
[Embroidery print mode].

d

Print type
Actual Size:
Select this option to print the design at
actual size and the sewing information
(dimensions of the embroidery pattern,
sewing color order, stitch count and
hoop position) on separate pages.

cc "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

Reduced Size:
Select this option to print a reduced
image together with all of the abovementioned information on a single
page.

a

Printing
■ Specifying print settings
Before printing, you may need to change the print
settings for the embroidery design files.

1

Click

, then [Print], then [Print Setup].

e

Print option
Print image:
Select this check box to print the image
imported into the Design Page in
addition to the embroidery pattern.
However, any part of the image
extending out of the print area for the
embroidery will not be printed.
Print sewing area box & center axes:
(This setting is only available when
[Actual Size] is selected.)
: Select this option to print black
lines to indicate the sewing area
(refer to "Specifying the sewing
area" on page 16) and the center
axes for the data.
: Select this option to print an
embroidery positioning mark in
the center of the axes.
(This setting cannot be selected if
[Jumbo Frame] has been selected as
the Design Page size.)

a

b

c
d
f

Print template grid:
Select this check box to print green
lines to represent the grid printed on
the embroidery sheet included with the
hoop. (This setting cannot be selected
if User Hoop, [Cap Frame], [Cylinder
Frame], [Jumbo Frame], [Clamp
Frame] or [Round Frame] has been
selected as the Design Page size.)

e

g
h

i
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• Some patterns imported from original cards
cannot be exported.
• Divided embroidery patterns and embroidery
patterns for the jumbo frame or multi-position
hoop will be exported as a single file, and will not
be split into sections.

Saving and Printing
Print hoop section boundaries onto the
first page:
Select this check box to print the
sections of a design where the Design
Page has been set to a custom size or
to [Jumbo Frame]. The pattern
sections are printed in red.

g

When printing an imported image onto
iron-on paper or printable fabric, or when
printing the sheet for positioning the
embroidery in the printed image, select
[Image print mode], and then select an
option under [Material].

h

Material

Divide embroidery image into 2 pages:
Select this check box to print at actual
size and on A4- or Letter-size paper a
design that is larger than the paper size
by dividing it in two and printing each
half on different pages.
(This setting is only available when
[Actual Size] is selected in the [Print
Setup] dialog box and when the
Design Page is set to the larger hoop
sizes. This setting is not available if a
[User Hoop] size is selected.)
With this split printing feature,

Print the image on printable fabric or an
iron-on transfer sheet:
Select this option to print the
background image on iron-on paper or
fabric that can be printed on. Only the
image is printed.
Print a flipped image:
Select this check box to print the image
flipped on a vertical axis. When printing
on iron-on paper, the image is normally
printed flipped (mirror image). (For
details, refer to the instructions for the
iron-on paper that you are using.)
Select this option if your printer does
not have a function for printing a flipped
(mirror) image. (For details, refer to the
instructions for your printer.)

/

or
/
is printed in the lower-right
corner of the paper to indicate which
half is printed.
Color Changes:
Select this check box to print the thread
color change information for the
pattern.
When this check box is cleared, the
information for the necessary threads
is printed. This allows you to check the
total number of thread colors.
f

Print a sheet of paper for aligning the
printed image and the embroidery:
Select this option to print a sheet for
aligning the positions of the image and
embroidery. Positioning marks and
guide lines indicating the embroidering
area are printed on the image.

Stitch image

i

Normal:
Select this option to print the design as
lines and dots.

The position where the image is printed
on the paper can be changed. (Any part of
the image extending out of the print area
of the paper is not printed.) Click [Change
Position] to display the [Image Print
Position Setting] dialog box, and then
drag the image to the desired printing
position in the paper.

Realistic:
Select this option to print a realistic
image of the design. To change the
settings of the realistic image, click
[Attributes].
cc "Changing realistic view settings" on
page 79

a
If the [Divide embroidery image into 2 pages]
check box is cleared and you print on paper of a
larger size, the design does not print in two halves.
Likewise, if you print on paper of a smaller size, the
design might be cut off.
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Change Position

2

Click [OK].
cc "Changing the display of the embroidery
design" on page 78.

b
With embroidery patterns for the jumbo frame
The pattern in Side 2 of an embroidery pattern for
the jumbo frame is printed with the orientation of
the actual embroidery (rotated 180°).

Saving and Printing
■ Checking a print image
You can preview the contents of the Design Page
before printing.
Click

, then [Print], then [Print Preview].

The print image can also be displayed by clicking
[Print Preview] in the [Print Setup] dialog box.

You can print the Design Page together with its
sewing information.

1

Click

2

Select the necessary settings.

3

Click [OK] to begin printing.

4

, then [Print], then [Print].

Follow the instructions for the printer to finish
printing.
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b

■ Printing a Design Page with
sewing information

Saving and Printing
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Creating Embroidery Patterns
Containing Text

This section provides descriptions for entering
text and the various operations for arranging
them. In addition, details are provided for creating
embroidery patterns whose text can easily be
replaced.
From Layout & Editing, various embroidery
patterns can be created for text.
The following types of text can be created.
Built-in fonts:

This software is provided with 130 built-in
fonts. (10 built-in fonts are specifically for
small text)

TrueType fonts: TrueType fonts installed on your computer

can be used to create embroidery patterns.

Small text:

These small fonts have sizes between 3 and
6 mm (0.12 and 0.24 inch).
Because of their size, these fonts are useful
for beautifully sewing small text.

Monogram:

Design custom monograms by combining
text and decorative patterns.

User-defined
fonts:

User-defined fonts can be created by using
the Font Creator.

In addition, text can be arranged in the following
ways.
Text
arrangement:
Transforming:

The text can be arranged along an outline or
an arc.
Text can be transformed into any of the 26
Transform styles.

Tutorial 2: Using Templates

Tutorial 2: Using Templates
Using the [Template Wizard], you can easily create custom embroidery patterns by simply changing the text
in the patterns that are already available. Follow each step to create a custom embroidery pattern.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_2.
Step 1

Starting the Template Wizard

Step 2

Selecting the type of template to be used

Step 3

Editing the text

Step 4

Outputting the edited template

Step 1 Starting the Template
Wizard
When Layout & Editing starts up, the first dialog box
of the wizard appears.

1

Plug your USB media into the computer.

2

Click [Use Template Designs].
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Step 2 Selecting the type of
template to be used
1

Select [shirtsCH11B.pes] from the category
[Shirts_Chest], and then click [Next].

Tutorial 2: Using Templates
1

b
Various templates are available when [Template]
is selected in the [From] selector of the [Import]
pane.
Select [shirtsCH11B.pes] from the category
[Shirts_Chest], and then click [Template
Wizard] to open the Template Wizard.

Click "R" in the text edit box, to be changed,
and then click [Edit Text].
 The text is highlighted.

2

Type "S", and then press the <Enter> key.

Step 3 Editing the text

c

b

a

a

Text list: Edit the text here.

b

Preview window: Check the results of the
edited text.

c

Embroidery information for the template

3
4

Type "Championship", and then press the
<Enter> key.
Click [Next].
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 The results of editing appear in the preview
window.
The text "Sweetheart" in the second row is
highlighted.

Tutorial 2: Using Templates
■ Outputting the edited template

Step 4 Outputting the edited
template

USB media, a sewing machine, an original card or
the Link function can be selected as output
destinations.
a

1

b
c

2

Depending on the desired output destination,
prepare the USB media or original card.
Otherwise, connect the embroidery machine
to the computer.
Select the output destination from the [Send
To] selector, and then click [Send].

d

1

2

a

Edit in Design page
Click this button to open the template in a
Design Page, where it can be edited or
saved.

b

Send to selector
Select the output destination.

c

Send
Click this button to output the template.

d

Create New Embroidery Design
Click this button to return to the dialog box
for selecting a template. A different
template can be edited.

In the [Send To] selector, select your USB
media to be used, and then click [Send].

To create another embroidery pattern using a
different template, click [Create New
Embroidery Design]. The dialog box from
Step 2 appears.
To close the Template Wizard, click [Cancel].
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a
• Select an output destination according to the
method used to transfer data to your embroidery
machine.
• When no output destination is found, the [Send]
button will be grayed out and unavailable.
cc "Transferring Embroidery Designs to
Machines" on page 201 and "Using the Link
Function to Embroider From the Computer" on
page 204

Template Feature

Template Feature
Saving your design as a
new template
A design that you have created can be used as a
template.

1
2

Create an embroidery pattern that contains
text.
Apply the [Name Drop] attribute to the text.
cc "Tutorial 5: Creating Name Drop" on
page 124 and "Name Drop Feature
(Replacing Text)" on page 127

3

, then [Save As].

Creating Embroidery Patterns Containing Text

4

Click

Save the created embroidery pattern in a
folder of the [Template Library] folder. Select
the folder (Drive where Palette was
installed)\Program Files (x86)\Baby
lock\Palette Ver.10\Library\Template
Library\Sample, type in the file name, and
then click [Save].
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Tutorial 3: Entering text
This section describes the procedures for importing a transformed text pattern and editing the text.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_3.
Step 1

Importing a transformed text pattern

Step 2

Editing entered text

Step 1 Importing a transformed
text pattern
Import a text pattern from the [Import] pane.

1
2

Display the [Import] pane.

Step 2 Editing entered text
1
2

3

Sample built-in font patterns are available in the
[Import] pane when [Text] is selected in the
[From] selector.
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Click in the text field.
 The text pattern appears as dotted lines,
and the cursor appears at the end of the
text.

Select [Text] from the [From] selector and
[Transformed] from the [Category] selector.
Select [TT_001.pes], and then click [Import].

b

Select the imported text pattern, and then click
the [Text Attributes] tab.

Press the <BackSpace> key to delete the
text, and then click characters in the character
table to enter text. Finally, press the <Enter>
key to apply them.

b
For details on other ways to edit text, refer to the
section indicated below.
cc "Editing entered text" on page 107

Advanced Operations for Entering Text

Advanced Operations for Entering Text
Entering text
1

Click the [Home] tab.

2

Click [Text] in the [Tools] group, and then
click

6

Press the <Enter> key or click the Design
Page.

.

b

3

If necessary, change the font, text size, color
and sew type.
cc "Setting text attributes" on page 107 and
"Embroidery attributes for text" on
page 117

4

Click in the Design Page.

• Click [Hide List] to hide the character table.
While it is hidden, click [Show List] to display
the character table.

a
5

Type the text.

If the entered character is not available with the
selected font or if the character cannot be
converted to an embroidery pattern, the character
appears as
in the Design Page. If this occurs,
enter a different character.
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• Hold down the <Ctrl> key and press the
<Enter> key to enter a new line of text.
• Characters can also be entered by clicking them
in the character table. This is particularly useful
if you have to enter accented characters that are
not available on your keyboard.

Advanced Operations for Entering Text

Editing entered text

Setting text attributes

Switch to one of the following text edit modes, and
then type text as needed using the cursor appearing
at the end of the text.

Text attributes can be specified with the [Font]
selector and [Text Size] selector in the [Text] tab.

■ Using Text Attributes tab
1 Select a single text pattern.
2

Click the [Text Attributes] tab, and then click
in the text field.

b
The [Text] tab appears when a text pattern or a
Text tool is selected.

■ Font
Click the [Font] selector, and then select the
desired font.
a

■ Using Edit text tool
1 Select a single text pattern.
2

Click the [Text] tab, and then click [Edit Text]
in the [Edit] group.

■ Using keyboard
1 Select a single text pattern.
2

Press a character key in the keyboard.

■ Using Text tool
1 Click [Text] in the [Tools] group of the
[Home] tab, and then select

2
107

Click a text pattern to edit.

b

c

d

e

a

Font Type
• A number identifies built-in fonts.
•

identifies user-defined fonts.

•

identifies TrueType fonts.

b

Font sample
If a single string of text is selected, the
fonts in the list appear with the selected
characters.

c

Font name

d

Recommended minimum size

e

Most recently used fonts

.

Advanced Operations for Entering Text
4

b
• User-defined fonts

Select the check boxes for the fonts to be
displayed, and clear the check boxes for the
fonts to be hidden.

PEF files created with Font
Creator and saved in the [MyFont]
folder where Palette was installed
appear as userdefined fonts after
the fonts listed in the table above.
The UD icon appears on userdefined fonts.

cc "Font Creator" on page 274
• TrueType fonts
The installed TrueType fonts appear after the
user-defined fonts.

TrueType font settings can be changed in the
[TrueType Font Attribute Setting] dialog box.
cc "Specifying TrueType font attributes" on
page 110

5

b
To return the fonts to the default (all fonts
displayed), click [Default].

6

a

To filter the fonts, click [Font Filter] so that it
appears as
.
Clicking the button switches between filtering
and unfiltering the fonts.

• Text created using certain TrueType fonts may
not be converted correctly into an embroidery
pattern due to the shape of the character. These
characters cannot be embroidered correctly.
Test sew before embroidering on your project.
• In addition, text created using some TrueType
fonts cannot be converted at all.

■ Font Filter

Click [OK] to apply the filter settings.

b

A font listed in the [Font] selector can be selected.

The font filter cannot be applied to small text fonts.

1

cc "Small Text" on page 118

2
3

Click text or a monogram, or select the [Text]
tool or [Monogram] tool.
Click the [Text] tab.
Click
beside [Font Filter] in the [Font]
group, and then click [Font Filter Settings].
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b

The [Monogram] check box is available when
a pattern with a monogram font or the
[Monogram] tool is selected.

Advanced Operations for Entering Text
3

■ Text size

Change the text attributes.

Click the [Text Size] selector. Type the desired
height and press the <Enter> key, or select the
desired value.
Built-in fonts are listed in the [Font] selector with the
recommended minimum size. We recommend
using these fonts at a size equal or greater than the
size indicated.

a
b

1

c

d
e

1 Recommended minimum size

■ Specifying various text attributes
1 Select the text.
2

f

g

h
i

Click the [Text Attributes] tab.

j

If the [Text Attributes] pane is not displayed,
click the [View] tab, then [Attributes], and
then click [Text Attributes].

a

Kerning
0.0 mm

b

Vertical Offset
0.0 mm

c

2.0 mm

Rotate Angle
0°
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5.0 mm
(between "A" and "B")

20°

Advanced Operations for Entering Text
d

0.0 mm

e

2.0 mm

2

Line Spacing
100%

f

3
Center

Right

Transform

i

Click to return to the default setting.
Name Drop

cc "Name Drop Feature (Replacing Text)"
on page 127

b

a
• The settings for [Font style] and [Script] differ
depending on the TrueType font that is selected.
• If text created from multiple TrueType fonts is
selected, this command is not available. In
addition, if text of the same font but different font
styles or scripts is selected, this dialog box
appears with the attribute settings for the first
letter in the text. In either case mentioned above,
selecting only one character from within text
displays a dialog box containing only that
character's attributes.

• Both [Kerning] and [Character Spacing] set
the spacing between characters. [Character
Spacing] is always applied to the entire text
pattern, while [Kerning] can be applied to
individual characters.
cc Refer to "Editing individual characters" on
page 113 for more details about selecting
individual characters in a text pattern.
• Settings specified for [Kerning], [Vertical
Offset] and [Rotate Angle] in the [Text
Attributes] pane are applied to all selected
characters.
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Vertical

cc "Transforming text" on page 111

j

Select a font style from the [Font style]
selector, select a character set from the
[Script] selector, and then click [OK].

Direction
Horizontal

h

Click [TTF Settings] in the [Font] group.

150%

Alignment
Left

g

■ Specifying TrueType font
attributes
1 Select text in a TrueType font.

Character Spacing

Advanced Operations for Entering Text
■ Transforming text

If
was selected in step 2, the following
operations can also be performed.
Drag

1
2

,

and

to transform the text.

Select the text.
Select the [Transform] check box, and then
click the transformation shape button.
:Adjusts the text size.

:Moves the text along the circle.

Depending on the selected shape, a dotted
line and

or

appear around the text.

a
A text pattern contains data for both line and
region sewing. Therefore, if this command is
selected, depending on the form of the font, there
may be a gap between the line and the region in
the text.

3

Drag

to transform the text.

b
•

can only be dragged vertically.

•
can only be dragged horizontally.
• To return the transformed text to its original
shape, clear the [Transform] check box.
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:Adjusts the radius of the circle.

Advanced Operations for Entering Text
4

b
Depending on the shape selected under
[Transform], different handles appear for editing
the text.

Specify the desired settings in the [Fit Text to
Outline Attribute Setting] dialog box, and
then click [OK].
b
a

c

d

Horizontal Alignment

b

Vertical Alignment

c

Text Orientation

d

the other side

Creating Embroidery Patterns Containing Text

a

Fitting text to an outline

1

2
3

Select the text or small text and an outline.

Click the [Home] tab.
Click [Group] in the [Edit] group, and then
click [Fit Text to Outline].
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a
• When fit text to outline is specified, the text
transformation is cancelled.
• Only one string of text can be arranged on a
single outline.

Editing individual
characters
1

Select the text.

2

Select characters in the text.
To select a single character, click
character.

b

for the

• To change the position of text on the outline,
select the text, and then drag it.
• The settings for some text attributes ([Size],
[Character Spacing], [Vertical Offset] and
[Rotate Angle]) can be changed for single
characters, even with text fit to an outline.
cc "Editing individual characters" on page 113

b
a

■ Releasing text from an outline

1
2
3

c

Select text or small text that is arranged on an
outline.

Rotation handle

b

Size handle

c

Vertical offset handle

Individual characters can be rotated, resized
or repositioned. In addition, when text is
selected, click the [Text] tab to change the
thread color and sewing attributes.

Click the [Home] tab.
Click [Group] in the [Edit] group, and then
click [Release Text from Outline].

a

b
Multiple
can be selected and the selected
can be changed in the same way that embroidery
pattern points are selected.
• Drag the pointer.
 All points within the box are selected.
• Hold down the <Ctrl> key while clicking the
points.
 To deselect a point, click the selected
point.
• Hold down the <Shift> key while pressing an
arrow key to select multiple points.
• Hold down the <Ctrl> key while pressing an
arrow key to change the point that is selected.
cc "Selecting points" on page 66

113

Advanced Operations for Entering Text

Changing a character size
and character's attributes

2

When you release the mouse button, the
character spacing is changed.

You can easily use drag operations to change the
size and text attributes.

■ Changing the size
1
2

■ Changing the vertical offset

handle.

1

Bring the pointer onto the lower

Drag the handle.

2

Drag the handle vertically.

When you release the mouse button, the
character size is changed.

3

■ Changing the kerning
1 Place the pointer onto the character body
other than the
the character horizontally.

handles, and drag

handle.

When you release the mouse button, the
character offset is changed.

■ Rotating the characters
1

Bring the pointer onto the

2

Drag the handle.

handle.
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3

Bring the pointer onto the upper right

Advanced Operations for Entering Text
3

When you release the mouse button, the
character angle is changed.

Converting text patterns
Text pattern

Blocks

Text can be converted into blocks, allowing you
reshape characters. By changing the sewing
direction line in each of these small regions, you can
create text patterns that appear like manual
embroidery.

1

Select the text or monogram text.

2

Click the [Text] tab.

3

Click [Convert to Blocks] in the [Edit] group.

Shapes

*Blocks: A group of shape patterns with multiple
sewing direction lines
After being converted, text attributes are no longer
available, but the following editing operations can be
performed.
Convert to Blocks
The pattern is converted while maintaining the
multiple sewing direction lines.
The character shapes can be partially rearranged.
Convert to Outline
The text is converted to shapes, which can be
edited.
Various sew types or embossing/engraving effects
can be applied.

b
For details on the shape pattern and text pattern,
refer to page 8.
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■ Converting text to blocks

a
Small text cannot be converted into blocks (shape
patterns with multiple sewing direction lines).

b
• The text pattern is converted with the original
sewing quality maintained.
• The shapes of created blocks can be edited in
their finest details.
cc For details on editing blocks or outlines, refer
to "Reshaping Embroidery Patterns" on
page 66
• Since the text data is no longer available, the
text cannot be edited.

Advanced Operations for Entering Text
■ Converting text to outline pattern

Selecting connection point
positions in a text pattern

1

Select text.

The positions for connection points between
characters within the same text (end point of one
character and the start point of the next character)
can be specified.
The available settings are [Default], [Closest] and
[Farther].

2

Click the [Text] tab.

1

3

Click [Convert to Outline] in the [Edit] group.

Select the text or monogram text.
If the [Sewing Attributes] pane is not
displayed, click the [View] tab in the Ribbon,
and then click [Sewing Attributes].

2

Click a setting under [Connection Points].

Transformed shapes are grouped. In addition, hole
sewing is automatically specified for openings
(such as the triangle inside the letter "A").

a
Text patterns created with built-in fonts 025 and
029, user-defined fonts or small text fonts cannot
be converted to outlines.

a

a

b

c

Default

b
• When a pattern is converted outlines, the sewing
quality will decrease slightly.
• The sewing direction will become uniform, but it
can be edited.
cc "Specifying the sewing direction" on page 51

Stitches are created in the default sewing
order for good stitching quality of all
characters.

• Since the text data is no longer available, the
text cannot be edited.
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b

Advanced Operations for Entering Text
b

Closest

Stitches are created at the shortest distance
between the end point of one character and
the start point of the next character. This
shortens jump stitches and reduces the
number of times that the thread is trimmed.
c

Embroidery attributes for
text
The Sew group in the Attributes tab allows you to set
the embroidery attributes (thread color and sew
type, outline and inside region on/off).
When text is selected, settings can be specified for
the following.

Farther

a

a

Stitches are created at a farther distance
between the end point of one character and
the start point of the next character. This
lengthens jump stitches so they can easily be
trimmed manually.

b

Line color/Region color
Sets the thread color for outlines and
inside regions.

cc "Color" on page 46
b

A Connection Points setting can be selected
not only for region sewing, but also for line
sewing.

a
• These settings are not available with text
created using built-in fonts 025 or 029, a
TrueType font, a user-defined font or a small text
font.
• These settings are not available for text
containing characters of different colors.
• These settings are not available for text where
the sewing order of the characters is not
continuous.

c

Line sew type
Sets the sew type for the outlines.
Except with built in fonts 025 and 029, and
a user-defined fonts, all sew types are
available for lines in text.

cc "Line sew types" on page 49
c

Region sew type
Sets the sew type for an inside region.
[Satin Stitch], [Fill Stitch] and [Prog.
Fill Stitch] are available for lines in text.

cc "Region sew types" on page 49

a
• Text patterns created using built-in fonts 025
and 029 or user-defined fonts only have an
inside region. The thread color and sew type for
only the region can be selected.
• Sewing attribute that can be set with Text under
sewing. For details, refer to "Region sewing
attributes" on page 331.
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b

b

• To turn off line sewing, select [Not Sewn (Line)]
from the [Line sew type] selector.
• To turn off region sewing, select [Not Sewn
(Region)] from the [Region sew type] selector.
• The variety of embroidering effects possible
differs depending on the selected combination of
settings for line sewing and region sewing.

Sample small text font patterns are available in the
[Import] pane when [Text] is selected in the
[From] selector and [Small Text] is selected in the
[Category] selector.

Region sewing
specified
(Text Body Sew
Type)

Any other than [Not
Sewn (Line)]

Any other than [Not
Sewn (Region)]

[Not Sewn (Line)]

Any other than [Not
Sewn (Region)]

Any other than [Not
Sewn (Line)]

[Not Sewn
(Region)]

■ Editing small text
Small text attributes can be selected from the [Text]
tab, the [Text Attributes] pane and the [Color]
pane. When the small text tool is selected, the
[Text] tab appears as shown below.

b
The [Text] tab appears when a small text pattern
or the small text tool is selected.

Small text fonts

Small Text
a
Precautions for embroidering small text patterns.
cc "Fonts Suitable for Embroidering" on
page 303

■ Entering small text
1 Click the [Home] tab.
2

Click [Text] in the [Tools] group, and then
click

.

a

b

c

a

Font number

b

Font sample

c

Font name

d

Recommended size

d

cc "Font List" on page 340

3

Enter text in the same way that regular text is
entered, starting with step 3.
cc "Entering text" on page 106
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Line sewing
specified
(Text Outline Sew
Type)

cc "Example of Importing Embroidery Data" on
page 13

Advanced Operations for Entering Text

a
Only built-in fonts specifically for small text can be
used.
cc For a list of the built-in fonts specifically for
small text, refer to "Small Text" on page 342.
The settings for all small text attributes except the
font are specified in the same way that they are
specified for regular text patterns.
However, with small text, settings cannot be
specified for the following.
• Sew type
• Sewing Attributes
• Transform
• Name Drop

b
To edit an entered small text, select the small text
with the [Select] tool, and then type the new text
into the text field in the [Text Attributes]
pane.There are three other ways to edit text.
cc "Editing entered text" on page 107

■ When sewing small fonts
For best results when using your embroidery
machine to embroider patterns containing small font
patterns, follow the recommendations described
below.

1
2

3
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Reduce the thread tension to less than what is
used when embroidering normal designs.
Sew at a speed slower than what is used when
embroidering normal designs.
(For details on adjusting the thread tension
and sewing speed, refer to the Operation
Manual provided with your embroidery
machine.)
Do not trim the jump stitches between the
characters.
(For details on setting the machine for thread
trimming, refer to the Operation Manual for the
embroidery machine.)

Tutorial 4: Monograms

Tutorial 4: Monograms

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_4.
Step 1

Entering monograms

Step 2

Adding a decorative pattern

Step 3

Changing character size of the monogram

Step 4

Changing the thread color and sew type of the monogram

1
2

4

Click [Edit Text] in the [Edit] group.

Display the [Import] pane.
Select [Text] from the [From] selector and
[Monogram] from the [Category] selector.
Click [TM_002.pes], then [Import].
 The text pattern appears as dotted lines,
and the cursor appears at the end of the
text.

5
6

Press the <BackSpace> key to delete the
text, and then use the keyboard to type in
"XYZ".
Press the <Enter> key.
 The text appears in the Design Page.

b
Sample monogram patterns are available in the
[Import] pane when [Text] is selected in the
[From] selector and [Monogram] is selected in
the [Category] selector.

3

Select the imported monogram pattern, and
then click the [Text] tab.

120

Creating Embroidery Patterns Containing Text

Step 1 Entering monograms

Tutorial 4: Monograms
3

b
• In this example, a monogram pattern was
imported from the [Import] pane; however, a
pattern can also be created by selecting the
Monogram tool, then typing in text.

Select [Monogram Decoration] from the
[Category] selector. Click [Deco09.pes],
then [Decorative Import].

cc "Entering text" on page 106
• Characters can also be entered from the
character table in the [Text Attributes] tab.

• You cannot insert line feeds.
• A maximum of three characters can be entered.
• Only uppercase letters (the characters
displayed at the character table) can be entered.

Step 2 Adding a decorative
pattern
A decorative pattern can be added.

1
2
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Display the [Import] pane, and select
[Decorative Pattern] from the [From]
selector.
Select the monogram.

 The decorative pattern is added.

b
• If a monogram is selected, the [Decorative
Import] button and [Maintain aspect ratio]
check box will appear.
To import the decorative pattern adjusted to the
size of the monogram while maintaining its
original height-to-width proportion, select the
[Maintain aspect ratio] check box. Clear the
check box to import the decorative pattern with
its height-to-width proportion adjusted to the
monogram.
• If no monogram is selected, the button will
appear as the [Import] button. Clicking this
button will import the decorative pattern at its
standard size.

Tutorial 4: Monograms

Step 3 Changing character size
of the monogram
■ Changing the character size of the
monogram

■ Changing the thread color
1 Click [Color] tab to display the color palette.
2

Click [TANGERINE].

Click the [Text Size] selector, and then type in "22".

3

b
Diamond and Script are fonts exclusively for
monograms. You can also use the built-in fonts or
TrueType fonts.

Select the characters "YZ", and then click
[RED].

cc "Editing monograms" on page 123

Click the point for the monogram character whose
settings are to be changed.

■ Changing sew type
1 Click the [Text] tab.
2

Click the [Text Body Sew Type] selector in
the [Sew] group, and then select [Fill Stitch].

1
1 Click here.
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Step 4 Changing the thread color
and sew type of the
monogram

Advanced Operations for Entering Monograms

Advanced Operations for Entering
Monograms
Editing monograms
Monogram attributes can be selected from the
[Text] tab, the [Text Attributes] pane, the [Sewing
Attributes] pane and the [Color] pane. When the
Monogram tool is selected, the [Text] tab appears
as shown below.

b
Diamond and Script are fonts exclusively for
monograms. You can also use built-in fonts, userdefined fonts and TrueType fonts.
cc For a list of the built-in fonts and monogram
fonts, refer to "Font List" on page 340.
The settings for all monogram attributes except the
font are specified in the same way that they are
specified for regular text patterns.

b
The [Text] tab appears when a monogram or the
Monogram tool is selected.

However, with monograms, settings cannot be
specified for the following.
• Rotate Angle, Character Spacing, Line Spacing,
Alignment, Direction
• Transform

■ Monogram font
Click the [Font] selector, and then select the
desired font.
a

b

c

d

• Name Drop
• Fit Text to Outline

b
• To edit an entered monogram, select the text
pattern with the [Select] tool, and then type the
new text into the text field in the [Text
Attributes] pane.
• There are three other ways to edit text.
cc "Editing entered text" on page 107

a

Font Type
• A number identifies built-in fonts.
•
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identifies Monogram fonts.

b

Font sample
If a single string of text is selected, the
fonts in the list appear with the selected
characters.

c

Font name

d

Most recently used fonts

Tutorial 5: Creating Name Drop

Tutorial 5: Creating Name Drop
By creating an embroidery pattern containing text and using the Name Drop function, you can easily create a
number of similar embroidery patterns, for example, for uniforms, by replacing only the name in the pattern.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_5.
Step 1

Designing the embroidery pattern

Step 2

Creating the list

Step 3

Outputting patterns using text from the text list

1
2

5

Type in "Fernand", and then press the
<Enter> key.

Display the [Import] pane, and select [Design
Library] from the [From] selector.
Select [Misc] from the [Category] selector,
and then drag the rainbow pattern into the
Design Page.

6

Select the text pattern, select the [Transform]
check box, and then click

3
4

.

Click the [Home] tab.
Click [Text] in the [Tools] group, click
and then click the Design Page.

,
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Step 1 Designing the embroidery
pattern

Tutorial 5: Creating Name Drop
7

(3) When entering text, press the <Enter>
key so that the cell in the next row enters
input mode.

Drag the pattern to adjust its position.

Repeat steps (1) through (3) to create the text
list.

b
Selecting a cell containing entered text allows you
to preview that text.

Step 2 Creating the list
1

Select "Fernand", and then select the [Name
Drop] check box, and click [Name Drop List]
button.

Step 3 Outputting patterns using
text from the text list
Let's practice outputting the patterns to files.
Embroidery data with the text replaced by each row
of text in the list can be outputted.

2

1

Click [To Folder].

2

Select the drive and folder in the dialog box

Enter text in the list. In this example, we will
add text at the end of the list.
(1) Click a cell in the
row and click [Edit
Text], or click the cell to enter input mode.

that appears after clicking
, type the name
of the file in the [File Name] box, and then
click [OK].
(2) Use the keyboard to enter the text.

 This application begins checking that there
are no errors in the embroidery data. If no
errors were detected, it begins outputting
the data.
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b
The files are named "<file_name>xxx.pes" (where
"xxx" are consecutive numbers starting with 001).

3

After the data has been outputted, the
following message appears. Click [OK].

An embroidery file is saved in the selected
folder for each line of text in the list.
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126

Name Drop Feature (Replacing Text)

Name Drop Feature (Replacing Text)
Text attributes with Name
Drop attribute applied
d

e

f

b
The [Name Drop List] dialog box for a text pattern
can be displayed by selecting a text pattern with
the [Name Drop] attribute applied, clicking [Text]
in the [Home] tab, then clicking [Text], then [Open
Name Drop List].

c

a

a

c

g

h

i

b

Name Drop
If this check box is selected, the [Name
Drop] attribute is applied.

a

■ Alignment
d

e

• When the [Name Drop] attribute is applied, the
settings for [Kerning], [Vertical Offset],
[Rotate Angle], [Character Spacing], [Line
Spacing], the character size and color will be
reset.

f

g

h

• The [Name Drop] attribute is not available with
text where the [Fit Text to Outline] command
has been specified, small text or monogram text.
b
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Name Drop List
Click this button to display the [Name
Drop List] dialog box.

Maintain aspect ratio
If this check box is selected, the height-towidth proportion of the text is maintained.

i

Name Drop Feature (Replacing Text)

Functions in the Name
Drop List dialog box
a c

d

e

g

b
If the pattern contains two text patterns with the
[Name Drop] attribute applied, the text list
appears as shown below.

f

b

■ Saving / importing a text list (CSV)

a

j

or

g

Imports a Name Drop List as a .csv file.
Click this button, select the drive and
folder, click the name of the file, and then
click [Open], or double-click the file's
icon.

i

Name Drop List
Create the list of text to be used to replace
text in the pattern. Double-click a cell to
enter input mode.
Select a row to display a preview of the
pattern with the text in that row. A row in
the text list can be selected by pressing
the

Saves the created Name Drop List.
Click this button, select the drive and
folder, type the name of the file in the [File
Name] box, and then click [Save] to save
the list as a .csv file.

key.

b

Click
to add a row at the end of the
list.
(Up to 500 rows can be added.)

c

Edit Text
Enters input mode for the text in the
selected cell. (Input mode can also be
entered by double-clicking a cell.)

d

Select a row, and then click [Insert]. A
new row is inserted above the selected
one.

e

Select a row, and then click [Delete]. The
selected row is deleted.

■ Outputting patterns using text
from the text list
h

Click to send to machines by using the
Link function. This button is available if an
embroidery machine compatible with the
Link function is connected to the
computer. Connect a compatible
embroidery machine that has been
started in Link mode.

cc "Using the Link Function to Embroider
From the Computer" on page 204
i

To Folder

cc "Outputting patterns using text from the
text list" on page 125

■ Editing a pattern with text
replaced
j

Select text in the [Name Drop List] dialog
box and click [OK] to return to the Design
Page and edit the pattern with the text
replaced.
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h

f

Name Drop Feature (Replacing Text)
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Creating Embroidery Patterns Using
Images

Embroidery patterns can easily be created from
images. In addition, this section provides details
on creating an embroidery pattern that is
combined with an image.

Stitch Wizard: Automatically Converting an Image to an Embroidery Design

Stitch Wizard: Automatically Converting
an Image to an Embroidery Design
An embroidery pattern can be created from a digital camera photo, a scanned illustration, or a clip art image.

■ Auto Punch (cc p. 132)

■ Cross Stitch (cc p. 135)

■ Photo Stitch 1 (cc p. 139)

■ Photo Stitch 2 (cc p. 144)
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Tutorial 6-1: Auto Punch
In this section, we are going to use the Auto Punch function to automatically create an embroidery pattern from
an image. This creates an embroidery pattern from shapes and colors in the image.
Step 1

Importing image data into Layout & Editing

Step 2

Starting the Auto Punch wizard

Step 3

Applying an image mask and adjusting its size and position

Step 4

Creating a border from the mask outline and converting to an embroidery pattern

Step 1 Importing image data into
Layout & Editing
1
2

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [from File].

• Images with few and distinct colors work best
with [Auto Punch].

3

Double-click the [Documents (My
documents)\Palette Ver.10\Tutorial\
Tutorial_6] folder to open it.

• Repeat steps 1 to 4 to choose another picture
image. Otherwise, the image can be replaced
with the dialog box in Step 4.
cc "Select Mask dialog box" on page 147

b

• You can import picture images from a scanner,
or clipboard, and import that image.

When this application is installed, the [Palette
Ver.10] folder is installed in the Documents folder.

cc "Importing Image Data" on page 150

4

Select the file [penguin.bmp], and then click
[Open], or double-click the file's icon.

Step 2 Starting the Auto Punch
wizard
1
2

Click the [Image] tab.
Click [Auto Punch] in the [Stitch Wizard]
group.

 The image appears in the work area.
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b

Tutorial 6-1: Auto Punch

Step 3 Applying an image mask
and adjusting its size and
position
1

Click
to select the circle mask.
Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.
Click [Next].

Step 4 Creating a border from the
mask outline and
converting to an
embroidery pattern
Select the [Add mask outline] check box, check
the preview image, and then click [Finish].

b
The mask outline selected here can be used as
line data (border) in Step 4.
cc "Select Mask dialog box" on page 147.

2

Drag the image to adjust its output location
and size. The white background indicates the
sewing area in the Design Page.
Click [Next].

 The image is automatically hidden and
stitches are automatically input.

cc "Check Mask Shape/Modify Image dialog
box" on page 148
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Auto Punch Features
Auto Punch Parameters
dialog box
a

c

c

Zoom

d

Create Lines
Click this button to display the [Select
Regions] dialog box, where the areas to
be converted to lines can be selected.

b

d
e

f

i

g
h

a

Result View
The resulting analyzed image appears in
the Result View box.

b

Omit Region Colors/Omit Line Colors
In the [Omit Region Colors] list and
[Omit Line Colors] list, click the colors to
select whether or not they will be sewn.
You can select whether or not areas will
be sewn by selecting their colors. Colors
that are crossed out are set to not be
sewn.

Click the areas to be converted to lines,
and then click [OK].

b
• To select whether or not a part of the image is to
be sewn, click in the Result View box, or click in
the [Omit Region Colors] and [Omit Line
Colors] lists.
• Areas filled with a crosshatch pattern in the
Result View box will not be sewn.
In addition, lines that appear as dotted lines will
not be sewn.

1

e

Thread Chart
Select the thread chart to be used.

f

Add mask outline
If this check box is selected, line data is
created from the mask outline.

g

Noise reduction
Sets the level of noise (distortions) that is
removed from the imported image.

h

Segmentation sensitivity
Sets the sensitivity for the image analysis.

i

Max. Number of Colors
Sets the number of colors used.

j

Retry
To view the results of the changes, click
this button.

1 These areas will not be sewn.
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j

Tutorial 6-2: Cross Stitch

Tutorial 6-2: Cross Stitch
The Cross Stitch function creates cross-stitch embroidery patterns from images. In this section, we will create
a cross-stitch embroidery pattern from an image.
Step 1

Importing image data into Layout & Editing

Step 2

Starting the Cross Stitch wizard

Step 1 Importing image data into
Layout & Editing

3

Click [Next].

Select the [Tutorial_6] folder, and then select
[tulip.bmp] as the image.
cc "Importing image data into Layout &
Editing" on page 132

From this dialog box, an image mask can be
applied, and its size can be adjusted and
shape edited. For this example, we will simply
continue to the next step.
cc "Select Mask dialog box" on page 147

Step 2 Starting the Cross Stitch
wizard
1
2

4

Click [Next].

Click the [Image] tab.
Click [Cross Stitch] in the [Stitch Wizard]
group, and then click [Color].

From this dialog box, the size and position of
the image can be adjusted. For this example,
we will simply continue to the next step.
cc "Check Mask Shape/Modify Image dialog
box" on page 148
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5

Click [Next].

In this dialog box, the cross size and the
number of colors can be specified. For this
example, we will use the default settings.

6

Click [Finish].

Creating Embroidery Patterns Using Images

In this dialog box, stitches can be added,
deleted or edited, and colors and the number
of times each stitch is sewn can be specified.
For this example, we will use the default
settings.

 The image is automatically hidden and
stitches are automatically input.
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Cross Stitch Features
Cross Stitch Parameters
dialog box
a

f

Max. Number of Colors
Sets the number of colors used in the
created pattern.

g

Retry
To view the results of the changes, click
this button.

h

Next
Continues to the next step ([Edit Cross
Stitch] dialog box).

c b

■ Edit Cross Stitch dialog box
Click a button in (1) to select the type of stitch,
select a thread color in (2), and then click or
drag in (3) to edit the stitches.

d
e
f

c

g

a

d

h

a

Result View
Areas that will not be converted to crossstitching are shown with a crosshatch
pattern.

b

Omit Colors
In the Omit Colors list, click the colors to
select whether or not they will be sewn.

b

g
f

b
• To select whether or not a part of the image is to
be sewn, click in the Result View box, or click in
the [Omit Colors] list.
• Areas filled with a crosshatch pattern in the
Result View box will not be sewn.

e

a

Selecting stitches
Selecting stitches to be added/deleted
(cross-stitches): Specifies a crossstitch inside a box.
(backstitches): Specifies a back stitch
inside (

1

or
b

1 These areas will not be sewn.
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c

Zoom

d

Cross size
Sets the size of the pattern.

e

Thread Chart
You can select the brand of thread to use
in the created cross stitch pattern.

or

) or on the edge (

) of a box.

Color Option
To change the color, click [Change
Color] to display the [Thread Color]
dialog box, and then click the desired
color.
To select the color to be used for a stitch,
click
, and then click the stitch to
be sewn with that color.

Cross Stitch Features
c

Editing area
 For cross-stitches
Clicking a box: Adds one stitch.
 For backstitches
Clicking an edge of a box: Adds one
stitch at the edge.
Clicking a diagonal line in a box: Adds
one stitch on the diagonal.
 For both cross-stitches and
backstitches
Dragging the pointer: Adds
consecutive stitches.
Right-clicking/dragging with the right
mouse button held down: Deletes one
stitch/deletes consecutive stitches.
Zoom

e

Display Template
To display the imported image, click
[Display Template].

f

Add mask outline
If this check box is selected, line data is
created from the mask outline.

g

Cross Stitch Times/Backstitch Times
For the number of times each stitch is to
be sewn, select [Single], [Double] or
[Triple].

Creating Embroidery Patterns Using Images

d

a
If [Previous] is clicked to return to the [Cross
Stitch Parameters] dialog box after the stitches
have been edited, the edited stitches are reset to
their previous arrangement.
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Tutorial 6-3: Photo Stitch 1
By using the Photo Stitch 1 function, embroidery patterns can be created from photos. This type of embroidery
pattern created from a photo has detailed and overlapping stitching.
Step 1

Importing photo data into Layout & Editing

Step 2

Starting the Photo Stitch 1 wizard

Step 3

Applying an image mask and adjusting its size and position

Step 4

Selecting appropriate thread colors and creating an embroidery pattern

Step 1 Importing photo data into
Layout & Editing
Select the [Tutorial_6] folder, and then select
[swimming_girl.jpg] as the image.

Step 3 Applying an image mask
and adjusting its size and
position
1

cc "Importing image data into Layout &
Editing" on page 132

Step 2 Starting the Photo Stitch 1
wizard
1
2

Click the [Image] tab.
Click [Photo Stitch 1] in the [Stitch Wizard]
group, and then click [Color].

b
With [Photo Stitch 1], an embroidery pattern can
be created in color (Color), sepia (Sepia),
grayscale (Gray) or one color (Mono). For this
example, select [Color].
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Drag the handles to adjust the shape of the
mask. Drag the mask to adjust its position.

2

Then click Next.

3

Click [Design Settings].

Tutorial 6-3: Photo Stitch 1
4

5

Select [Hoop Size] and choose a Design
Page size of 100 × 100 mm from the selector.
Then, click [OK].

Click [Fit to page] to change the final finishing
size.

Step 4 Selecting appropriate
thread colors and creating
an embroidery pattern

At this point, the embroidery pattern can be
completed by clicking [Finish]. However, this
section will describe how to improve the photo
stitching by changing various settings.
From the [Thread Chart] selector, select the
thread chart to be used.
In the [Max. Number of Colors] selector,
specify "20".
Click [Update Preview].

b
• The size of the embroidery pattern appears in
the lower left corner of the dialog box. The user
can change the size freely with this display.
• The minimum sizes of embroidery patterns that
can be sewn are listed below.
 Face only: 100 × 100 mm
 Head and face: 130 × 180 mm

2

Slide the [Brightness] slider one position to
the left, and the [Contrast] slider two
positions to the right.
Click [Update Preview].

cc "Check Mask Shape/Modify Image dialog
box" on page 148 and "Gray Balance /
Modify Image dialog box" on page 149

6

Check the preview of the area to be converted
then click [Next].

b
Make adjustments as needed, depending on the
image. If it is difficult to adjust the tone, click
[Select from Candidates].
cc "Select from Candidates" on page 143.
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1

Tutorial 6-3: Photo Stitch 1
3

While looking at the preview on the right side,
select colors from the list for the most
frequently used colors (light blue for the
background) and for the more characteristic
colors (deep rose for the lips), and then click
[Reserve].
 For this example, four colors (cream brown,
light blue, salmon pink and deep rose) are
reserved.

4

5

In the [Max. Number of Colors] selector,
specify "10", and then click [Update Preview].

Click [Finish].

 The image is automatically hidden.
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b
If the created embroidery pattern contains colors
that you do not wish to emphasize (for example,
grays in the face), change the sewing order in the
[Sewing Order] pane so that the undesirable color
is sewn before all other colors.
cc "Changing colors" on page 85.

Photo Stitch 1 Features

Photo Stitch 1 Features
Photo Stitch 1 Parameters
dialog box
With Color, Sepia or Gray
a

c

d

Color options

Color/Sepia/Gray
Thread Chart

You can select the brand of thread to
use in the created pattern.

Auto Select

Select whether thread colors will be
selected automatically (on) or manually
(off). Select this check box to turn on
this function.

Number of
Colors

Sets the number of colors selected by
the Auto Select function.

List of colors
used

Displays the thread colors that are
being used. With this list, the thread
colors that are being used can be
checked or changed.
Click this button to add a thread color to
the list of colors used.
When clicked, the [Add] dialog box
appears.

e

With Mono
a

Add

Select a thread chart, then a thread
color, and then click [OK] to add the
color to the list. Added thread colors will
be reserved as thread colors that must
be used.

Remove
b

c

d

e

Select the thread colors in the color options a,
specify the desired settings under [Sewing Option]
b and [Color Option] c, and then, click [Update
Preview] d to preview the effects of the specified
settings. Click [Finish] e to convert the image to
an embroidery pattern.

Select a thread color in the list of colors
used, and then click this button to delete
the selected color from the list. This is
used to delete unnecessary thread
colors and reduce the number of colors.
Specifies thread colors that must be
used. Select a thread color in the list of
colors used, and then click this button to

Reserve

display

in the Reserved column. To

cancel this setting, click to icon so that it
appears as

.

Mono
List of colors
used

Displays the thread colors that are
being used.

Change
Color

Click this button to display the [Thread
Color] dialog box, where the thread
colors can be changed.

142

Creating Embroidery Patterns Using Images

b

a

Photo Stitch 1 Features
b

Sewing Option

Detail

Selecting a setting closer to [Fine]
creates more details in the pattern and
increases the number of stitches. (The
stitches will be overlapping.)

Run Pitch

When the value is lowered, the sewing
pitch (stitch length) will be shortened,
resulting in finer stitching.

Sew Page
Color
(Available
only with
Color, Sepia
and Gray)

If this check box is cleared, the parts of
the pattern that are the same color as
the Design Page will not be sewn.
If it is selected, those parts will be sewn.

Add mask
outline

If this check box is selected, line data is
created from the mask outline.

Others

c

Click this button to display the [Others]
dialog box, where the following settings
can be specified.
[Conversion Priority]:
To give priority to creating a pattern as
close to the original photograph, select
[Stitch Quality].
To give priority to reducing the number
of jump stitches, select [Jump Stitch
Reduction].
[Image Type]:
If [Photo] is selected, the thread colors
will be mixed together, which will result
in a more natural look.
If [Cartoon] is selected, the thread
colors will not be mixed together, which
will result in a more simply colored look.
Select [Photo] for image data from a
photograph, etc. Select [Cartoon] for
image data from an illustration, etc.

Brightness / Contrast

The top slider is used to adjust the brightness.
The bottom slider is used to adjust the contrast.
The image can be automatically
adjusted.
Click this button to display nine patterns
with different brightness and contrast
levels based on the original image.
Select one of the candidates, and then
click [OK].
Select from
Candidates
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d

Update Preview
Update the previewed image after settings have
been changed.

b
• If the [Auto Select] check box is selected, the
thread colors will be automatically selected from
the chart selected in the [Thread Chart]
selector. If thread colors are reserved, they will
included in the colors selected according to the
number specified in the [Number of Colors]
box.
If the [Auto Select] check box is cleared, the
settings in the [Thread Chart] selector and
[Number of Colors] box are not applied, and
only the thread colors in the current list of colors
used will be used to assign thread colors.
• When thread colors are added/deleted, the
[Auto Select] check box is cleared. To use
added thread colors and automatically select
other thread colors, select the [Auto Select]
check box, and then update.
• The thread colors in the list of colors used are
listed, in order, starting from the brightest. This
order is the sewing order and cannot be
changed.

b
Creating beautiful photo embroidery
• Actual thread colors may differ from the thread
colors on the screen. In addition, thread colors
may appear differently on the screen depending
on your operating environment.
By editing the colors to create a user thread
chart corresponding to the threads that you
have, you can create patterns while viewing
them in colors nearest to the actual threads that
will be embroidered.
cc "Editing user thread color lists" on page 192
• The following types of photos are not
appropriate for creating embroidery patterns.
 Photos where the subject is small, such as in
photos of gatherings
 Photos where the subject appears dark, such
as photos taken in a room or taken with
backlighting
• An image with a width and height between 300
and 500 dots is suitable.

Tutorial 6-4: Photo Stitch 2

Tutorial 6-4: Photo Stitch 2
We will create an embroidery pattern with [Photo Stitch 2] in a method different than that used with [Photo
Stitch 1]. Although this embroidery pattern will also be created from a photo, this type of embroidery pattern
contains repeating zigzag stitches. This produces a more general rendering than with [Photo Stitch 1];
however, the data is created with well-regulated stitching.
Step 1

Importing photo data into Layout & Editing

Step 2

Starting the Photo Stitch 2 wizard

Step 3

Applying an image mask and adjusting its size and position

Step 4

Changing the sewing angle

Step 1 Importing photo data into
Layout & Editing
Select the [Tutorial_6] folder, and then select
[girl2- face.bmp] as the image.

1

Click

to select the circle mask.

Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.
Click [Next].

Step 2 Starting the Photo Stitch 2
wizard
1
2

Click the [Image] tab.
Click [Photo Stitch 2] in the [Stitch Wizard]
group, and then click [Mono].

cc "Select Mask dialog box" on page 147

2

From this dialog box, the size and position of
the image can be adjusted. For this example,
we will simply continue to the next step.
Click [Next].

cc "Check Mask Shape/Modify Image dialog
box" on page 148 and "Gray Balance /
Modify Image dialog box" on page 149
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cc "Importing image data into Layout &
Editing" on page 132

Step 3 Applying an image mask
and adjusting its size and
position

Tutorial 6-4: Photo Stitch 2

Step 4 Changing the sewing
angle
1

In the [Direction] box, type "45".

2

Click [Update Preview].

3

Click [Finish].
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Photo Stitch 2 Features
Photo Stitch 2 Parameters
dialog box

a

Sewing Option

Line interval

Line interval

With Color
a

Lower value

b

Higher value

Max. Density

0°

45°

90°

Direction
Add mask
outline
b

If this check box is selected, line data is
created from the mask outline.

Color Option

c

d

Thread Chart

You can select the brand of thread
available in the [Color Set] selector.

Color Set

If [Auto Select] is selected, the most
appropriate four colors will automatically
be selected.
Selecting a different option specifies the
four colors used when creating the
embroidery pattern.
The color choices are: cyan (C),
magenta (M), yellow (Y), black (K), red
(R), green (G) and blue (B). Select one
of the following combinations that
contains the colors most used in the
image.
Color combinations: CMYK, RGBK,
CRYK, BMYK

Thread
Colors Used

Displays the four selected thread colors.

Change
Color

Under [Thread Colors Used], click a
color. Then, click [Change Color] to
display the [Thread Color] dialog box.
Select the new color and click [OK].
The selected thread color will be applied
to the image shown in the preview
window.

With Mono
a

b

c

d

Specify the desired settings under [Sewing Option]
a and [Color Option] b , and then click [Update
Preview] c to preview the effects of the specified
settings. Click [Finish] d to convert the image to
an embroidery pattern.

Mono
Change
Color

Click on the [Change Color] button to
open the [Thread Color] dialog box if
you wish to change the color of the
photo stitching. Select the color and
click [OK] to make the color change.

Color/Mono
Brightness /
Contrast

The top slider is used to adjust the
brightness.
The bottom slider is used to adjust the
contrast.

Update
Preview

Updates the previewed image after
settings have been changed.
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Color

Advanced Stitch Wizard Operations

Advanced Stitch Wizard Operations
Image To Stitch Wizard
Click
at the top of the window (in the [Quick
Access Toolbar]) to display the Startup Wizard,
and then click [Create Embroidery Patterns Using
Images]. If an image has been imported, the next
dialog box appears.

Adjusting the Mask and
Image
■ Select Mask dialog box
The [Select Mask] dialog box appears no matter
which conversion method was selected.
a

b

d

c

a

d

b

e

e

f

a

Sample image before being converted

b

Sample image of embroidery pattern
after being converted

c

Select the conversion method.

d

Select to start up Design Center and
import the image into the Design Page.

e

Description of conversion method

f

Click to continue to the next step.

c

f

f

a

Mask shapes
The image will be masked with the
selected shape.

b

The mask can be reshaped or
repositioned. Select the tool appropriate
for the operation to be performed.
: Drag the handles to enlarge/
reduce the mask. Drag the mask
to adjust its position.

b
If no image has been imported into the Design
Page, the [Open an image file] dialog box
appears.

: Points can be entered, moved and
deleted to create a mask with the
desired shape.
To add points, click the outline of
the mask. To move a point, select
the point, and then drag it. To
delete points, select the point, and
then press the <Delete> key.

a
With a small original image, it may not be possible
to reduce the size of the mask.
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c

If [Auto Generate] was clicked, an outline
of mask was automatically detected from
the image.

• Move the [Original] – [Sharp] slider to
adjust the sharpness of the image's
outlines. A setting more towards [Sharp]
makes a more noticeable boundary
between bright and dark areas.

The [Auto Generate] button is available
only with images that have a light-colored
background, like in this photo.

• Move the [Dark] – [Bright] slider to adjust
the brightness of the image.
• Move the [Low] – [High Contrast] slider to
adjust the contrast of the image.
f

Clicking [Open Image] allows you
replace the image with a different one.
The [Open an image file] dialog box
appears. Select a file.

The next step differs depending on the color range
selected for the embroidery pattern.

A mask shape edited with
or
created by clicking [Auto Generate]
will be added at the top of the list. Then,
this mask shape can be selected the
next time a pattern is created using a
Stitch Wizard. A maximum of five
shapes will be added, and they will be
arranged in order of the most recently
used.
These mask shapes appear no matter
which Image To Stitch function is
selected.
d

Zoom

e

Clicking the [Image Tune] button displays
an [Image Tune] dialog box.

If Color, Sepia or Gray was selected for [Photo
Stitch 1], [Photo Stitch 2] or Cross Stitch, or if
[Auto Punch] was selected:
The following dialog box appears.
a

b
c

d

a

Adjust the position and size of the image.
Drag the image to the desired position.
Drag the handle to adjust the image to the
desired size.

b

Click [Design Settings] to change the
size of the Design Page. Specify the
settings in the [Design Settings] dialog
box.

cc "Specifying the Design Page Settings" on
page 14
c

Click [Fit to page] to adjust the image to
the size of the Design Page.

d

Embroidery pattern size
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■ Check Mask Shape/Modify Image
dialog box

a

Advanced Stitch Wizard Operations
■ Gray Balance / Modify Image
dialog box

Importing to Design Center

If [Mono] was selected for [Photo Stitch 1] or
[Photo Stitch 2]:

We will create embroidery data in Design Center by
using an image that was opened in Layout & Editing.

The following dialog box appears.

1

a

Click [Design Center] in the [Stitch Wizard]
group.

 Design Center starts up and the image
appears in the Design Page.

b
c

d

e

a

Adjust the position and size of the image.
Drag the image to the desired position.
Drag the handle to adjust the image to the
desired size.

b

Click [Design Settings] to change the
size of the Design Page. Specify the
settings in the [Design Settings] dialog
box.

cc "Specifying the Design Page Settings" on
page 14

149

2

Click the [Image] tab.

c

Click [Fit to page] to adjust the image to
the size of the Design Page.

d

Embroidery pattern size

e

Drag the slider to adjust the gray balance.

cc "Basic Design Center Operations" on
page 211 and "Line Image Stage" on
page 224

Importing Image Data

Importing Image Data
An imported image can be used with the Image To Stitch Wizard, as a template for manual punching, or for
printing onto iron-on transfer sheets or printable fabric when using "Print and Stitch".
An image can be imported using any of the following four methods.
• From a file

• From the Clipboard

• From a scanner (TWAIN Device)

a
Only one image can be added to the work area. If you try to display a different image, it will replace the
previous one.

■ Image file formats

3

Images in the following formats can be imported.

Select the drive, the folder and the file. Click
[Open].
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- Windows bitmap (.bmp), Exif (.tif, .jpg), Windows
Metafile (.wmf), Portable Network Graphics
(.png), Encapsulated PostScript (.eps), GIF (.gif)

b
• Vector image data in the ".wmf" (Windows
Metafile), ".emf" (Enhanced Metafile) and ".svg"
(Scalable Vector Graphics) file formats can be
converted to shape patterns as it is without
some information not supported.
cc "Importing vector images (WMF/EMF/SVG)"
on page 93
• If an EPS file doesn't contain a "Preview" image,
it can not be displayed correctly. When you
create a file in EPS format, be sure to save it with
preview image.

Importing image from a file
1
2

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [from File].

b
• If the [Preview] check box is selected, the
contents of the selected file will appear in the
[Preview] window.
• Various clip art images can be found in the
[ClipArt] folder (in the folder where Palette was
installed) at:
C:\Program Files (x86)\Baby lock\Palette
Ver.10\ClipArt
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Importing image from the
clipboard
1
2

4

From the [Sources] list, click the desired
device to select it. Click [Select].

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [From Clipboard].

a
If no TWAIN device is installed, there will be no
names displayed in the [Sources] list. First, install
the driver software for the TWAIN device.

5
 The image on the clipboard is imported into
the Design Page.

6

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [From TWAIN Device].

a
This can only be done when there is image data on
the Clipboard.

Importing image from a
scanner (TWAIN Device)
 The driver interface for the device selected
in the Select Source dialog box appears.

b
TWAIN is an application interface (API)
standardization for software that controls scanners
and other devices.

1
2
3
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Check that the scanner or other TWAIN
device is correctly connected to your
computer.

7

Specify the necessary settings for importing
an image, and then import the image.

a
For information on using the driver interface, refer
to the help manual for that interface, or contact the
manufacturer of the interface.

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [Select TWAIN device].

 The imported image will be pasted into the
Design Page at its original size.

Changing the Image Settings

Changing the Image Settings
Adjusting the density of
the background image
1
2

Click the [Image] tab.
Drag the slider, or click
[Image] group.

or

in the

Changing the size, angle
and position of the image
■ Selecting an image
1 Click the [Image] tab.
2

Click [Modify Image] in the [Image] group.

Hide (off)

50% 100%
1

25%

75%

b
Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying it
faded at each density (75%, 50% and 25%) to
hiding the image (Off).

2

1 Handle
2 Red line

b
The status bar shows the dimensions (width and
height) of the image.

■ Moving an image
Drag the selected image to the desired location.

■ Scaling an image
Drag the handle to adjust the image to the desired
size.

b
If the <Shift> key is held down while a handle is
dragged, the image is enlarged or reduced from
the center of the image.
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 The image is selected and appears as
shown below.

Changing the Image Settings
■ Rotating an image
An image can be rotated in 90° increments.

1
2

Click the [Image] tab.
Click [Rotate Right] or [Rotate Left] in the
[Edit] group.

Saving the image data
■ Saving as a file
1 Click the [Image] tab.
2

Click [Save] in the [Image] group, and then
click [to File].

Rotate Right

3

Select the drive, the folder and the format.
Type in file name. Click [Save].

Rotate Left

■ Deleting an image
1 Click the [Image] tab.
2

Click [Delete] in the [Edit] group.

b
The image data can be saved in either of the
following formats: Windows bitmap (.bmp), Exif
(.jpg).

An image can also be deleted by selecting it, then
pressing the <Delete> key.
cc "Changing the size, angle and position of
the image" on page 152
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■ Outputting to the Clipboard
1 Click the [Image] tab.
2

Click [Save] in the [Image] group, and then
click [to Clipboard].

Tutorial 7: Print and Stitch

Tutorial 7: Print and Stitch
In this example, we will create a design that combines embroidery and an image.
Print the background image on fabric.
Embroider

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_7.
Creating a design combined with a background image

Step 2

Printing the background image

Step 3

Printing the positioning sheet

Step 4

Embroidering

Step 1 Creating a design
combined with a
background image

4

Import the file [Bear_Background.jpg].
Select the file Bear_Background.jpg in the
folder [Documents (My documents)\Palette
Ver.10\Tutorial\Tutorial_7].

For this example, we will use the gift box image
(Bear_Background.jpg) and the embroidery pattern
of the bear (tutorial_7_Bear.pes).

1

Start up Layout & Editing.
Specify a Design Page size of 130 × 180 mm.
cc "Specifying the Design Page Settings" on
page 14

2
3

Click the [Image] tab.
Click [Open] in the [Image] group, and then
click [from File].

cc "Importing Image Data" on page 150.

5

Display the [Import] pane.
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Step 1

Tutorial 7: Print and Stitch
6

Import the file [tutorial_7_Bear.pes].

8

Transform the text to fit with the design of the
image.

Select [Tutorial] from the [From] selector and
[Tutorial_07] from the [Category] selector.
Drag [tutorial_7_Bear.pes] to the Design
Page.

a

Click [Text Attributes] tab.

b

Select the [Transform] check box, and
then click

.
a

b

cc "Importing embroidery designs" on
page 91

7

b

Enter the text.
Select built-in font [No. 30], and thread color
[DEEP ROSE].
Type in "Happy Birthday!".

c

Drag the rotation handle to adjust the
angle of the pattern.
c

d

d

cc "Entering text" on page 106

Drag
or a handle to adjust the size of
the pattern.

cc "Transforming text" on page 111 and
"Rotating patterns" on page 33

9

After the design is finished, save the
embroidery data onto media so it can be
transferred to the embroidery machine.
cc For details on saving embroidery
patterns, refer to "Saving" on page 95.
For details on transferring designs to an
embroidery machine, refer to
"Transferring Embroidery Designs to
Machines" on page 201.
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e

Step 2 Printing the background
image
Print the background image on an iron-on transfer
sheet or printable fabric.

1

, then [Print], then [Print Setup].

3

Click [Change Position].

4

Check the image position.

Specify the print settings.

a

b

If any part of the image extends out of the print
area, drag the image to adjust its position.

c
d

e

a

Select the printer to be used.

b

Under [Paper] and [Orientation], select
the appropriate settings for the iron-on
transfer sheet or printable fabric to be
printed on.

c

Select [Image print mode].

d

Select [Print the image on printable
fabric or an iron-on transfer sheet].

5

Click [OK].

6

Click [Print].

b
To check the print image, click [Print Preview].
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2

Click

To print a flipped image on an iron-on
transfer sheet, select the [Print a flipped
image] check box.
Some printers will automatically print an
image flipped if an iron-on transfer sheet
is selected as the paper. If this type of
printer is being used, clear the [Print a
flipped image] check box.
For details, refer to the instructions for the
printer being used.

Tutorial 7: Print and Stitch
7

b

Specify the appropriate settings in the [Print
Setup] dialog box, and then click [OK].
cc "Printing" on page 96.
 Printing begins.

2
3

Select [Print a sheet of paper for
aligning the printed image and the
embroidery].

Click [Print].
Specify the appropriate settings in the [Print
Setup] dialog box, and then click [OK].
cc "Printing" on page 96.
 Printing begins.

b
For details on printing on iron-on transfer sheets or
printable fabric, refer to the instructions for the
iron-on transfer sheets and printable fabric.

b
To check the print image, click [Print Preview].

Step 3 Printing the positioning
sheet
Print a sheet for aligning the image and the
embroidery.

1

Step 4 Embroidering
1

Specify the print settings.

If an iron-on transfer sheet is used, transfer
the image onto fabric.

b
For details on transferring from iron-on transfer
sheets, refer to the instructions for the iron-on
transfer sheets.
a

2

b

a
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Under [Paper] and [Orientation], select
the appropriate settings for the paper to
be printed on.

Hoop the fabric in the embroidery frame.

Tutorial 7: Print and Stitch
3

Place the positioning sheet on the fabric to be
embroidered so that it is aligned with the
printed image.

b
• For details on using the embroidery machine,
refer to the Operation Manual included with the
machine.
• Some patterns of completed samples for "Print
and Stitch" are provided in the following folder.
Documents (My documents)\Palette Ver.10\
Sample\Layout & Editing\Print and Stitch

• If the positioning sheet is too large, cut it to
an appropriate size so it can easily be used
for aligning the positions.

Creating Embroidery Patterns Using Images

• Tape the positioning sheet to the fabric to
secure it in place.

4

Attach the embroidery frame to the
embroidery machine.
Be sure that the positioning sheet does not
move out of place.

5

Align the needle with the mark at the center of
the positioning sheet.
• If the embroidery machine has a built-in
camera, press the start positioning button
to detect the positioning mark and
automatically align the embroidering
position.
• With other embroidery machines, manually
align the positions.

6
7

After positioning is finished, remove the
positioning sheet from the fabric.
Start the embroidery machine to embroider
the pattern.
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Operations for Specific Applications

This section describes operations for creating
embroidery patterns using manual punching and
for specific applications such as appliqués,
embroidered patches and large-sized embroidery
patterns.

Tutorial 8-1: Creating Appliqués

Tutorial 8-1: Creating Appliqués
The Applique Wizard provides instructions for easily creating appliqués. For this example, we will create an
appliqué that has holes (empty regions).

Finish

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_8.
Step 1

Creating an appliqué pattern

Step 2

Using the Applique Wizard

5

b
The Applique Wizard cannot be used if a pattern
containing text with the [Name Drop] attribute
applied is selected.

Select the two patterns, click [Modify
Overlap] in the [Edit] group, and then select
[Set hole sewing] to apply hole sewing.

Step 1 Creating an appliqué
pattern
1

Click the [Home] tab.

2

Click [Shapes] in the [Tools] group, and then
click

cc "Hole sewing" on page 39

.

Step 2 Using the Applique Wizard
1

Select the outer pattern, and then click
[Applique Wizard] in [Home] tab to start the
[Applique Wizard] dialog box.

b
3
4
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Drag the pointer in the Design Page to draw a
circle.
Select
as described in steps 1 and 2, and
then drag the pointer in the Design Page to
draw a heart on top of the circle.

Be sure to select the outer pattern before starting
the [Applique Wizard].

Tutorial 8-1: Creating Appliqués
2

Specify settings in the [Applique Wizard]
dialog box in the following order a - f.
a

b

c

d

Running Stitch
Select this setting to sew the
cutting line, then cut along
the cutting line with scissors.

e

Cutting
In order for this setting to be
available

f

Applique Material

b

Applique Position

c

Tack down

d

Covering Stitch

e

Output Pattern

f

Create an applique with hole sewing
This check box appears when using a
pattern with hole sewing applied and
[Replace] is selected under [Output
Pattern].

Select this setting to cut the
fabric with a machine
installed with cutwork
needles.

4

To return all parameters to their default settings,
click [Default].
Specify cutting lines for the appliqué in
[Applique Material].
The outline of the appliqué can be sewn as
running stitches or the appliqué can be cut out,
or it can be neither sewn nor cut out.

[Applique Position] is specified
automatically.
 The guideline for attaching the appliqué
piece is set to be sewn automatically.

5

b

3

cc "Basic requirements for
Cutwork functions" on
page 173

Specify basting of the appliqué in [Tack
down].
The appliqué piece can be basted onto the
base fabric. Select one of three stitches.
 For this example, select [Yes] then [V
Stitch].

Satin Stitch

E Stitch

V Stitch

 For this example, select [Yes] then
[Cutting].
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a

Tutorial 8-1: Creating Appliqués
6

Specify the stitching for securing the appliqué
in [Covering Stitch]. Select the sew type and
other attributes ([Width] and [Density]) for
finishing the appliqué.

7

 For this example, select "Satin Stitch", and
then set [Width] to "3.0 mm" and [Density]
to "5.0 line/mm".

Under [Output Pattern], select whether
covering stitches will be added around the
entire pattern ([Add]) or covering stitches will
be sewn for shape lines ([Replace]).
 For this example, select [Replace].
Add
Settings can be
specified for
[Distance from
original Pattern].

Satin Stitch
Settings can be
specified for [Width]
and [Density].

Replace
E Stitch
Settings can be
specified for
[Stroke], [Interval]
and [Pitch].

8

Specify hole sewing in [Create an applique
with hole sewing].

V Stitch
Settings can be
specified for
[Stroke], [Interval]
and [Pitch].

Select this check box when creating an
appliqué with holes (empty regions).

cc For details on setting [Stroke], [Interval]
and [Pitch], refer to"E/V Stitch" on
page 328

 For this example, select this check box.

b
This check box appears when only the outer
pattern with hole sewing applied or only a text
pattern (with fonts other than built-in fonts 025 and
029, a user-defined font or a Small Text font) is
selected, or when [Replace] is selected under
[Output Pattern].
* Multiple text patterns can be selected if certain
conditions are met.
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■ About the Output Pattern settings

b

Add

The shape of the appliqué material appears as
shown below, depending on whether the [Create
an applique with hole sewing] check box is
selected or not.
When the [Create an applique
with hole sewing] check box is
cleared

• Covering stitches will be created around the
original pattern.
• Under [Distance from original Pattern], specify
the distance of the covering stitches from the
original pattern.

When the [Create an applique
with hole sewing] check box is
selected

9

Click [OK] to exit the Applique Wizard dialog
box.

• This can be used to combine various patterns.

The [Add] setting is not available if the stitch
pattern does not exist, for example, when both the
line and region sew types are set to [Not Sewn].

b
When [Cutting] is selected under [Applique
Material]:
• Uncut sections will remain in cutting lines
specified with the Applique Wizard. Be sure to
cut them with scissors after embroidering is
finished.

Replace
• Covering stitches will be sewn for outlines in the
original pattern.
• The original pattern will be deleted.
• Shape and text patterns can be used as the
original pattern. However, the following patterns
cannot be used.
- Open lines
- Closed lines that are intersecting
- Text created with built-in fonts 025 and 029,
an user-defined font or a Small Text font
- Original patterns containing both a shape
pattern and a text pattern
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a

Tutorial 8-1: Creating Appliqués

b
When multiple patterns are selected, covering
stitches will be created as shown below.
• If the patterns do not overlap
Covering stitches will be created for each
pattern.
[Add]

[Replace]

• If the patterns overlap
With the [Add] setting, covering stitches will be
created for an outline around all patterns.
[Add]
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[Replace]
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Tutorial 8-2: Creating Embroidered
Patches
The Embroidered Patch Wizard provides instructions for easily creating embroidered patches.

Step 1

Creating the patch pattern

Step 2

Using the Embroidered Patch Wizard

4

b

Drag each pattern to arrange them so that
they are well balanced.

The Embroidered Patch Wizard cannot be used if
a pattern containing text with the [Name Drop]
attribute applied is selected.

Step 1 Creating the patch pattern
1

Select the appropriate [Shapes] tool, and
then draw a heart.
cc "Drawing various shape" on page 62.

2

Import the fish pattern from the [Aquatic]
category of the Design Library.
cc "From Design Library" on page 91.

3

Select the [Text] tool, and then type in "I",
"Fresh" and "Fish".
cc "Entering text" on page 106.
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The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_8.

Tutorial 8-2: Creating Embroidered Patches

Step 2 Using the Embroidered
Patch Wizard
1
2

Select all patterns, and then click the [Home]
tab.
Click [Embroidered Patch] in the [Cut and
Sew] group to start the [Embroidered Patch
Wizard].

a
• [Width], [Density] and [Distance from original
Pattern] will be available if [Yes] has been
selected.
• Use [Distance from original Pattern] to specify
the distance between the original pattern and
the border.

5

Under [Cutting Line], specify the cutting lines
for the embroidered patch.
The cutting line of the embroidered patch can
be sewn as running stitches or the
embroidered patch can be cut out.

3

 For this example, select [Running Stitch],
and then set [Distance from satin stitch]
to "3.0 mm".

Specify settings in the [Embroidered Patch
Wizard] dialog box in the following order a b.
a

Running Stitch
Select this setting to sew the
cutting line, then cut along
the cutting line with scissors.

b

Cutting
In order for this setting to be
available
cc "Basic requirements for
Cutwork functions" on
page 173
a

Satin Stitch

b

Cutting Line

6

b
To return all parameters in the [Embroidered
Patch Wizard] to their default settings, click
[Default].

4

Under [Satin Stitch], specify a border for the
embroidered patch.
 For this example, select [Yes], and then set
[Width] to "3.0 mm", [Density] to "4.5 line/
mm" and [Distance from original Pattern]
to "5.0 mm".
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Select this setting to cut the
fabric with a machine
installed with cutwork
needles.
Click [OK] to exit the [Embroidered Patch
Wizard] dialog box.

b
• When [Cutting] is selected under [Cutting
Line], uncut sections will remain in the cutting
lines created with the Embroidered Patch
Wizard. Be sure to cut them with scissors after
embroidering is finished.
• The thread color of the satin stitching is the color
currently specified in the Design Page.

Tutorial 8-2: Creating Embroidered Patches
When [Satin Stitch] is set to [No]

Practical use of Satin
Stitch and Cutting Line

The distance between the patch pattern and the
cutting line is specified under [Distance from
original Pattern].

When [Satin Stitch] is set to [Yes]
The distance between the patch pattern and the
satin stitches is specified under [Distance from
original Pattern], and the distance between the
satin stitches and the cutting line is specified under
[Distance from satin stitch].

1

2

1 Patch pattern
2 Cutting Line

1

2

3

If multiple patterns are selected for the patch
pattern, the finished result differs depending on the
distances between the patterns as well as between
the patterns, satin stitches and cutting line in
addition to the width of the satin stitches.
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1 Patch pattern
2 Satin Stitch
3 Cutting Line

If multiple patterns are selected for the patch
pattern, the finished result differs depending on the
distances between the patterns and between the
patterns and cutting line.

Tutorial 8-3: Creating a Cutwork Pattern Filled with Net Stitching

Tutorial 8-3: Creating a Cutwork Pattern
Filled with Net Stitching
Cutwork patterns, combining embroidery and cutting with cutwork needles, can be created using the extended
functions. By using the [Cutwork Wizard], a cutwork pattern can easily be created.

Finish
The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_8.
Step 1

Creating an outline shape for cutwork

Step 2

Using the Cutwork Wizard

For the cutwork functions to be available, click
,
then [Design Settings]. Under [Machine Type],
select

2

.

Select [Outline Shapes] from the [From]
selector, select [Leaves] from the [Category]
selector, select [OL_clover01.pes], and then
click [Import].

When the cutwork functions are not being used, it is
not necessary to select this setting.
cc "Specifying the Design Page Settings" on
page 14

Step 1 Creating an outline shape
for cutwork
1

Display the [Import] pane.

b
Patterns in [Outline Shapes] from the [From]
selector are appropriate for creating the cutwork
patterns.
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3
4

Enlarge the pattern imported into the Design
Page.
Ungroup the pattern. Select the pattern,
right-click it, and then click [Ungroup].

b
• The [Cutwork Wizard] can also be used if
closed shape patterns or text patterns are
selected.
• If a line of the pattern crosses itself, the
[Cutwork Wizard] will not be available.
• Text with built-in font 025 or 029 or a userdefined font cannot be used.
• Shape patterns and text patterns cannot be
combined.

3

Specify settings in the [Cutwork Wizard] in
the following order a - e.
a

1
2

Select the four leaves, and then click the
[Home] tab.
Click [Cutwork Wizard] in the [Cut and Sew]
group to start the [Cutwork Wizard].

c

d

e

a

Stabilize Cut Edge

b

Cutting Line

c

Secure Water-Soluble Stabilizer

d

Net Fill

e

Covering Satin Stitch

Operations for Specific Applications

Step 2 Using the Cutwork Wizard

b

b
To return all parameters to their default settings,
click [Default].

4

Specify running stitching along the edge
before cutting in [Stabilize Cut Edge].
By specifying that running stitches be sewn
before the fabric is cut, the cut edges are
reinforced, preventing them from unraveling.
 For this example, select [Yes].
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5

Specify cutting line type in [Cutting Line].

7

Select whether the fabric will be cut along the
cutting line or whether the cutting line will
remain as running stitches.

Specify net fill stitching inside the cutout areas
in [Net Fill].
By sewing net fill stitching in cutouts, inner
cutouts can be reinforced while allowing for a
greater design variety.

 For this example, select [Cutting].

 For this example, select [Yes].

Cutting
In order for this setting
to be available
cc "Basic
requirements for
Cutwork
functions" on
page 173
Select this setting to
cut the fabric with a
machine installed with
cutwork needles.
Running Stitch
Select this setting to
sew the cutting line,
then cut along the
cutting line with
scissors.

6

Select the parameters according to the
procedure from step 8 to 10, when [Net Fill]
is set to [Yes].

8

Specify the net fill stitch pattern in [Pattern].
Five net fill stitch patterns are available.
 For this example, select [Pattern 2].

Specify securing of the water-soluble
stabilizer in [Secure Water-Soluble
Stabilizer].
Running stitches will be sewn to secure the
water-soluble stabilizer after the fabric has
been cut. In order to prevent embroidery from
losing its shape after it has been cut, place
water-soluble stabilizer in the cutout areas
and sew it in place.

Pattern 1

Pattern 2

Pattern 3

Pattern 4

 For this example, select [Yes].

Pattern 5
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9

Specify the pattern spacing for the net fill stitch
in [Spacing].

13

 For this example, set it to [3.0 mm].

2.0 mm

10

 For this example, set it to [6.5 line/mm].

10.0 mm

Specify the pattern direction of the net fill stitch
in [Direction].

Specify the density of the satin stitching in
[Density].

5.0 line/mm

14

7.0 line/mm

Click [OK] to exit the [Cutwork Wizard].

 For this example, set it to [0°].

11
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0°

90°

Specify satin stitching after cutting in
[Covering Satin Stitch].
Satin stitching is sewn along the edges of
inner cutouts.
The zigzag stitch or the stem stitch is used as
an underlay for the satin stitching.
 For this example, select [Yes].

Select the parameters according to the
procedure from step 12 to 13, when
[Covering Satin Stitch] is set to [Yes].

12

Specify the width of the satin stitching in
[Width].
 For this example, set it to [4.0 mm].

3.0 mm

6.0 mm
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On Using the Cutwork Functions
Before using Cutwork functions, check the following.

Basic requirements for
Cutwork functions

• Patterns when [Outline Shapes] is selected in
the [From] selector of the [Import] pane.

■ Set the "Machine Type" to multineedle embroidery machine
For the Cutwork functions to be available, click
,
then [Design Settings]. Under [Machine Type],
select

.

■ Use a multi-needle machine that
has been upgraded to work with
Cutwork functions
■ Outline shapes and text can be
used to create a cutwork pattern
• Outline shapes that have been drawn with the
tools indicated below.

The embroidery machine should be set to cutwork
mode in the settings screen before starting to
embroider. Refer to the included Operation Manual
for the details of embroidery machine operation.

• Text created in fonts other than built-in fonts 025
and 029, a user-defined font or a small text font.

a
Cutwork functions cannot be used with singleneedle embroidery machines. In addition, some
multi-needle machines may not support the
functions. Be sure to check that your machine is
compatible with the cutwork functions.
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Layout & Editing window for cutwork patterns
The settings and window areas specifically for cutwork functions are described below.

2

1

4
5
1

Sewing Order
The cutting lines appear in one frame in the
[Sewing Order] pane, and the icon for the
cutwork needle appears beside the frame.

2

Design Page
The cutting lines appear as gray dotted lines in
the Design Page, regardless of whether the
[Solid View], [Stitch View] or [Realistic View]
is selected.

3

Sewing Attributes
In the [Sewing Attributes] pane, detailed
cutting settings can be specified for the cutwork
functions.

4

Previewing cutting lines
In the [Stitch Simulator] pane, the cutwork
needles are displayed in four different shades of
gray.

In a stitch simulation, the cutting lines appear as
short gray lines, indicating the needle drop
points for making the cuts.

cc "Cutting" in the "Line sewing attributes"
on page 329

While being edited

In a stitch simulation
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3

On Using the Cutwork Functions
5

Checking Design Property
When [Cutting] has been assigned to a line
from the [Line sew type] selector, [Design
Property] screen appears as shown below.

Transferring/saving/
exporting the cutwork
patterns
In addition to transferring cutwork patterns to a
machine, they can be saved or printed.

■ Transferring
Transferring using USB media
By using commercially available USB media,
cutwork patterns can be transferred to embroidery
machines compatible with the USB media.
cc "Transferring to a machine by using USB
media" on page 201

b
[Color order] can be also viewed in the [Design
Property] screen in the Design Database.

Transferring directly to a machine's
memory
Cutwork patterns can be transferred to embroidery
machines that can be connected to a computer
using a USB cable.
cc "Transferring directly to a machine's
memory" on page 201

a
• In patterns with [Cutting] selected in the [Line
sew type] selector, the line color and region
sewing settings are not available.
• Designs containing the line sew type [Cutting]
are saved as cutwork patterns.
cc "Transferring/saving/exporting the cutwork
patterns" on page 175
• Created cutwork patterns can be used only with
embroidery machines upgraded for cutwork.
• With Palette Ver.10, the line sew type [Cutting]
changes to [Running Stitch] in the following
situations.
 When the [Machine Type] setting (on the
[Design Page] tab of the [Design Settings]
dialog box) is changed from a multi-needle
embroidery machine to a single-needle
embroidery machine
 When a cutwork pattern is imported while
[Machine Type] (on the [Design Page] tab) is
set to a single-needle embroidery machine
• Cutwork pattern cannot be transferred to a
machine by using an original card or the Link
function.
• Cutwork pattern cannot be created in Design
Center. To set the line sew type to [Cutting],
use Layout & Editing.
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a
• Cutwork patterns cannot be transferred to a
machine by using an original card or the Link
function.
• The cutwork patterns can be transferred to
embroidery machine only after the upgrade for
cutwork has been installed and certified to the
machine.

■ Saving
Saving cutwork patterns in the PES format
For details, refer to "Saving and Printing" on
page 95.

a
Designs containing the line sew type [Cutting] are
saved as cutwork patterns.

On Using the Cutwork Functions
■ Exporting
Exporting cutwork patterns in other
formats
Created cutwork patterns can be converted to other
formats (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd,
.xxx, and .shv) and outputted.
When exported as another format, the cutting lines
will be changed to a running stitch.
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Tutorial 9-1: Creating Split Embroidery
Designs
Layout & Editing has a function for creating split embroidery designs when the embroidery pattern being
created is larger than the embroidery hoop.
The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_9.
Step 1

Specifying the Design Page size in Layout & Editing

Step 2

Creating the embroidery design

Step 3

Checking the embroidering order

Step 4

Attaching stabilizer to the fabric

Step 5

Using the Positioning Sheet, mark the embroidering position on the fabric

Step 6

Hooping the fabric

Step 7

Embroidering

Step 1 Specifying the Design
Page size in Layout &
Editing
1

Click

b

Select [Custom Size], and then type or
select the desired width and height for the
Design Page. This setting is to specify the
exact width and height of a design. For
this example, set width to 230 mm and
height to 330 mm.

c

Click the [Section Size (for Hoop Size)]
selector, and then select the size of the
sections (your embroidery hoop). For this
example, select 120 × 170 mm
(130 × 180 mm).

, then [Design Settings].

b

2

Specify the Design Page size and the size of
the design sections.

a

b

c

a
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Select the type of embroidery machine to
be used.

• With the [Section Size (for Hoop Size)] setting,
the width and height of the sections are 10mm
smaller than the actual hoop size in order to
provide space for fine positioning adjustments
with adjustment sections. The 10mm is for
overlapping.
• It is not necessary for the [Section Size (for
Hoop Size)] to match the Design Page size.
Select the hoop size to be used for sewing.

3

Click [OK].

Tutorial 9-1: Creating Split Embroidery Designs

Step 2 Creating the embroidery
design
For this example, we will use one of the lace
embroidery patterns provided with the software.

1
2

Display the [Import] pane.
Select [Tutorial] from the [From] selector and
[Tutorial_9] from the [Category] selector.
Click [tutorial_9-1.pes], then [Import].

Step 3 Checking the
embroidering order
Check the sewing order to see the order that the
design sections will be sewn and determine which
parts of the fabric should be hooped.
The design sections are sewn in order from left to
right, top to bottom.

1

, then [Design Property].

Uncheck the [Show about selected
Object(s)] to view the separate design
sections. Click on [Next] and [Previous] to
move back and forth through each section.
Check the design, and then click [Cancel].

cc "Importing embroidery designs" on
page 91.

a
Before an embroidery pattern created in a custom
Design Page is saved, running stitches are added
at the edges of the design sections so that the
design sections can easily be aligned during
sewing. This alignment stitching appears in the
[NOT DEFINED] color and cannot be edited.
cc Memo of "Step 7 Embroidering" on page181
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2

Click

Tutorial 9-1: Creating Split Embroidery Designs

Step 4 Attaching stabilizer to the
fabric
Stabilizer must always be used when embroidering
to stabilize the fabric. There are many types of
stabilizer; the type that you will use depends on the
type of fabric that you are embroidering on. For
large-size designs that are split into sections, the
stabilizer must be adhered to the fabric, for
example, iron-on stabilizer. In some cases, you may
need to use two pieces of stabilizer for your
embroidery.

1

2

When using spray adhesive, spray the adhesive
onto a hooped piece of stabilizer that is strong
enough for the entire large-size embroidery. In
some cases, you may need to use two pieces of
stabilizer for your embroidery.

Punch a hole at the end of each arrow on the
positioning sheet.

Place the positioning sheet on the fabric, and
then insert the tip of a marking pen into each
hole to mark the fabric.

a
• For best results, attach the stabilizer to the fabric
(as described on this page). Without the correct
stabilizer, the design may become misaligned
due to puckering in the fabric.
• Be sure to check the recommendations on the
stabilizer package.

Step 5 Using the Positioning
Sheet, mark the
embroidering position on
the fabric

3

4

b
• The positioning sheets are included in the
package.
• The Positioning Sheets are also in the
[Positioning Sheet] folder and can be printed
out with a printer.
• Location of the Positioning Sheets: C:\Program
Files (x86)\Baby lock\Palette Ver.10\Positioning
Sheet.
• The positioning sheets in the PDF files are at
actual size. When printing the positioning sheet
from the PDF file, be sure to print it at actual
size. Do not print while reducing or enlarging to
fit the paper size.
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5

Connect the points marked on the fabric to
draw reference lines.

Place the positioning sheet on the fabric, and
mark points A, B, C and D.

A

B

D

C

To mark an area to the right of the previously
marked area, align points A and D on the
positioning sheet with marks B and C on the
fabric.

A

A B

B

D

D C

C

Tutorial 9-1: Creating Split Embroidery Designs
6

To mark an area below the previously marked
area, align points A and B on the positioning
sheet with marks C and D on the fabric.

A

7

Step 6 Hooping the fabric
1

B

A

B

D

C

D

C

Repeat steps 5 through 6 to reposition the
positioning sheet and draw the embroidering
position for each section of the embroidery
pattern.

2

• The intersection of the horizontal and vertical
line indicates the center of the embroidery hoop.
• While carefully considering how the fabric will be
hooped, place the positioning sheet on the
fabric, and then draw lines to indicate the
embroidering position. In addition, because all
embroidery areas are not drawn on the
positioning sheet for large embroidery hoops, be
careful that the embroidery area does not extend
from the marked area on the fabric as shown
below.

3

Keeping the reference lines on the embroidery
sheet aligned with the reference lines for the
first pattern section, place the fabric and inner
ring of the embroidery hoop into the outer ring
of the hoop, and then pull the fabric so that it
is tight.

Finish hooping the fabric, and then remove the
embroidery sheet.
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a

Insert the embroidery sheet into the inner ring
of the embroidery hoop, and then place them
on top of the fabric with the centerline on the
embroidery sheet aligned with the reference
lines (drawn on the fabric) for the first pattern
section to be sewn.

Tutorial 9-1: Creating Split Embroidery Designs
5

a
• Place the fabric and hoop on a level surface, and
then make sure that the inner ring is pressed in
well enough that the top edge of the inner ring
aligns with the top edge of the outer ring.
• If the embroidery sheet is not used, the marks on
the embroidery hoop can be used to hoop the
fabric vertically and horizontally.
However, since the center point on some
embroidery machines is off center, the
embroidery sheet should be used for best
results.
• Another way to hoop the fabric is to use sticky
stabilizer that can be hooped separately, tear
away the protective paper, then carefully align
the fabric onto the sticky surface using the
embroidery sheet as a guide.
• Tip: The sticky stabilizer should be removed
right away after the embroidery design is
finished.
• Tip: The fabric can be hooped more easily if
double-sided tape is affixed to the back of the
inner ring, which is placed on top of the fabric,
and then the fabric is clamped between the inner
ring and the outer ring.

Hoop the fabric for the next design section.
cc "Hooping the fabric" on page 180

b
When an embroidery design created in a custom
Design Page is saved or transferred to an original
card, alignment stitching (single lines of running
stitches with the color [NOT DEFINED], with a
pitch of 7.0 mm, and starting with fixed stitches
with a pitch of 0.3 mm) is added at the edges of the
design sections. (The alignment stitching appears
in the print preview and is printed in red.)
Sample data for this tutorial
1) Embroider the upper-left design section.
 Alignment stitching is sewn below and on
the right side of the embroidered design
section.

Step 7 Embroidering
1

When large-size embroidery designs are
transferred to the embroidery machine, the
patterns appear on the embroidery machine
display as shown below. For this example,
select the first embroidery pattern section
(Aa).

b
If there is no stitching in section Aa, select the first
section that contains stitching. Click on
[Application] button, and then click [Design
Property] to check the embroidering order.

2

3
4
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Attach the embroidery hoop to the embroidery
machine, and then using the machine's layout
adjusting functions, align the needle position
with the intersection of the lines drawn on the
fabric.
Embroider the selected pattern.
Remove the embroidery hoop from the
embroidery machine, and then remove the
fabric from the hoop.

2) Hoop the fabric for the upper-right design
section with the left side of the hoop aligned on
the alignment stitching on the right side of the
design section sewn in step 1, and then
embroider the design.
 Before the design section is embroidered,
alignment stitching is sewn on the left
side. Make sure that this alignment
stitching aligns with the alignment
stitching sewn in step 1. After the design
section is embroidered, alignment
stitching is sewn below the design
section.

Tutorial 9-1: Creating Split Embroidery Designs

3) Hoop the fabric for the lower-left design section
with the top of the hoop aligned on the
alignment stitching at the bottom of the design
section sewn in step 1, and then embroider the
design.
 Before the design section is embroidered,
alignment stitching is sewn at the top.
Make sure that this alignment stitching
aligns with the alignment stitching sewn in
step 1. After the design section is
embroidered, alignment stitching is sewn
on the right side of the design section.
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4) Hoop the fabric for the lower-right design
section with the left side of the hoop aligned on
the alignment stitching on the right side of the
design section sewn in step 3 and with the top
of the hoop aligned on the alignment stitching at
the bottom of the design section sewn in step 2,
and then embroider the design.
 Before the design section is embroidered,
alignment stitching is sewn on the left side
and at the top. Make sure that this
alignment stitching aligns with the
alignment stitching sewn in step 3 and in
step 2.

6

Continue hooping the fabric and embroidering
until the entire embroidery design is sewn.
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Tutorial 9-2: Creating Design for MultiPosition Hoops
This program enables you to create multi-position designs that you can stitch in any multi-position hoop
attached to your embroidery machine.

a

a
b
c

b
c
ABC

Example of multi-position hoop: 100 × 172 mm hoop

Although the size of the design that can be embroidered using an multi-position hoop is 130 × 180 mm (or 100
× 100 mm, depending on the sewing area of the embroidery machine), first determine which of the three
installation positions (indicated as a, b, and c in the illustration above) the multi-position hoop will be installed
at and determine the orientation of the design.
When creating the design, each design section can only be as large as the sewing area of the embroidery
machine.
The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_9.
Step 1

Selecting the Design Page size

Step 2

Creating the design

Step 3

Optimizing hoop changes

Step 4

Checking the pattern

Step 1 Selecting the Design Page
size
1
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Click

, then [Design Settings].

2

Select

under [Machine Type], and

then select [Hoop Size] and choose a Design
Page size of 130 × 300 mm or 100 × 172 mm
from the selector. Then, click [OK].

Tutorial 9-2: Creating Design for Multi-Position Hoops
• The size of one pattern must be no larger
than 100 × 100 mm (or 130 × 180 mm).

b
• Settings for multi-position hoops are indicated
by " ".
• Choose the appropriate setting after checking
the size of the hoop available for your machine.

• Each pattern must completely fit within a
single area (a, b, or c).

b
a

Step 2 Creating the design
1

The Design Page appears on the screen as
shown below.

1

a

4
2

b

3

b

c

b
• Area a
Embroidering area when the multi-position hoop
is installed at the top installation position.
• Area b
Embroidering area when the multi-position hoop
is installed at the middle installation position.
• Area c
Embroidering area when the multi-position hoop
is installed at the bottom installation position.
The dotted lines separate each area.

2

1: The position of this pattern is correct since it fits
completely within area a.
2: The position of this pattern is correct since it fits
completely within either area b or area c.
3: The size of this pattern is acceptable, but its
position must be corrected since it does not fit
completely within any of the areas.
(It will be necessary to correct the position in
order to fit in either b or c.)
4: This pattern must be corrected since it is too
large.
(It will be necessary to correct the position and
size in order to fit in either a, b, or c.)

Create the design, making sure that it meets
the following conditions.

a
b

c
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c
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Step 3 Optimizing hoop changes
1

Click

, then [Design Settings].

b
• A check mark appears when this function is
turned on; no check mark is displayed when this
function is turned off.

5

1

3

2

2

b

4
Click [Output] tab.

6

3

a

Select the [Optimize the number of times to
change the hoop’s position] check box, and
then click [OK].

c

• When the Optimize hoop change function is
turned on, the sewing order that you have set is
optimized to reduce the number of times that the
hoop installation position is changed.
For the example shown on this page, the sewing
order is: a (pattern 1)  b (pattern 2) a
(patterns 3 & 5) c (patterns 4 & 6)
If the Optimize hoop change function is turned
off, each pattern is sewn according to the sewing
order that you have set.
For the example shown on this page, the sewing
order is: a (pattern 1) b (pattern 2) a
(pattern 3) c (pattern 4) a (pattern 5) c
(pattern 6)
Therefore, since the number of times for
changing the hoop installation position is not
optimized, it may be changed more often than if
it was optimized.

a
Since the pattern may not be sewn correctly or the
fabric may not feed evenly if the hoop installation
position is changed too often, we recommend
turning on the [Optimize hoop change] function.
Turning on this function will change the sewing
order that you have set, therefore, check the
sewing order before you begin embroidering.
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Step 4 Checking the pattern
1

Click

, then [Design Property].

■ Saving the design
The entire design is saved as a single file (.pes).

b
If the file size or the number of color changes is
larger than the specified number, or if one of the
patterns does not completely fit within an
embroidery area, the error message appears.

■ Writing the design to an original
card
A design for a multi-position hoop is created by
considering the pattern in each hoop installation
position as one pattern, then combining them.
Check the sewing order of each pattern and
the number of times the hoop position will be
changed.

a
b

: This pattern is sewn when the hoop is
installed at the top installation position
(position a).
: This pattern is sewn when the hoop is
installed at the middle installation position
(position b).
: This pattern is sewn when the hoop is
installed at the bottom installation position
(position c).
Only the patterns that would be sewn at the
current position in the hoop installation order
appear in the Design Page, and the
embroidering area for the current hoop
position is outlined in red.
a

The position in the hoop installation order
for the currently displayed pattern.

b

To display information for patterns at
other positions in the hoop installation
order, click [Previous] or [Next].

Therefore, the frame installation position sewing
order for the pattern shown above is b, a, then c.

a
If a pattern is larger than the embroidery area or if
a pattern is positioned so that it does not
completely fit within an embroidery area, the error
message appears. After the pattern causing the
error is displayed, select the pattern and change
its size or position.
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2

Therefore, when this type of design is written to an
original card, one multi-position hoop design is
saved as a combination of multiple patterns.

Tutorial 9-2: Creating Design for Multi-Position Hoops
Notes on embroidering using the multiposition hoop

■ Printing a Design Page for a multiposition hoop

• Before embroidering your design, sew a trial
sample of the design on a scrap piece of fabric
from your design, making sure to use the same
needle and thread.

On the first page, a complete image of the Design
Page is printed at actual size. (However, for a 130 ×
300 mm Design Page, a reduced image of the
Design Page is printed.) On the following pages, an
image of each design section and its sewing
information are printed in the sewing order.

• Be sure to affix stabilizer material to the back of
the fabric and tightly stretch the fabric within the
hoop. When embroidering on thin or stretch
fabrics, use two layers of stabilizer material. If no
stabilizer material is used, the fabric may become
over-stretched or wrinkled or the embroidery may
not be sewn correctly.
cc For more ways to stabilize large designs,
refer to "Attaching stabilizer to the fabric"
on page 179
• Use the zigzag stitch for sewing the outlines in
order to prevent embroidering outside the
outlines.

• For patterns that require the hoop to be installed
at different installation positions, design the
embroidery pattern so that the various parts of
the pattern overlap in order to prevent
misalignment while embroidering.

1

1 Overlap
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When [Actual Size] is selected:
An image of the pattern in each design section is
printed on a separate page as the corresponding
sewing information.
When [Reduced Size] is selected:
An image of the pattern in each design section is
printed on the same page as the corresponding
sewing information.
cc "Printing" on page 96
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Tutorial 9-3: Embroidering With the
Jumbo Frame
This section describes the procedures for creating embroidery data and for embroidering using the jumbo
frame (frame size: 360 × 360 mm; with mounts on both sides of the embroidery frame).

a
• If the jumbo frame was selected, the size of the Design
Page becomes 350 × 350 mm in order to create margins
that allow automatic positioning using the built-in camera.
• The jumbo frame described here was designed specifically
for our multi-needle embroidery machines equipped with a
built-in camera. It cannot be used with any other machine,
such as single-needle embroidery machines. Check the
Operation Manual provided with your multi-needle
embroidery machine to determine if it is compatible with the
jumbo frame.

Jumbo frame: 360 × 360 mm embroidery frame

For details on embroidering using the camera and on affixing the embroidery positioning stickers, refer to the
Operation Manual provided with the embroidery machine.
The sample file for this tutorial is located at Documents (My documents)\Palette Ver.10\Tutorial\Tutorial_9.
Step 1

Selecting the Design Page size

Step 2

Creating the embroidery design

Step 3

Checking a divided pattern

Step 4

Attaching stabilizer to the fabric

Step 5

Embroidering

Step 1 Selecting the Design Page
size
1

Click

, then [Design Settings].

2

Click

under [Machine Type], select

360 × 360 mm (Jumbo Frame) from the
[Hoop Size] selector under [Page Size], and
then click [OK].
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b

Tutorial 9-3: Embroidering With the Jumbo Frame
2

a
Check the size of embroidery frames that can be
used with your machine before changing the
setting.

3

Select [Tutorial] from the [From] selector and
[Tutorial_9] from the [Category] selector.
Click [tutorial_9-3.pes], then [Import].

The Design Page appears on the screen as
shown below.

a

b

a

Side 1 embroidering area
Area embroidered first

b

Side 2 embroidering area
Area embroidered second

The embroidery pattern is automatically
divided into the different areas.

a
The embroidery pattern is split with a section
overlapping a and b.
If the pattern arranged in this section uses satin
stitches, the stitch may change when the pattern is
split. Therefore, we recommend shifting the
pattern or changing the sew type to fill stitches.

Step 2 Creating the embroidery
design
For this example, an embroidery pattern provided
with this software will be used in the procedure
described below.

1
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Display the [Import] pane.

cc "Importing embroidery designs" on
page 91.

Step 3 Checking a divided
pattern
Before starting to embroider, the divided embroidery
pattern can be checked. If a pattern that you do not
wish to be divided has been split onto Side 1 and
Side 2, you can check the embroidery pattern, then
adjust it so it is not split.

1

Click

, then [Design Property].

Tutorial 9-3: Embroidering With the Jumbo Frame
2

Click [Next] to view the next side of the
embroidery design.

Step 4 Attaching stabilizer to the
fabric
Always use stabilizer when embroidering.
For large designs split into sections, the stabilizer
must be attached to the fabric, for example, by using
iron-on stabilizer, self-adhesive stabilizer or spray
adhesive. Use stabilizer appropriate for the fabric.
In addition, be sure to use stabilizer that is strong
enough and large enough for the entire
embroidering area. You may need to attach two
layers if thin stabilizer is used.
cc See more information about stabilizer,
"Step 4 Attaching stabilizer to the fabric"
on page179.

Step 5 Embroidering

b
To view the embroidery pattern of the separate
sides, uncheck the [Show about selected
Object(s)].

■ Saving the design
The entire design is saved as a single file (.pes).
cc "Transferring to a machine by using USB
media" on page 201, and "Transferring
directly to a machine's memory" on
page 201

1

2
3

Hoop the fabric in the embroidery frame.

Attach the embroidery frame to the
embroidery machine.
Select the pattern for side 1, and then start the
embroidery machine to embroider the side 1
embroidering area.

a
An embroidery design for the jumbo frame cannot
be transferred to the machine by using an original
card. Transfer these designs directly to the
machine's memory or to the machine by using
USB media.
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Embroider using the embroidery positioning stickers
included with the embroidery machine. These
stickers are detected by the embroidery machine's
built-in camera to automatically position the fabric.

Tutorial 9-3: Embroidering With the Jumbo Frame
4

When embroidering is finished, follow the
instructions on the embroidery machine to
affix embroidery positioning sticker on the
embroidering area.

6

7

b

Follow the embroidery machine instructions to
remove the embroidery positioning stickers.

Select the pattern for side 2, and then start the
embroidery machine to embroider the side 2
embroidering area.

An image of the needle location appears in the
screen with the positioning detection area framed
by a line.
Affix an embroidery positioning sticker so that it fits
within the line. For details, refer to the Operation
Manual for the machine.
 The embroidery machine's built-in camera
detects the embroidery positioning sticker.

5

After the sticker have been detected, remove
the embroidery frame, rotate it 180°, and then
re-attach it to the embroidery machine.

b
• For details on using the embroidery machine,
refer to the Operation Manual included with it.
• Carefully remove the embroidery frame and
reattach it correctly. If the embroidery frame is
not correctly attached or if there is slack in the
fabric, the embroidery pattern may become
misaligned.

■ Embroidery data for the jumbo
frame
• When the embroidery design is being saved in
[Layout & Editing], older file format versions are
not available.
In addition, the embroidery design is saved as
data specifically for our multi-needle embroidery
machines equipped with a built-in camera. It
cannot be sewn with any other machine.

 The embroidery machine's built-in camera
detects the embroidery positioning sticker
again.
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• An embroidery pattern created in a Design Page
set to the jumbo frame size in [Design Center]
cannot be transferred directly to the machine.
Import the embroidery pattern into [Layout &
Editing], and then transfer it to the embroidery
machine.

Specifying/Saving Custom Sewing Attributes

Specifying/Saving Custom Sewing
Attributes
Saving frequently used
sewing attributes
Frequently used sewing attributes can be saved
together, and recalled when specifying sewing
attributes.

■ Saving the settings in a list
1 Click the [Sewing Attributes] tab.
cc "Specifying sewing attributes" on
page 54

2

box, select the group of settings to be deleted.

2

Click [Delete] to delete the selected group of
settings from the list.

■ Recalling a group of settings from
the list
1 In the [Load/Save Default Settings] dialog
box, select the group of settings to be recalled.

If necessary, change the settings, and then
.

a

Click [Save As].
b

4

Type in a name for the group of settings, and
then click [OK] to register the group in a list.

2

a

A group of settings that you have saved
will appear with "*" beside its name.

b

Sewing attributes appropriate for various
fabrics are already available. Select the
type of fabric to be embroidered to specify
the recommended settings for that fabric.

Click [Load].
 The settings in the [Sewing Attribute
Setting] dialog box change to the saved
settings.

b
• The saved setting can also be used on a
different computer. Simply copy [sastu.txt] from
[C:\Program Files (x86)\Baby lock\Palette
Ver.10\Settings] on the original computer to the
Settings folder at the same path on the
destination computer.
• In Explore click on C:\Program Files (x86)\Baby
lock\Palette Ver.10\Settings. Single left click on
the Settings folder to view the contents. Single
right click on sastu.txt and select copy from the
menu. Paste to a USB device and transfer to a
different computer.

Editing user thread color
lists
If you have a list of thread colors that are frequently
used, they can be saved in a user thread chart.

1

Click [Option], then [Options].
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click

3

■ Deleting a group of settings from
the list
1 In the [Load/Save Default Settings] dialog

Specifying/Saving Custom Sewing Attributes
2

■ Creating a new thread chart
1 Click [New Chart] a.

Click [Edit User Thread Chart].

2

3

A user thread chart can be saved, edited or
deleted.
a

b

c

d e

f

g

Type in the name of the chart, and then click
[OK].

b
A saved thread chart can be selected from the
[User Thread Chart] selector and [Thread Chart]
selector.

■ Renaming a thread chart
1 From the [User Thread Chart] selector j,
select the chart.

2
h
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i

j

k l

m

a

Select an existing thread chart.

b

Adds thread colors from a existing thread
chart.

c

When editing or deleting a thread chart,
select the thread chart here before
performing the operation.

d

Imports the thread chart.

e

Deletes a thread chart.

f

Creates a new thread chart.

g

Changes the thread chart name.

h

Displays thread colors in existing thread
chart.

i

Deletes a thread color.

j

Displays thread colors in the user thread
chart.

k

Changes the order of the thread colors.

l

Adds a new thread color.

m

Edits a thread color.

3

Click [Rename Chart] b.
Type in the name of the chart, and then click
[OK].

■ Deleting a chart
1 From the [User Thread Chart] selector j,
select the chart.

2

Click [Delete Chart] c.

3

If a message appears, click [Yes].

Specifying/Saving Custom Sewing Attributes
■ Importing a thread chart
1 Click [Import Chart] c.

■ Adding a new item
1 Click [New Item] f.

2

2

Select the drive, the folder, and the btc, btc2 or
csv file, and then click [Open].

3

To create a new color, click [Mix].

Specify the color, and then click [OK] to add
the specified color to the [Edit Thread] dialog
box.
(a)

cc "User thread chart files" on page 195

3

If a message appears, click [Yes].

■ Editing a chart
1 From the [User Thread Chart] selector j,
select the chart.

2

Continue with the appropriate procedure. To
save the changes, click [OK].

■ Adding items from a thread chart
1 From the [Thread Chart] selector h, select
the thread brand or a user thread chart.
If multiple user thread charts have been
created, thread colors can be selected from
different user thread charts.

2

From the list i, click the thread colors.

The color cannot be changed if the slider (a) is
moved to the top of the scale.

4

To add multiple items, hold down the <Shift> or
<Ctrl> keys while selecting thread colors.
Click [Add] l.

If necessary, type in the code, brand and
description into the appropriate boxes.

b
Only numbers can be entered for the code.

5

b

3

b

Click [OK] to add the new item to the user
thread chart k.

b
An asterisk (*) appears in front of the index number
for items created or edited by the user.

 The selected items are added to the list in
the user thread chart j.
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Files in the .btc, .btc2 or .csv format can be
imported.

Specifying/Saving Custom Sewing Attributes
■ Deleting items
1 From the list for the user thread chart k,
select the item to be deleted.

2

Click [Delete] m to delete the item from the
user thread chart.

■ Editing an item
An item registered in the list for a user thread chart
can be edited to change the color or thread number.

1
2

From the list for the user thread chart k,
select the item to be edited, and then click
[Edit Item] g.
Edit the item details in the same way as
adding a new item.

As with newly added items, an asterisk (*) appears
in front of the index number of edited items.

■ Changing the order of items
1 From the list for the user thread chart k,
select the item to be moved.
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User thread chart files
Existing user thread charts can be imported, or
edited user thread charts can be used on a
different computer.
• A newly created user thread chart is saved, in
the .btc2 format with the same name as the
thread chart, at [C:\Program Files (x86)\Baby
lock\Palette Ver.10\MyChart].
• Existing user thread charts, created with the
previous versions of the application such as
Palette Ver.9, can be used in Palette Ver.10.
Import the file "chart2.btc" from the following
location;
[C:\Program Files (x86)\Baby lock\Palette
Ver.9\Color].
• The file "chart1.btc" in the [Color] folder cannot
be imported.
• A user thread chart file in the .csv format can be
imported.
The .csv file should contain information for
Code, Brand, Description, R, G and B,
separated by commas with one color on each
line. The RGB values must be within 0-255.
Example: For a .csv file

b

2

b

Click [Up] or [Down] e to change the order
of the item.

100,MyBrand,Black,10,10,10
101,MyBrand,White,245,245,245

Specifying/Saving Custom Sewing Attributes

a
Thread colors in embroidery patterns created with
this application may appear differently on the
embroidery machine, depending on the model
used.

Operations for Specific Applications

1. Embroidery machines without a function for
displaying thread colors
The specified thread color information cannot
be displayed at all.
2. Embroidery machines with a function for
displaying thread colors
Of the thread color information specified in the
embroidery pattern, only the thread color
names are displayed on the machine.
However, the names that are displayed are
limited to the machine's preset thread color
names. Therefore, the machine displays the
names of its preset thread colors that are
closest to the colors specified in the embroidery
pattern.
3. Embroidery machines with a thread color
index
Some machines can display the thread
information specified with this application.
However, for thread colors that have been
edited or added by the user (thread colors with
an asterisk (*) at the left side), only the thread
number is displayed.
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Using Manual Punch Tool
By using the [Manual Punch] tools, you can create embroidery patterns whose sewing direction lines can be
manually adjusted.

b
Shapes drawn using the [Manual Punch] tools can be edited in the same way as shapes drawn using the
[Shapes] tools.

Creating an original logo
Using the [Manual Punch] tools, an embroidery
pattern can be created using an image of your logo
in the background.

1

2

First, select the [Manual Punch] tool. Click
the [Home] tab, click [Shapes], and then click
.

Open an image of the logo to be used to
create the embroidery pattern.
cc "Importing Image Data" on page 150

: Select this tool to create straight block
patterns (region sewing).
(Shortcut key: <Z>)

For this example, we will create a pattern of the red
design at the far left.

b
A faded copy of the background image can be
displayed in the [Design Page].
cc "Adjusting the density of the background
image" on page 152

: Select this tool to create curved block
patterns (region sewing).
(Shortcut key: <X>)
: Select this tool to create running
patterns (line sewing).
(Shortcut key: <V>)
: Select this tool to create feed patterns
(jump stitches).
(Shortcut key: <B>)
cc "Jump Stitch and Jump Stitch Trimming"
on page 297
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Using Manual Punch Tool
3

Click points 1 through 4, in order.
1
3

7

2

Click point 13, then point 14 (last point of
running stitching connecting the parts), and
then press the <Enter> key.
Specify the point so that it overlaps/connects
the part created in step 5.

4

14

13

b
To remove an entered point, right-click it or press
the <BackSpace> key.

4

8

Click
in the [Input] group of the
[Manual Punch] tab.

9

Click
in the [Input] group of the
[Manual Punch] tab.
Click points 15 through 23, in order.
Click point 24 (last point of the pattern part),
and then press the <Enter> key.
Specify the point so that it overlaps/connects
the part created in step 7.

5

Click points 5 through 11, in order.
16

Click point 12 (last point of the pattern part),
and then press the <Enter> key.

15

18

17
19
21

20

23

22

5
6
8

7

24
10
12

9

10

Click
in the [Input] group of the
[Manual Punch] tab.

11

b
Instead of pressing the <Enter> key, the pattern
part can be completed by double-clicking.

6

Click
in the [Input] group of the
[Manual Punch] tab.
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Select the Curve tool.

Using Manual Punch Tool
11

Click points 25 through 27, in order.
Click point 28 (last point of the pattern part),
and then press the <Enter> key.
Specify the point so that it overlaps/connects
the part created in step 9.

27
28

25
26

Image of finished logo

b
• If parts are connected to previous and following
ones, jump stitches will not be created in order
to automatically optimize entry and exit points.
We recommend checking stitching with the
Stitch Simulator before sewing.
cc "Checking the stitching with the Stitch
Simulator" on page 80
• Manually adding or adjusting sewing direction
lines in shape patterns afterward allows you to
continue creating patterns using the same
Manual Punch tools.
cc "Specifying the sewing direction" on page 51
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Transferring Data

This section describes operations for transferring
embroidery designs to embroidery machines.

Transferring Embroidery Designs to Machines

Transferring Embroidery Designs to
Machines
The procedures for transferring the created embroidery pattern to an embroidery machine differ depending on
your embroidery machine model. For details, refer to the Operation Manual provided with your embroidery
machine.

Transferring to a machine
by using USB media
Designs can be transferred to
an embroidery machine
compatible with the USB Host
function.

a

4

After the data has been transferred, the
message "Finished outputting data." appears,
indicating that the transfer is finished. Click
[OK], and then remove the USB media.

b
If multiple USB media are connected, specify
where the data is to be transferred in the area
shown below.

The "Palette Software Key" cannot be used as
USB media. Do not save embroidery files on the
"Palette Software Key" for transferring.

1

Plug the USB media into the computer.

2

Click the [Home] tab.

3

Click [Send] in the [Sew] group, click [Send
to USB Media], and then select the desired
drive.

Transferring directly to a
machine's memory
Designs can be transferred to
embroidery machines that can
be connected to a computer
using a USB cable.

1

 Data transfer begins.

a
If there is already a file with the same name at the
destination, the following dialog box appears.
Select whether to overwrite the existing file, to stop
copying or to copy the file using a different name.

2
3

Connect the embroidery machine to the
computer.
Click the [Home] tab.
Click [Send] in the [Sew] group, click [Send
to Your Machine], and then select the
desired drive.

 Data transfer begins.
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a
If there is already a file with the same name at the
destination, the following dialog box appears.
Select whether to overwrite the existing file, to stop
copying or to copy the file using a different name.

Transferring to a machine
by using an original card
Designs can be transferred to
an embroidery machine
equipped with a card slot.

a

4

b
• For details on transferring designs with this
method, refer to the Operation Manual provided
with your embroidery machine.
• If multiple machines are connected, specify
where the data is to be transferred in the area
shown below.

cc "From an original card" on page 92
• An embroidery design for the jumbo frame
cannot be transferred to the machine by using
an original card. This size is designed
specifically for our multi-needle embroidery
machines equipped with a built-in camera.
cc "Tutorial 9-3: Embroidering With the Jumbo
Frame" on page 188
cc For details on writing multiple embroidery
designs, refer to "Transferring
Embroidery Designs to Machines" on
page 246.

1

Plug the USB card writer module. Insert an
original card into the USB card writer module.

• If the connected embroidery machine has been
set to Link mode, the command [Send to Your
Machine], mentioned in this procedure, cannot
be selected. To select this command, return the
machine to normal mode.

2

Click the [Home] tab.
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After the data has been transferred, the
message "Finished outputting data." appears,
indicating that the transfer is finished. Click
[OK].

• Be sure that the hoop size of the design does not
exceed the hoop that will be used on the
embroidering machine.
• When writing to an original card that already
contains data, all data on the card will be
deleted. Before writing to a card, save all
necessary data to a hard disk or other media,
and check that no necessary data remains on
the card.

Transferring Embroidery Designs to Machines
3

4

Click [Send] in the [Sew] group, and then click
[Write to Card].

When the following message appears, click
[OK].

a
Transferring split embroidery designs
Embroidery patterns for the split patterns created
on the custom-sized Design Page are written to
cards split into their separate sections.
If the total size of the pattern exceeds the capacity
of the media or the machine's memory or if the
pattern is split into over 80 sections with a Design
Page size of 90 × 90 cm (35.4" × 35.4"), you will
need to split the pattern and write the separate
sections onto several media.
If all pattern sections cannot be saved with a single
operation, the [Select Hoop Sections] dialog box
appears. Select pattern sections until the media
becomes full.

 Data transfer begins. The following
message appears while the data is being
transferred.

5

After the data has been transferred, the
following message appears, indicating that the
transfer is finished. Click [OK].

The card capacity indicator at the top of the dialog
box shows the amount of space available on the
card (white) and the amount of space used by the
pattern sections (blue).
When a pattern section is selected, the total
amount of space used by the selected pattern
sections appears in blue. If the capacity is
exceeded, the entire card capacity indicator
appears in red. To deselect a pattern section, click
it again.
Click [Write] to write the selected pattern sections
to the media. (The [Write] button is available only
when a pattern section is selected and there is
sufficient space on the media for the selected
pattern sections.)
cc For details on creating split embroidery
designs, refer to "Tutorial 9-1: Creating Split
Embroidery Designs" on page 177.
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Using the Link Function to Embroider
From the Computer
Embroidery designs can be embroidered by transferring the embroidery data from the
computer to one or more embroidery machines compatible with the Link function. These
embroidery designs are embroidered after the data is sent from the computer to the
embroidery machine in the same way that a document is printed after the data is sent from
a computer to a printer.

a

• The Link function can be used only with
embroidery machines compatible with the
function; it cannot be used with other machines.
For details, refer to the Operation Manual
provided with your embroidery machine.
• The Link function cannot be used with the
following embroidery designs.
 Size exceeds the area that can be
embroidered with the machine
 Embroidery designs in a Design Page of a
custom size or for the jumbo frame
 Patterns for the 240 × 360 mm hoop
• Up to four embroidery machines can be
connected using the Link function.

• For details on connecting the machines to the
computer, refer to the Operation Manual
provided with your embroidery machine.
• If the machine is positioned far from the
computer, we recommend you to use a selfpowered USB hub. Do not use USB extension
cables or repeater cables.
• Do not connect or disconnect the USB cable
while the machine is turned on.
• Select [Power Options] in [Control Panel], and
then set both [System standby] and [System
hibernates] to [Never].

1
2

Create an embroidery design in [Layout &
Editing].
Set the embroidery machine in Link mode.
• Turn on the Link function of the embroidery
machine, and then turn off the machine.

b
One or more embroidery machines can be
connected to PC by using the Link function.

4

Click the [Home] tab.

a
For details on setting the machine in Link mode,
refer to the Operation Manual provided with your
embroidery machine.

3

Use the USB cable included with the
embroidery machine to connect the machine
to the computer.
• Turn on the embroidery machine.

204

Transferring Data

a

Using the Link Function to Embroider From the Computer
5

Click [Send] in the [Sew] group, and then click
[Link].

6

After the design has been transferred, press
the start/stop button on the embroidery
machine to begin embroidering.

b
The transferred data cannot be edited from the
embroidery machine. The received data can only
be embroidered. However, embroidering settings
can be specified.
When embroidering is started, the following appears
in the [Link] dialog box.

a

c

b

a

Transferred design

b

Queue
Displays the data before it is transferred
to the embroidery machine.

 When the machine is ready to start loading
the data, data transfer begins. While the
data is being transferred, a message
appears in the screen of the embroidery
machine, and the design moves to the
transferred design area.

c

Shows the status of the embroidery
machine.

Each status indication is described below
Status

Description

Ready

Press the button on the
embroidery machine (Start/Stop
button) to start sewing.

Waiting

If there is no data in the queue
b, select [Link] as the
destination in the application,
and send data.
If this is the status even though
there is data in the queue b,
continue the operation by using
the machine's operation panel.

Sewing

The machine is sewing.

Paused

The machine has temporarily
been stopped.

If the data sent from [Layout & Editing] does not
appear in the transferred design box, continue the
operation by using the machine's operation panel.

Color
change

Change the thread spool on the
machine.

Check
thread

Check the bobbin thread or the
upper thread on the machine.

b

Check frame

Install a different embroidery
frame on the machine.

Error

Check the details of the error
that occurred on the machine.

a

If you want to send more than one design to the
[Link] dialog, repeat step 4 for each design. The
[Link] dialog will remain open while the selected
design from [Layout & Editing] will be sent to the
Link.
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■ If multiple designs were sent to a
single machine

■ If multiple embroidery machines
are connected

Multiple embroidery designs can be embroidered
after being sent to the [Link] dialog box. In this case,
the dialog box appears as shown below.

The [Distributor] dialog box appears, in addition
with the [Link] dialog box for each embroidery
machine. The designs in the [Distributor] dialog will
all be selected. Specify which file is to be transferred
to which machine.

b
• Design Database is available to send multiple
designs at a time.

b
Distributor dialog box

cc "Sending embroidery designs to machines by
using the Link function" on page 250

a

b

c

• With the [Name Drop] function, you can also
send multiple designs where only the text is
replaced.
cc "Outputting patterns using text from the text
list" on page 128
e

f

The following operations can be performed from this
dialog box.
a

Moves the selected design(s) to the
beginning of the embroidering order.

b

Moves the selected design(s) one
position forward in the embroidering
order.

c

Moves the selected design(s) one
position backward in the embroidering
order.

d

Moves the selected design(s) to the end
of the embroidering order.

e

Automatically adjusts the embroidering
order of the designs to reduce as much as
possible the number of thread color
changes.

f

Deletes the selected design(s) from the
[Link] dialog box.

a

Selects all embroidery designs.

b

Deselects the embroidery designs.

c

Deletes the selected embroidery design.
(The design is deleted without being
moved to the <Recycle Bin>.)

a
• Sending a design to the Distributor dialog for
multiple machines.
• For multiple designs to be sent, repeat Step 5
for each design.

b
Before the message "The machine will move.
Keep your hands etc. away from the machine."
appears on the machine and [OK] is pressed, the
embroidering order of the designs, including the
first one, can be changed since the first design has
not yet been sent to the machine.
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a bc d

Using the Link Function to Embroider From the Computer
1

Select a machine in the [Machine Name] a
selector, select an embroidery file, and then
click [Send] b.

b

a

Machine name

b
• The initial machine name is the machine's ID.
For details, refer to the Operation Manual
provided with your embroidery machine.
• The name of the machine can be changed.
For details, refer to "Changing the embroidery
machine name appearing with the Link function"
on page 208
 The embroidery designs are moved to the
[Link] dialog box.
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2

Repeat step 1 to move each design to the
[Link] dialog box.

Using the Link Function to Embroider From the Computer

b
• The embroidering order of designs in the queue
can be changed.
cc For details, refer to "If multiple designs were
sent to a single machine" on page 206.
• If additional machines are connected while the
[Link] dialog box is displayed, corresponding
queues will appear. If a machine is
disconnected, the corresponding queue will
disappear.
• To display the [Property] dialog box for a file,
double-click the file's icon, or click a file to select
it, right-click it, and then click [Property] from
the menu that appears.
• To reduce this dialog box to a button on the
taskbar, click the [Minimize] button.

of the queue whose name is to be changed.

2

Type the name in the [Machine Name] box,
and then click [OK].

Transferring Data

To disconnect the USB cable, or shut down the
computer
• After data transferring to embroidery machine
and the transferring message on the screen of
the machine is closed, you can disconnect the
USB cable, or shut down the computer.
When connected to the embroidery machine
again, you can continue the Link operation.
• The embroidery machine can finish sewing the
design currently being embroidered even if the
computer is turned off.
• If the embroidery machine is turned off while it is
embroidering, the resume operation can be
used the next time it is turned on. At that time,
transmission can be resumed using the Link
function by clicking [Link] in [Design Database]
or in the [Option] menu of [Layout & Editing]
to display the [Link] dialog box.
• If the embroidery machine connection cannot be
detected, the [Link] dialog box will close
automatically.
• To display the [Link] dialog box again after the
computer has been restarted, click [Link] in
[Design Database] or in the [Option] menu (in
the upper-right corner) of [Layout & Editing].
• To display the [Distributor] dialog box, click
[Distributor] in the [Option] menu of the [Link]
dialog box.

■ Changing the embroidery
machine name appearing with the
Link function
1 Click [Machine Name] in the [Option] menu

b
A name (up to 10 alphanumeric characters/
symbols) can be specified for the embroidery
machine.

a
• When an embroidery machine is connected to
the computer, the embroidery machine is
recognized by the computer as a removable disk
and is assigned a drive letter. If this drive letter
is the same as one that has already been
assigned by the computer, designs cannot be
sent from the computer to that embroidery
machine. This problem occurs, for example, if a
network drive has been assigned a computer
drive letter. If this occurs, cancel the assignment
for the drive with the conflicting drive letter.
• When the number of embroidery machines
connected to the computer via USB is
increased, the operating system may require
that the computer be restarted. At that time,
restart the computer.
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Design Center

This section describes the basic operations
performed in Design Center. A simple step-bystep procedure is provided to create an
embroidery pattern from a template image, such
as an illustration.

Basic Design Center Operations

Basic Design Center Operations
In Design Center, embroidery patterns can be created from an original image. In addition, you can specify
colors and sewing attributes for the lines and regions that are more detailed than those specified with the [Auto
Punch] function in Layout & Editing.
An embroidery design is created in the following four stages.
Step 1
Original Image Stage

Step 2
Line Image Stage

Step 3
Figure Handle Stage

Step 4
Sew Setting Stage

Open an image file, and
select the colors to be used
for creating the outlines.

The original image is
converted to a black-andwhite line image.
Outlines can be drawn or
erased.

The line image is converted
to a figure handle image.
Points in the figure handle
image can be edited to
change the design.

The sew type and thread
colors are specified in the
outline to complete the
embroidery design.

Example:
The stripes in the scarf are
erased.
Stripes are added to the
scarf.

Example:
The eyes are moved, and
the facial expression is
changed.
A star is added to the tail of
the plane.

Example:
By applying colors different
than in the original image,
the design is given a
different appearance.

• If the data is saved, work can be stopped at each stage, then started again.
• The most appropriate images to use are those with few and distinct colors. Images or photos that are
intricate or have gradations are not suitable since it is difficult to extract their outlines.
• Line image data is saved in the .pel format, and figure handle data is saved in the .pem format.
• The embroidery data is saved in the .pem format. To transfer .pem data created in Design Center to an
embroidery machine, import the pattern into Layout & Editing, and then transfer the data to an embroidery
machine.
cc "Importing into Layout & Editing" on page 220 and "Transferring Embroidery Designs to
Machines" on page 201
This section describes the basic operations performed in Design Center. For details on the procedures or
settings, refer to "Design Center Window" on page 221.
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Step 1 Original Image Stage

4

Click

.

■ Extract outlines from an image
1 Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.

5

2

Select the desired image file, and then click
[Open].

Click [Design Center] under the title [Palette
Ver.10] in the screen.

Airplane image is located at:
Documents (My documents)\Palette Ver.10
\Sample\Design Center.

3

Click

.
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a

Basic Design Center Operations
6

In the image displayed in the [Pick Colors]
window, select the colors to be used for the
outlines (embroidery lines).
 The selected color appears in a box on the
right side, and
appears in the check box
to show that the color is selected.

Step 2 Line Image Stage
■ Using the Eraser
1 To erase a line, click [Eraser] in the [Tools]
according to
group, and then select a tool
the size of the area or thickness of the line to
be erased.

2

Move the pointer over the line to be erased,
and then click the line or drag the pointer to
erase the line.

The desired color can be selected more
easily if the [Zoom] slider is used to
enlarge the image.
If a color other than that for the outline
was selected, clear the check box
beside the color to deselect it.

7

After selecting the colors to be used for the
outlines, click [OK].
 The line image appears in the Design
Page.
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■ Using the Pen
1 To draw lines, select the [Pen] in the [Tools]
group, and then select a tool
with the
desired thickness of the line to be drawn.

Basic Design Center Operations
2

Drag the pointer to draw a line. To add a point,
click in the Design Page.

2

Click [OK].

b
To draw vertical or horizontal lines, hold down the
<Shift> key while moving the pointer.

 The line image is converted to a figure
handle image.

b

Design Center

• If lines are drawn or erased incorrectly, click
(Undo button) to undo the last operation.
• To change the display size, use [Zoom]
command.
• The part of the work area that is displayed can
easily be changed by using the [Pan] tool.

Step 3 Figure Handle Stage
■ Moving outlines
1 Click the [Figure Handle] tab.
■ Editing the extracted outline
1 When the line image is finished, click [To

2

Click
in the [Tools] group, and then click
the outline to be moved.

Figure Handle] in the [Stage] group or
(the second icon from the left) in the upperright corner of the screen.

1
2

1 Rotation handle
2 Scale handles
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3

Move the pointer over the outline so that the
shape of the pointer changes to
drag the outline.

3

Double-click the end point.

, and then

b
Drag a handle to change the size or angle. To
delete the outline, press the <Delete> key.

■ Adding lines to the figure handle
image
1 Click [Input Line] in the [Tools] group.
■ Reshaping outlines
1 Click [Select Point] in the [Tools] group.

2

Click the start point (1), and then click the next
point (2).

2

Click an outline.

1
2

 A line is drawn connecting the two points.
Continue clicking to draw additional lines.

1

b
• To remove the last point that was entered, rightclick.
• To draw vertical or horizontal lines, hold down
the <Shift> key while moving the pointer.

2

1 Point
2 Pink Line

3

To add a point, click the outline (1).
To create a corner, drag the point (2).
1

2
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4

If the point is deleted, the corner is removed.
Click the point to be deleted, and then press
the <Delete> key, or click [Delete] in the
[Clipboard] group.

2

Select a point, and then click [Split at Point]
in the [Edit] group to split the line.

■ Connecting lines
Two points can be connected to form a line.

5

To change the shape of the line, drag the
point.

1
2

Perform steps 1 and 2 in "Reshaping
outlines" to select a line.
While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.

b
• If multiple points are selected, all of the points
will be moved or deleted.
• To select additional points, hold down the <Ctrl>
key and click each point, or drag the pointer over
the points.

3

Release the mouse button to connect the two
points.

■ Splitting lines
Lines can be split at a point.

1

Perform steps 1 and 2 in "Reshaping
outlines" to select a line.
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 The shape of the pointer changes to
,
and a red square appears when the two
points are overlapping.

Basic Design Center Operations
■ Continuing to the Sew Setting
Stage
When the figure handle image is finished, continue
to the Sew Setting Stage.

1

Click [To Sew Setting] in the [Stage] group or
in the upper-right corner of the screen.

Step 4 Sew Setting Stage
We are now going to apply sewing attributes to the
different parts of the outline to create the embroidery
pattern.

■ Specifying sewing attributes
1 Click the [Sew Setting] tab.
2

To specify the sew type for the line, click
[Line] in the [Tools] group, and then select
the desired tool from [Line Sew Tool].

1
1 [Line sew type] selector

: Click this button to apply sewing
attributes to the entire outline.

b

: Click this button to apply sewing

Even after continuing to the Sew Setting Stage,
you can return to the Figure Handle Stage to edit
the figure handle image.

attributes to a portion of the outline.
To specify the sew type for the region, click
[Region] in the [Tools] group.

1
1 [Region sew type] selector

b
Sewing attributes cannot be applied to regions if
the region is not completely enclosed in an outline
in the Figure Handle Stage.

3
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Click

.

Basic Design Center Operations
4

7

Click the desired color.

When using

, click the region where the

sewing attributes are to be applied.

5
6

Click the down arrow in the sew type selector
and choose the desired sew type.
When using

or

, click the outline

To change the sewing attributes, repeat steps
1 through 7.
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where the sewing attributes are to be applied.

Basic Design Center Operations

a

b

Sewing attributes for region cannot be applied to
open regions (regions not fully enclosed in an
outline), as shown in the illustration below.

• From the [Sewing Attribute Setting] dialog
box, detailed settings for attributes, such as the
width of satin stitches and the run pitch, can be
specified.
cc "Specifying sewing attributes" on page 233.
• The Reference Window is useful for specifying
colors while checking the colors of the original
image.

If attributes cannot be applied to a region, return to
the Figure Handle Stage and make sure that
region is closed. Edit any broken lines with the Edit
Point tool.

Using the Reference Window

cc "Adding lines to the figure handle image" on
page 215

1.

Click the [View] tab.

2.

Select the [Reference Window] check box
in the [Show/Hide] group.

3.

Click the [Image] tab.

This allows you to select colors while checking
the colors in the original image.

 The image opened in Original Image
stage appears.

If [Reference] has been clicked, click
[Original].

219

Basic Design Center Operations

Step 5 Importing into Layout &
Editing
The embroidery pattern created in Design Center
can be imported into Layout & Editing. In addition,
the created data can be transferred to the machine
using functions in Layout & Editing.

a
If the sewing attributes of an outline or region are
not set, the embroidery pattern cannot be
imported.

1
2

Click the [Sew Setting] tab.
Click [Send to Layout & Editing] in the
[Stage] group.

 Layout & Editing starts up.

3

Design Center

4

Select either to import a pattern as stitch
pattern or as outline pattern.

Specify settings for [Import], [Magnification]
and [Orientation], and then click [Import].

b
For details on the settings [As Stitches] and [As
Outlines] beside [Import], refer to "Importing
embroidery design from Design Center" on
page 94.

220

Design Center Window

Design Center Window
3

4

5 6

1
2

9

8

7

10

11

1

Application button

2

Ribbon

3

Quick Access Toolbar

4

Stage button
Indicates the current stage. Click to move to a different stage.

5

Option button

6

Help button

7

Reference Window (cc p. 228)
Displays all outlines and patterns in the work area, giving you an overview while you work on a detailed
area.

8

Design Page

9

Work area

10 Status Bar
11 Refresh Window button
cc "Understanding Windows" on page 11
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Original Image Stage
Using the wizard
This wizard provides a step-by-step guide for
creating embroidery patterns.

e

Most Recently Used Files
From the list, click the name of the file,
and then click [Open].

f

Always show Wizard at Startup
Select this check box to start up the
wizard each time Design Center is started
up.

Click
, and then select [Wizard] from the
command list.

■ Opening an image
When you click the [From Image] button in the
[How do you want to produce embroidery?]
dialog box, the [From Image] dialog box appears.

b

c

d

a

c

b

d

Open Image File
Clicking this button that displays the
[Open] dialog box to select an image file.

cc "Image file formats" on page 150
b

From Clipboard
Clicking this button to paste the image on
the Clipboard into the Design Page. This
function can only be used when there is
an image on the Clipboard.

c

From TWAIN Device
Clicking this button to import an image
from a TWAIN device (such as a scanner)
connected to your computer, then paste it
in the Design Page.

d

Use Current Image
Clicking this button to use an image
opened in the Original Image Stage. This
function can only be used when an image
is opened in the Original Image Stage.

e

f

a

From Image
Clicking this button displays the [From
Image] dialog box.

b

New Line Image
Clicking this button opens a new Design
Page in the Line Image Stage.

cc "Drawing a new line image freehand" on
page 225.
c

New Figure
Clicking this button opens a new Design
Page in the Figure Handle Stage.

cc "Drawing a new figure handle image
freehand" on page 227.
d

Open PEM
Clicking this button displays the [Open]
dialog box so that a .pem file can be
selected.
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a

a

Original Image Stage

b
• To import an image from a file TWAIN device
 Connect the TWAIN device to the computer,
and then click [Image], then [Open from
TWAIN Device], or click [From TWAIN
Device] in the [From Image] dialog box.
When the [Select Source] dialog box
appears, select a device. Next, click [Select].
 For information on using the driver interface,
refer to the help manual for that interface, or
contact the manufacturer of the interface.
• Tips for scanning illustrations for Design Center
 If the outline is not clear, trace the outline on
tracing paper.
 Better scanning results may be produced by
reducing the tone of the image.

Opening a file
1

2
3

Click
, and then select [Open] from the
command list.

Select the drive and the folder.
To open a file, select it, and then click [Open],
or double-click the file's icon.

b
• If an image file is selected, the file is opened in
the Original Image Stage.
• If a .pel file is selected, the file is opened in the
Line Image Stage.
• If a .pem file is selected, the file is opened in the
Figure Handle Stage or the Sew Setting Stage.
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Line Image Stage
Extracting the outlines of
an image
1

In the Original Image Stage, click [To Line
image].

b
When the extracting color boundaries using
[Detect Outlines], the colors are converted to line
image as shown below.

cc "Original Image Stage" on page 212.

2

Selecting the colors to be used for the
outlines, and then click [OK].
a

e

g

Click [Preview] to preview the line image
in the Design Page.

Design Center

d

f

b

g

c

a

Zoom slider
Use this slider to adjust the zoom ratio for
displaying the image.

b

Tone slider
Use this slider to reduce color tones in
images where it is difficult to select the
outline color.

c

Noise reduction slider
Use this slider to reduce image noise
(distortions) in images where the outline is
not clear.

d

Click the outline color(s) to convert into
black outlines.

e

Displays the colors selected in d. To
deselect a color, clear the corresponding
check box.

f

To extract the color boundaries, click
[Detect Outlines] check box.
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Drawing a new line image
freehand
Click
, and then select [New Line Images] from
the command list.

Using the Pen and Eraser tools, the line image can
be drawn freehand in the Design Page.
cc "Line Image Stage" on page 213.

b
In the Line Image Stage, the file will be saved as a
.pel file.
cc "Saving embroidery patterns" on page 237,
and "Drawing a new figure handle image
freehand" on page 227.
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Figure Handle Stage
Changing settings for
converting to outlines
1

ON

In the Line Image Stage, click [To Figure
Handle].

To replace the black lines with figure
handle lines following the border of the
outlines, clear the [Thinning Process]
check box.

cc "Line Image Stage" on page 213.

2

Specify the desired settings in the [Figure
Object Conversion Setting] dialog box, and
then click [OK].
a

OFF

b

e
d

a

Select a setting under [Resolution].

c

Use the [SIZE] slider to set the size.

d

You will not be able to enlarge the image
beyond the limits of the Design Page
area. If necessary, click [Design Page
Property], and then change the Design
Page size.

e

To create outline data from a part of the
image, select the specific area by clicking
[Pick Area], then dragging the pointer (+)
to draw a selection frame around the area
to be selected.

Fine
Select this setting only if the image
contains many small details.
Normal
Select this setting to provide a sufficient
resolution without making the file too
large.
Coarse
Select this setting to keep the file as small
as possible.
b

To replace the black outlines with figure
handle lines along the center of the
outlines, select the [Thinning Process]
check box, and then use the slider to
select the degree of detail.

b
When the slider is set to [Much], even very thick
black lines will be replaced with a line along the
center.
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c

Figure Handle Stage

a
It may not be possible for outline data to be created
from an image when moving from the Line Image
Stage to the Figure Handle Stage, even after
various outline conversion settings have been
specified. If this occurs, return to the Line Image
Stage, and correct the outlines in the line image or
apply corrections to the image.

Specifying the Design
Page size
1
2

Click the [Figure Handle] tab.
Click [Design Page Settings] in the [Design
Page] group.

Drawing a new figure
handle image freehand
Click
, and then select [New Figure Data] from
the command list.

3

Select the Design Page size, and then click
[OK].
a

b

c

d

b
• In the Figure Handle Stage, the file will be saved
as a .pem file.
• To retrieve data from a saved .pem file, use the
command [Import Figure] in the [Figure
Handle] tab.

a

Select a machine type.
The settings available in the [Page Size]
selector differ depending on the machine
type selected here.

b

To adjust the Design Page size according
to the hoop size, select [Hoop Size], and
then select the desired hoop size from the
selector.

c

To specify a custom Design Page size,
select [Custom Size], and then type or
select the desired width and height for the
Design Page.

d

To return to the default settings, click
[Default].

a
• Do not select a hoop size larger than the
embroidery hoop that can be used with your
machine.
• Do not create a Custom Hoop larger than the
embroidery hoop that can be used with your
machine.
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Editing outlines
■ Scaling outlines

■ Rotating outlines
Rotating manually

Scaling numerically:

1

1

Select the outline.

2

2

Click the [Figure Handle] tab.

3

Click [Numerical Setting] in the [Edit] group,
and then select [Size].

Move the pointer over the rotation handle. And
then drag.

Rotating numerically

1
2

4

Select the outline.

Select the outline.
Click [Numerical Setting] in the [Edit] group,
and then select [Rotate].

Select a size, and then click [OK].

3

Type or select the desired rotation angle, and
then click [OK].

b

Design Center

a

a

b

To change the width and height
proportionally, select the [Maintain
aspect ratio] check box.
Select whether the width and height will
be set as a percentage (%) or a dimension
(millimeters or inches).
Type or select the desired width and
height.

■ Flipping outlines horizontally or
vertically
1 Select the outline.
2

b
An angle can also be selected by dragging
the [Rotate] dialog box.

in

Viewing outlines in the
Reference Window
1
2

Click the [View] tab.
Select the [Reference Window] check box in
the [Show/Hide] group.

Click [Flip Vertically] or [Flip Horizontally] in
the [Edit] group.
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■ Zooming
The [Reference Window] can be switched to
display either the entire Design Page or only the
embroidery pattern.
Click the [Pan/Zoom] tab, click

■ Displaying a different reference
image
1 Click the [Image] tab.

.

Displays the entire Design
Page.

2

3
Displays the entire
pattern.

■ Moving the display area frame
The part of the outline displayed in the Design Page
can be selected from the [Reference Window].

1
2

Move the pointer over the display area frame.
Drag the display area frame so that it
surrounds the desired part of the outline.
 The selected part of the outline is displayed
in the Design Page.

■ Redrawing the display area frame
Instead of moving the display area frame, the frame
can be redrawn to display the desired part of the
outline in the Design Page.
Click the area to be displayed, or drag the pointer
over the desired part of the outline in the
[Reference Window].
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Click [Reference], then click

.

Select the reference image, and then click
[Open].

Figure Handle Stage

Changing the background
image
■ Changing the display of the
background image
1 Click the [View] tab.
2

Drag the slider, or click
[Template] group.

or

in the

Changing application
settings
Hide (off)

50%

25%

100%

■ Changing the grid settings
1 Click the [View] tab.

75%

Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying it
faded at each density (75%, 50% and 25%) to
hiding the image (Off).

2

Specify the grid settings in the [Grid] group.
a

■ Changing the size and position of
the background image
1 Select the template. Click [Modify Template]

b
c

in the [Template] group.

2

a

To display the grid, select the [Show
Grid] check box.
To hide the grid, clear the [Show Grid]
check box.

b

To display the grid as solid lines, select
the [with Axes] check box.
To display the grid as dots (intersecting
points of the grid) , clear the [with Axes]
check box.

c

To set the grid spacing, type or select a
value in the [Interval] box.

Drag the template image to move it to the
desired location.
Drag a handle to enlarge or reduce the size of
the template image.

■ Changing the measurement units
Click [Option], then [Options], then [System Unit],
and then select the desired measurement units
([mm] or [inch]).
cc "System unit" on page 20
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b

Sew Setting Stage

Sew Setting Stage
1
2

In the Figure Handle Stage, click [To Figure
Handle] to display the [Stage] group.

4

Click the enclosed region to apply the sewing
attributes.

Click [To Sew Setting] in the [Stage] group.

b
In the Sew Setting Stage, the colors of the Design
Page and background can be changed from the
[Design Settings] dialog box (displayed by
clicking the [Option] menu, and then selecting
[Design Page Settings].)

1
1 Marching lines

a
• If the attributes cannot be applied to a region, go
back to the Figure Handle Stage and make sure
that region is closed.
• Edit any broken lines with the Edit Point tool.

Setting region/line sewing
■ Region sewing
1 Click the [Sew Setting] tab.
2

Click [Region] in the [Tools] group.

3

If necessary, change the color and sew type.
cc "Sewing attributes" on page 232

231

b
• Although a region may seem closed, if the
sewing attributes cannot be specified for the
region, the region may not actually be closed.
• To find the opening in the region, use the line
drawing mode in the Figure Handle Stage to
divide the region into smaller regions, and then
check which region sewing attributes cannot be
applied to in the Sew Setting Stage.

Sew Setting Stage
■ Line sewing
1 Click [Line] in the [Tools] group, and then
select the desired tool (

or

) from

[Line Sew Tool].

Sewing attributes
The Sew pane on the [Sew setting] tab, available in
the Sew Setting Stage, allows you to set the color
and sew type of region and outlines.
The sewing attributes that are available depend on
the tool selected.
Example 1: When

2
3

is selected

If necessary, change the color and sew type.

1

cc "Sewing attributes" on page 232.

1 Region color button
2 Region sew type selector

Click the outline to apply the sewing attributes.

Example 2: When

1

2

or

is selected

2

1 Line color button
2 Line sew type selector

Design Center

■ Sew type
1 Click in a sew type selector.
1

2

Click the desired sew type.

Line sew type

Region sew type

1 Marching lines

b
When
is selected, settings are applied only to
a portion of the clicked outline.

3

Click the region or line to apply the sew type
setting.

b
• To turn off sewing, select [Not Sewn (Line)]
from the [Line sew type] selector or [Not Sewn
(Region)] from the [Region sew type] selector.
• If the sewing has been turned off, the regions
appear in white or the lines appear as dotted
lines.
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Sew Setting Stage
■ Specifying sewing attributes
1 Click the [View] tab.
2

b

c

Select the [Sewing Attributes] check box in
the [Show/Hide] group to display the [Sewing
Attributes] dialog box.

• For region sewing
Beginner mode

a

Expert mode

a

To Expert mode/To Beginner mode
Click to switch the mode.

Click to load/save the sewing settings.
cc "Saving frequently used sewing
attributes" on page 192

1

d

Hide Hint/Show Hint
Click to switch between displaying and
hiding the hint view

e

With each change in the sewing
attributes, a preview of the stitching can
be checked here.

Change the sewing attributes displayed under
[Line sew] or [Region sew].
cc For details on the different sewing
attributes and settings, refer to "Line
sewing attributes" on page 325 and
"Region sewing attributes" on page 331

2

When the line sewing attributes are displayed,
click an outline to apply the line sewing
attributes to the outline.
When the region sewing attributes are
displayed, click a region to apply the region
sewing attributes to the region.

b

e

b

d

c

e

b

d

c

• For line sewing
Beginner mode

a

Saving frequently used sewing attributes
• Frequently used sewing attributes can be saved
together, and recalled when specifying sewing
attributes.
• Perform this operation in the same way that it is
performed in Layout & Editing.
cc For details, refer to "Saving frequently used
sewing attributes" on page 192

Expert mode

a

■ Color
1 Click the [View] tab.
2
3
e

b

d

c

e

b

d

c

a

Click to return to the default setting.
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Select the [Sewing Attributes] check box in
the [Show/Hide] group to display the [Sewing
Attributes] dialog box.
Click the [Color] tab.

Sew Setting Stage
4

From the [Thread Chart] selector, select a
thread color chart or a user thread chart.

2

Specify the desired settings in the [Gradation
Pattern Setting] dialog box, and then click
[OK].
c
a

5

From the list of thread colors, click the desired
color.

6

Click the region or outline to apply the color
setting.

■ Creating a gradation
The density of the color can be adjusted at various
locations to create a custom gradation pattern.

1

In Expert mode of the [Sewing Attribute
Setting] dialog box, select the [Gradation]
check box, and then click [Pattern].

a

To select a preset gradation pattern, click
the desired pattern under [Select
pattern].

b

Move the sliders to adjust the density of
the gradation pattern.

c

The preview area shows the setting
changes that you make.

b
Gradation can be specified if satin stitches, fill
stitches or programmable fill stitches have been
selected for the region sewing and [Manual] has
been selected as the sewing direction.

a
An additional color (used for blending in Layout &
Editing) cannot be specified with the gradation
setting in Design Center.

Applying effects to
concentric circle and radial
stitches
In order to increase the decorative effect, you can
move the center point of regions set to the
concentric circle stitch or radial stitch.

1

Click the [Sew Setting] tab.

2

Click [Region] in the [Tools] group.

3

Select the desired color and sew type
([Concentric Circle Stitch] or [Radial
Stitch]).
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cc For details on the four buttons under the
list, refer to "Special colors" on page 48

b

Sew Setting Stage
4

Click the region.
 The center point (

5

) appears.

Drag the center point to the desired location.

Preventing overlapping
stitching of regions (hole
sewing)
By specifying hole sewing, the stitching in
overlapping regions will not be sewn twice. Hole
sewing can be set only when one region completely
encloses another.

1

Click the [Sew Setting] tab.

2

Click [Hole Sew] in the [Tools] group.

3

4

b
To move the center point later, click
, and then
right click the region with the concentric circle
stitch or radial stitch applied. The center point
appears and can be moved.
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Click the region that completely encloses
another region.

Click [OK] to set hole sewing.

Sew Setting Stage

b
To cancel hole sewing, click the white inner region.
The inner region will be sewn twice when it
appears in the same color as the outer region.

Checking and editing the
sewing order
1
2

3

Click the [Sew Setting] tab.
Click [Sewing Order] in the [Check Design]
group.

To change the sewing order of a color, select
the frame for the color, and then drag the
frame to the desired position.

Applying stamps
Stamps can be applied to regions in the Sew Setting
Stage of Design Center.

1

Click [Stamp] in the [Tools] group, and then
select the desired tool from [Stamp Tools].

b
• To select additional frames, hold down the
<Shift> or <Ctrl> key and select each frame.
• The frames containing regions are separated
from the frames containing outlines with a thick
vertical line. Frames from one side of the line
cannot be moved to the other side.
• To enlarge the pattern for better viewing, click
.

: Click this button to apply a stamp.

4

: Click this button to edit the applied stamp.

To view the sewing order of multiple patterns
of the same color, select the frame, and then
click the [Part] tab.

Settings for stamps are specified in the same way
that they are in Layout & Editing.
cc "Applying and editing stamps" on
page 58

b
Some stamp patterns are provided with this
application; however, by using Programmable
Stitch Creator, you can edit the patterns that are
provided or you can create your own.

5
6

To change the sewing order of a pattern,
select the frame for the pattern, and then drag
the frame to the desired position.
Click [OK].
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2

Click the [Sew Setting] tab.

Sew Setting Stage

Checking the stitching in
the Stitch Simulator
1
2

Saving embroidery
patterns

Click the [Sew Setting] tab.

The file can be saved at each stage.

Click [Stitch Simulator] in the [Check
Design] group to view stitching using the
stitch simulator.

■ Overwriting
Click
, and then select [Save] from the
command list.

The basic operations are the same as those
described for Layout & Editing.
cc "Checking the stitching with the Stitch
Simulator" on page 80

Viewing embroidery
patterns in the Reference
Window
Embroidery patterns can be viewed in the
Reference Window in the Sew Setting Stage in the
same way that they are in the Figure Handle Stage.
cc "Viewing outlines in the Reference
Window" on page 228.

■ Saving with a new name
1

2
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Click
, and then select [Save As] from the
command list.

Select the drive and the folder, and then type
in the file name.

Sew Setting Stage
3

Click [Save].

b
• Image data from the Original Image Stage can
be saved as a bitmap file (.bmp).
• In the Line Image Stage, image data is saved as
a .pel file.
• In the Figure Handle Stage and the Sew Setting
Stage, pattern data is saved as a .pem file.

a
If you select a file type of a previous software
version, saved .pem files can be opened with that
version of the software; however, some
information may be lost.

Design Center
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Using Design Database, the created embroidery
data can be managed. In addition, while viewing
images of the file contents, the files can be
organized, or multiple embroidery designs can be
transferred to embroidery machines.

Design Database Window

Design Database Window
1

2
3
5
4
6

11
10

9

7
8

1

Toolbar

2

Folder pane

3

Contents pane
Displays thumbnails of all embroidery design in
the selected folder.

4

Card reading button
Reads an original card.

5

Folder content display button
Displays the folder contents.

6

Send to selector
Select where the embroidery files will be written
or sent.

7

Write button
Begins writing the selected designs (displayed in
the writing list).

8

Remove button
Returns the selected design (displayed in the
writing list) to the unselected state.

9

Writing list
Displays the list of designs to be written to the
original card, USB media or embroidery
machine.

10 Add button
Adds the design selected in the contents pane to
the writing/transfer list.
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11 Writing box display/non-display button
Click when writing/transferring designs.
Click this button to hide or display the Writing list.

b
Settings for the following can be selected from the
Option menu.
• Select mm or inch as the system units.
• Select Blue, Black, Silver or Aqua as the
application color.

Starting Up Design Database

Starting Up Design Database
1
2
3

Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.
Click [Design Database] under the title
[Palette Ver.10] in the screen.
Click a folder in the folder pane.
 All embroidery files in the folder are
displayed in the contents pane on the right.

b

Design Database

• The displayed files have the following
extensions.
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, .jef,
.sew, .csd, .xxx
• .pem files are not displayed since they cannot be
read by the machine. Import the embroidery
design into Layout & Editing from Design
Center, and then save it as a .pes file.
• Zipped file can not be read in this application.
cc "Importing into Layout & Editing" on page 220
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Organizing Embroidery Designs

Organizing Embroidery Designs
Creating new folders
1

In the folder pane, on the left, select the folder.

2

Click [File], then [Create New Folder].

b
• To copy the file from one folder to another on the
same drive, hold down the <Ctrl> key while
dragging the embroidery design.
• To move the file from one folder to another on
different drives, hold down the <Shift> key while
dragging the embroidery design.
• The file can also be removed from the current
folder (or copied) by selecting the menu
command [Edit] - [Cut] (or [Edit] - [Copy]).
Then, the file can be added to the new folder by
selecting it in the folder pane, then selecting the
menu command [Edit] - [Paste].

Changing file names
3

Type in the name of the new folder, and then
press the <Enter> key.

Moving/copying files to a
different folder
1
2
3

In the folder pane, locate the folder where you
want to move the embroidery design.
In the folder pane, click the folder that contains
the embroidery design.
Drag the embroidery design in the contents
pane to the folder you previously located in the
folder pane.

a
The names of embroidery designs can be changed
from Design Database only when the sewing
information (menu command [Display] –
[Details]) is displayed.
cc "Changing how files are displayed" on
page 244

1
2

3

In the folder pane, select the folder containing
the embroidery design.
Select the embroidery design. Then click
again.

Type in the new name of the embroidery
design, and then press the <Enter> key.

b
 If the two folders are on the same drive, the
selected embroidery design is moved to
the other folder.
 If the two folders are on separate drives,
the selected embroidery design is copied
into the other folder.
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When renaming a file, the file extension cannot be
changed.

Organizing Embroidery Designs

Deleting files
1
2
3

In the folder pane, select the folder containing
the embroidery design that you want to delete.

■ Small Thumbnails
Click

or click [Display], then [Small

Thumbnails].

In the contents pane, select the name of the
embroidery design.
Press the <Delete> key.
 The file is moved to the Recycle Bin.

Changing how files are
displayed
The embroidery designs in the contents pane can
be displayed as large thumbnails or small
thumbnails, or they can be listed by their sewing
information.

■ Large Thumbnails
Click

■ Sewing information
Click

or click [Display], then [Details].

or click [Display], then [Large

Thumbnails].

Design Database
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Opening Embroidery Designs

Opening Embroidery Designs
Opening files with Layout
& Editing
1

In the folder pane, select the folder containing
the embroidery design that you want to open
in Layout & Editing.

a
Be sure to select a folder that contains .pes files.

2

In the contents pane, select the .pes file.

3

Click [File], then [Open in Layout & Editing].

Importing files into Layout
& Editing
Files in the following formats can be imported.
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew,
.csd, or .xxx

1
2
3

In the folder pane, select the folder containing
the embroidery design that you want to import
into Layout & Editing.
In the contents pane, select the embroidery
design.
Click [File], then [Import Into Layout &
Editing].
 The selected embroidery design appears in
the Layout & Editing window.
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Transferring Embroidery Designs to Machines

Transferring Embroidery Designs to
Machines
a
The procedures for transferring the created embroidery design to an embroidery machine differ depending
on your embroidery machine model. For detail, refer to the Operation Manual provided with your embroidery
machine.

Transferring to a machine
by using USB media/USB
cable/original card
1

2

Click

.

Prepare the media to be used to make the
transfer, or connect an embroidery machine to
the computer.

a
Be sure that the hoop size of the design does not
exceed the hoop that will be used on the
embroidering machine.

b
Design Database

• If the design is to be written to an original card,
insert the original card into the USB card writer
module.
• If the design is to be written to USB media, plug
the USB media into the computer.
• If the design is to be transferred directly to an
embroidery machine, connect the embroidery
machine to the computer. For details on
transferring design, refer to the Operation
Manual provided with your embroidery machine.
• In order to use the Link function to transfer
embroidery designs, an embroidery machine
compatible with the Link function must be
running in Link mode.

1

2

1 Contents pane (Available designs)
2 Writing list (Selected designs)

cc "Using the Link Function to Embroider From
the Computer" on page 204
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Transferring Embroidery Designs to Machines
3

Click the [Send To] selector, and then click
the destination.

■ Using USB media
Designs can be transferred to
an embroidery machine
compatible with the USB Host
function.

a
The "Palette Software Key" cannot be used as
USB media.

4.

Select

from the [Send To] selector.

b
If multiple USB media are connected,
for each
connected device appears. Select the USB media
where the design is to be written.
a
b
c

5
6

d

a

Sends designs to the USB media.

b

Sends designs directly to an embroidery
machine.

c

Sends designs to the USB card writer.

d

Sends designs to embroidery machine(s)
by using the Link function.

.

Select a folder in a, select an embroidery file
from the contents pane b, and then click
to add the file to the writing list. After
all embroidery files to be written are added to
the writing list, click

a

b

.

b

c

If Link is not available in the [Send To] selector,
check that the embroidery machine is running in
Link mode and that the cable is correctly
connected.
cc "Using the Link Function to Embroider
From the Computer" on page 204
The remaining steps differ depending on the
destination where the data is to be sent.
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Click

d

 The designs in the writing list are written to
the USB media.
 When the designs have been written, the
message "Finished outputting data."
appears.

Transferring Embroidery Designs to Machines

a
• Do not remove the USB media while designs are
being written.
• If there is already a file with the same name at
the destination, the following dialog box
appears. Select whether to overwrite the
existing file, to stop copying or to copy the file
using a different name.

■ Transferring
directly to a
machine's memory
Designs can be transferred to
embroidery machines that can
be connected to a computer
using a USB cable.

4.

Select

from the [Send To] selector.

b
If multiple embroidery machines are connected,
for each machine appears. Select the
machine to be used to embroider.

5
6

b

.

Select a folder in a, select an embroidery file
from the contents pane b, and then click
to add the file to the writing list. After
all embroidery files to be written are added to

If a volume label has been specified for the USB

the writing list, click

media, " [(Drive Letter):] (Volume Label)"
appears in the [Send To] selector.
If a volume label has not been specified,
"

Click

.

[(Drive Letter):] USB Media" appears.
a

b

c

d

 The designs in the writing list are written to
the embroidery machine's memory.
 When the designs have been written, the
message "Finished outputting data."
appears.

a
• Do not remove the USB cable while designs are
being written.
• If there is already a file with the same name at
the destination, a dialog box appears. Select
whether to overwrite the existing file, to stop
copying or to copy the file using a different
name.
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For details on changing the name (volume label)
for the USB media, refer to the manual provided
with the USB media.

Transferring Embroidery Designs to Machines
■ Using an original
card
Designs can be transferred to
an embroidery machine
equipped with a card slot.

a

a
• Files other than .phc files can be written.
• If no USB card writer module is connected to the
computer, an original card cannot be selected as
the output destination. Before transferring, make
sure that a USB card writer module is connected
to the computer.

4.
5

Select

from the [Send To] selector.

Under [Machine Type], select the type of
embroidery machine to be used.
b
a

6

a

Single-needle machine

b

Multi-needle machine

From the [Hoop Size] selector, select the
appropriate size of embroidery hoop.

a
• Do not select a hoop size larger than the
embroidery hoop that can be used with your
embroidery machine. Otherwise, the created
original card will not work correctly with the
embroidery machine.
• When writing to an original card that already
contains data, all data on the card will be
deleted. Before writing to a card, save all
necessary data to a hard disk or other media,
and check that no necessary data remains on
the card.

b

c

d

a
• An embroidery design for the jumbo frame
cannot be transferred to the machine by using
an original card.
• If the pattern in the selected embroidery file is
larger than the hoop size selected in step 6, or
the number of stitches or number of colors for
the pattern exceeds the maximum for the hoop
selected in step 6, that file cannot be added to
the writing list. Only the embroidery designs
displayed in the writing list will be written to the
original card.

b
• Embroidery files can also be added to the writing
list by right-clicking the file, then clicking [Add to
Writing List], or by selecting a file in the
contents pane and dragging it to the writing list.
• A file can also be removed from the writing list by
right-clicking it in the writing list, then clicking
[Remove from Writing List].

9

If the files are to be written to an original card,
the following message appears. Click [OK].

cc "From an original card" on page 92

7
8

Click

a

.

Select a folder in a, select an embroidery file
from the contents pane b, and then click
to add the file to the writing list. After
all embroidery files to be written are added to
the writing list, click
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.

Do not remove the card or unplug the USB cable
while designs are being written to the card (while
the LED indicator is flashing).

Transferring Embroidery Designs to Machines
10

When a message appears, indicating that
writing is finished, click [OK].

b
Patterns created on a custom-sized Design Page
are written to cards split into their various hoop
sections.
cc Note of "Transferring to a machine by using an
original card" on page 202
• To rewrite the embroidery files written on
the original card, click
to select
those files, and move files to the writing list
in the same manner.
• To check the embroidery design file being
written to the original card, click

■ Sending
embroidery
designs to
machines by using
the Link function
An embroidery machine
compatible with the Link function must be running in
Link mode.
cc "Using the Link Function to Embroider
From the Computer" on page 204

4.

Select

5

Click

6

appears in the folder pane, and
all embroidery designs written to the
original card appear in the contents pane.

.

Select a folder in a, select an embroidery file
from the contents pane b, and then click
.

.


from the [Send To] selector.

b

a

c

• Embroidery designs written to the original card
appear as [Card Data] in the contents pane.
• To display the contents of the folder in the
display by clicking

Step 5 of "Using the Link Function to
Embroider From the Computer" on page 205.

a

b

contents pane, click

Continue the procedure as described in

. Switch the
and

.

Files in the .dst, .exp and .phc formats cannot be
transferred with the Link function. When [Link] is
selected in the [Send To] box, .dst, .exp and .phc
files do not appear in the contents pane.
In addition, embroidery files with the Design Page
size set to [Custom Size] or with [Hoop Size] set
to 360 × 360 mm (Jumbo Frame) do not appear
in the contents pane.

b
To display the [Link] dialog box again after the
computer has been restarted, click [Link] in the
[Option] menu.
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Searching for an Embroidery Design

Searching for an Embroidery Design
1

In the folder pane, select the folder.

2

Click [File], then [Search].

3

h

Specify the search conditions. Select the
check box of the search conditions to be
specified.

When searching for .pes files, the
following conditions can also be specified.

i

a
b

j

c

l

d

m

i

Design Name
Type the design name in the box.

j

Category
In the box, type specific characters or the
embroidery category.

k

Author
In the box, type the author's name to be
searched for.

l

Keywords
In the box, type the keyword to be
searched for.

m

Comment
In the box, type the comment to be
searched for.

k

e
f
g
h
n

a

File Name
Select to search for files with a specific file
name. Type the file name in the box.

b
Wildcard characters ("?" to represent a single
character and " " to represent multiple
characters) can also be used.
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Date Modified
In the boxes, type the modification date
range (from when to when).

b

Format
Select the check box beside the desired
file format.

c

Stitch Count
In the boxes, type the lower and upper
limits of the range for the number of
stitches.

d

Color Changes
In the boxes, type the lower and upper
limits of the range for the number of color
changes.

e

Total Colors
In the boxes, type the lower and upper
limits of the range for the total number of
thread colors.

f

Width
In the boxes, type the lower and upper
limits of the width range.

g

Height
In the boxes, type the lower and upper
limits of the height range.

b
• To also search through the subfolders (folders
within the selected folder), select the [Search
subfolders] n check box.
• All characters entered in the box beside [File
Name] will be considered as a single set of
characters. However, you can search for files
matching multiple words in the boxes below
[Search Conditions (only for PES files)] by
separating the words with a space.

4

Click [Search].
 A list of files matching the specified search
conditions appears.

Converting Embroidery Design Files to Different Formats

Converting Embroidery Design Files to
Different Formats
Embroidery design files can easily be converted to a file of one of the other formats (.pes, .dst, .exp, .pcs, .hus,
.vip, .shv, .jef, .sew, .csd, or .xxx).

1
2
3
4

5

In the folder pane, select the folder containing
the embroidery design that you want to
convert.

6

Click [Convert].
 The file is converted, and the new file is
added to the specified folder.

In the contents pane, select the embroidery
desired format.

b

Click [File], then [Convert Format].

• With [DST Settings] on the [Option] menu, the
number of jumps for thread trimming can be
specified for .dst files.

From the [Format Type] selector, select the
desired format.

b

• If multiple files with different formats are
selected to be converted while [Same folder] is
selected, any file with the same format as the
new one will not be converted. However, if the
files are being added to a different folder than
the original one, any file with the same format as
the new one will be copied to the different folder,
instead of being converted.
• If the file is converted to a .pes file, the thread
colors are converted as if the file was imported
into Layout & Editing.

Design Database

Under [Output To], select whether the new
file is added to the same folder as the original
file (Same folder) or to a specified folder
(Following folder).

cc "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

a
Files cannot be converted to the .phc format.

To change the folder where the new file will be
added, click

.
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Checking Embroidery Designs

Checking Embroidery Designs
Previewing files

Checking file information

Toolbar button:

1

Select a folder in a, select an embroidery file
from the contents pane b.

Sewing information such as the file name, size,
stitch count, sewing time, color count and
modification date can be checked in the Property
dialog box. With .pes file, additional information
about the embroidery design can be viewed.

a
The displayed sewing time is an estimate. The
actual sewing time depends on the machine model
used and the specified settings.

Toolbar button:

1
a

2

Click

b

, or click [Display] menu, then

2

In the contents pane, select the embroidery
design corresponding to the information that
you want to view.
Click

, or click [Display] menu, then

[Property].

[Preview].

PES files (version 4.0 or later)

b
Select [Color changes] beside [Color List] to
display the thread color change information in the
color list. Select [Total colors] to display the
information for all thread colors in the color list.
cc "Checking embroidery design information" on
page 88
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b
• Non-PES files and PES files (version 3.0 or
earlier)

• If the Design Page size was set to [Custom
Size] or if [Hoop Size] was set to a multiposition hoop (100 × 172 mm or 130 × 300 mm)
or a jumbo frame (360 × 360 mm), a [Property]
dialog box similar to the one shown below
appears.

Design Database

• The red box in the dialog box shows the position
of the displayed pattern section.
• To display information for other hoop positions,
click

or

.

254

Outputting a Catalog of Embroidery Designs

Outputting a Catalog of Embroidery
Designs
Images and sewing information for all embroidery designs can be outputted in a number of formats. Select
among the following modes according to your preferences.

4

Printing
Images of all embroidery designs in the selected
folder can be printed as a catalog or as an
instruction guide.

Select [Color List] c.
Color changes
The thread color information for each color
change is displayed.
Total colors
The thread color information for the necessary
threads is displayed. This allows you to check
the total number of thread colors.
cc "Checking embroidery design
information" on page 88

5

1
2
3

a

Select [Print Layout] d.
Catalog style 1

Catalog style 4

Catalog style 12

Instruction Guide style

In the folder pane, select the folder containing
the embroidery designs.
Click [File], then [Print Setup].
Under [Paper] a and [Orientation] b,
select the appropriate settings.

b

c
d
e

6

7
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Under [Color Description] e, select
whether the thread colors appear as the name
of the color or as the brand and thread
number.
Click [Print].

Outputting a Catalog of Embroidery Designs

Outputting as a CSV file

b
• If one or more embroidery designs were
selected in the contents pane, only the selected
designs are printed.
• If the brand name, thread number or file
properties is too long, some of the text may not
be printed.
• If [File], then [Print] is clicked, the embroidery
designs are printed according to the settings
already selected in the [Print Setup] dialog box.

Outputting as an HTML file

A .csv file containing the sewing information (file
name, dimensions, number of stitches, number of
colors, file path, file properties (.pes files only) and
the names of thread colors and thread numbers) for
selected embroidery designs can be outputted.

1
2
3

In the folder pane, select the folder containing
the embroidery designs.
Click [File], then [Create CSV].
Select the drive and the folder, and then type
in the name of the .csv file.

Instead of being printed, the catalog of embroidery
designs can be outputted as an HTML file.

1
2
3

In the folder pane, select the folder containing
the embroidery designs.
Click [File], then [Create HTML].
Select the drive and the folder, and then type
in the name of the HTML file.

4

Click [Save].

Design Database

4
5
6

To add a title at the top of the file and in the title
bar, type the title in the [Page Title] box.
Under [Page Layout], select how the designs
appear on the page.
Click [Save].
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Programmable Stitch Creator

Programmable Stitch Creator allows you to create
and edit stitch patterns, which can then be used
as programmable fill stitches or motif stitches in
both Layout & Editing and Design Center.

Basic Programmable Stitch Creator Operations

Basic Programmable Stitch Creator
Operations
Programmable Stitch Creator is an application for creating, editing and saving stitch patterns that can be used
for programmable fill stitch or motif stitch sewing. The following two types of patterns can be created in their
corresponding mode.

Fill/stamp stitch patterns

• These patterns can be used as stamp patterns and for sewing with the programmable fill stitch in
Layout & Editing or Design Center.
• These patterns can be created with a single line or with multiple lines. In addition, these patterns can
be used to create an embossing/engraving effect in sewn regions.
• These patterns are created in Fill/Stamp mode.

engrave

emboss

Motif stitch patterns

• These patterns can be used for sewing lines with the motif stitch and for sewing regions with the motif
stitch, piping stitch and stippling stitch in Layout & Editing or Design Center.
• These patterns are created with a single line, which gives the look of a single-stroke drawing, and they
are used for decorative machine sewing.
• These patterns are created in Motif mode.
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Creating Fill/Stamp Stitch Pattern

Creating Fill/Stamp Stitch Pattern
Existing programmable stitch patterns can be edited to create new patterns.

Opening a fill/stamp stitch pattern

Step 2

Drawing lines to edit the fill/stamp stitch pattern

Step 3

Applying embossing/engraving effects to the fill/stamp stitch pattern

Step 4

Saving the edited fill/stamp stitch pattern

Step 5

Using the edited fill/stamp stitch patterns in Layout & Editing

Step 1 Opening a fill/stamp stitch
pattern

4

Select Fill/Stamp File(*.PAS) in the Files of
type selector.
Select the pattern file wave1.pas.

First, we will open a fill/stamp stitch pattern to be
edited. In this example, we will use pattern
wave1.pas.

1
2
3

Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.
Click [Programmable stitch Creator] under
the title [Palette Ver.10] in the screen.

The pattern file can be found at the following
location.

Click
, and then select [Open] from the
command list.

For example, (Drive where Palette was
installed)\Program Files (Program Files
(x86))\Baby lock\Palette Ver.10\Pattern.

b
To view the data in the selected folder as
thumbnails in the [Browse] dialog box, click
[Browse].
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Step 1

Creating Fill/Stamp Stitch Pattern

Step 2 Drawing lines to edit the
fill/stamp stitch pattern
1

Click the [Home] tab.

2

Click [Draw Line] in the [Tools] group.

3

Click points (1) through (4).
1
2
3

5

Repeat the previous operations.

Step 3 Applying embossing/
engraving effects to the
fill/stamp stitch pattern
1

Click (1), and then double-click (2).
Next, click (3), and then double-click (4).

4

1

2

4

3

b
• To remove the last point that was entered, rightclick the mouse button.
cc "Reshaping a fill/stamp stitch patterns" on
page 264
• The grid width can be changed.

 Lines are drawn along the top and bottom
edges of the Design Page.

cc "Changing the grid settings" on page 273

4

Double-click (5) (end point).

b
In order to create an effect, the lines must form a
closed region.

5
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Creating Fill/Stamp Stitch Pattern
2

Click [Region (engrave)] in the [Tools]
group, and then click the first and fourth wave
regions.

 These regions appear in red and will be
sewn with short stitches to give the effect of
engraving.

b
To remove the embossing/engraving effect, use
the [Region (reset)] tool. Click [Region (reset)] in
the [Tools] group, and then click a region with an
effect applied.

Fill/stamp stitch patterns are saved in the .pas
format.

1

3

Click
, and then select [Save As] from the
command list.

Click [Region (emboss)] in the [Tools]
group, and then click the second and fifth
wave regions.

2

Select the drive and the folder, and then type
in the file name.

 This region appears in blue and will be
sewn with no dropped stitches to give the
effect of embossing.

When saving a fill/stamp pattern, specify the
size beside [Default Size]. Click [mm] or
[inch] to select the measurement units.

3

Click [Save].
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Step 4 Saving the edited fill/
stamp stitch pattern

Creating Fill/Stamp Stitch Pattern

Step 5 Using the edited fill/stamp
stitch patterns in Layout &
Editing
1

Start up Layout & Editing.

2

Select an embroidery pattern.

3
4

7

Click the edited fill/stamp stitch pattern, and
then click [OK].
 The pattern is applied to the inside regions
of the embroidery pattern.

From the [Region sew type] selector (in the
[Shapes] tab), select [Prog. Fill Stitch].
Display the [Sewing Attributes] pane.
cc "Specifying sewing attributes" on
page 54

5

Click
below [Programmable fill] in the
[Region sew] section.

b
• A fill/stamp stitch pattern can also be applied as
a stamp by using the Stamp Tools.
cc "Applying and editing stamps" on page 58
• For best results, refer to "Notes on
programmable fill stitches and stamps" on
page 335.

6
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Select the drive and folder where the pattern
was saved in Step 4.

Editing a Pattern in Fill/Stamp Mode

Editing a Pattern in Fill/Stamp Mode
■ Selecting patterns
1 Click the [Home] tab.
2

3

■ Scaling patterns
Drag a handle of the selected pattern to adjust its
size. Drag the rotation handle to rotate the pattern.

Click [Select] in the [Tools] group to use the
[Select] tool.

b
• If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.
• Click [Flip Vertically] in the [Flip] group to flip
the selected pattern(s) up/down. Click [Flip
Horizontally] in the [Flip] group to flip the
selected pattern(s) left/right.

Click the pattern.

2

1 Rotation handle
2 Handles

4

To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

b
• You can also select patterns by dragging the
pointer across the pattern.
• Hold down the <Ctrl> key and click a selected
pattern to deselect it.

• Using commands other than those mentioned
above, selected patterns can be edited in other
ways, for example, duplicated or deleted.
cc "Menus/Tools" of "Programmable Stitch
Creator" on page 317.

■ Reshaping a fill/stamp stitch
patterns
1 Click [Select Point] in the [Tools] group.

■ Moving patterns
Selected patterns can be dragged to move them.

b

2

Click the broken line.

• To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.
• Pressing the arrow keys moves the selected
pattern one grid mark in the direction of the
arrow on the key.
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1

Editing a Pattern in Fill/Stamp Mode
3

To edit a point, click the point to select it.

: Selected point
: Unselected point

• To move the point, drag it to the new
location.
• To insert a point, click the line to add a new
point.
 A new point appears selected.
• To delete the point, click

or press

the <Delete> key.

b
• If a line is composed of two points and you
delete one of them, the entire line is deleted.
• To select multiple points, hold down the <Ctrl>
key while clicking the points, or dragging the
pointer over the points.
• Hold down the <Ctrl> key while pressing the
key or

key. The selection direction

changes to the end or start point.
• Hold down the <Shift> key while dragging the
points. The points are moved horizontally or
vertically.
• Press an arrow key. The points move in the
direction of the arrow on the key.
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Creating Motif Stitch Pattern
Now, we will create a new motif stitch pattern. Motif stitch patterns are created in Motif mode.

Enter motif mode

Step 2

Shaping a single line to create motif stitch pattern

Step 3

Saving the created motif stitch pattern

Step 4

Using the edited motif stitch pattern in Layout & Editing

Step 1 Enter motif mode
1
2

2

Click [Select Point] in the [Tools] group.

Start up Programmable Stitch Creator.
Click
, and then select [New Motif
Pattern] from the command list.

Step 2 Shaping a single line to
create motif stitch pattern
In Motif mode, you can create original patterns by
changing the shape of a single line.

1

Click the [Home] tab.

Blue square: Start point
Red square: End point

3

Select (1), then drag the point.
The line that moves turns green when moving
a point.

1

2
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Step 1

Creating Motif Stitch Pattern
4

Click the line to insert points.
Click (3) located between (1) and (2).
Click (4) located between (3) and (2).

7

Click (6) located between (4) and (5), then
drag the point to (1).
Select (3), then drag the point to (2).

4
1

1
6

3 4

3

2

2
5

5

Select (4), then drag the point.

4

6

Click between (2) and (4) to insert point (5),
and then drag point (5).

4

5

2

267

b
• To move the point horizontally or vertically, hold
down the <Shift> key while dragging it.
• Pressing the arrow keys moves the selected
point one grid mark in the direction of the arrow
on the key. If the grid is not displayed, the
pattern moves a distance smaller than the
smallest grid interval in the direction of the arrow
on the key.
• To delete a selected point, press the <Delete>
key.
• These patterns can be applied in line sewing
and region sewing in Layout & Editing, and
region sewing in Design Center.

Creating Motif Stitch Pattern

Step 3 Saving the created motif
stitch pattern

5

Click
section.

below [Motif] in the [Line sew]

Motif stitch patterns are saved in the .pmf format.

1

Click
, and then select [Save As] from the
command list.

2

Select the drive and the folder, and then type
in the file name.

7

Click the created motif stitch pattern, and then
click [OK].
 The pattern is applied to the outlines of the
embroidery pattern.

 When saving a motif pattern, specify the
size beside [Default Size]. Click [mm] or
[inch] to select the measurement units.

3

Select the drive and folder where the pattern
was saved in Step 3.

Click [Save].

Step 4 Using the edited motif
stitch pattern in Layout &
Editing
1

Start up Layout & Editing.

2

Select an embroidery pattern.

3
4

From the [Line sew type] selector (in the
[Shapes] tab), select [Motif Stitch].
Display the [Sewing Attributes] pane.
cc "Specifying sewing attributes" on
page 54

b
A motif stitch pattern can be used when the motif
stitch, piping stitch or stippling stitch has been
selected as the sew type of a region.
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6

Editing a Pattern in Motif Mode

Editing a Pattern in Motif Mode
■ Moving and deleting several
points at a time
1 Click the [Home] tab.
2

■ Scaling patterns
1

Click

in the [Tools] group.

Click [Select Point] in the [Tools] group.

2

Drag the handle to adjust the selected
pattern(s) to the desired size.

b
Blue square: Start point
Red square: End point

3

To select a single point, click an empty square.
To select multiple points, hold down the
<Ctrl> key while clicking the points, or
dragging the pointer over the points.

: Selected point
: Unselected point

b
Hold down the <Ctrl> key while pressing the
key or

key. The selection direction changes

to the end or start point.

4

Edit the points.
• To move the points, drag them to the
desired location.
• To delete the point, click
the <Delete> key.

or press

a
The start point (blue square) and end point (red
square) can not be deleted.
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• If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.
• To flip the pattern along a vertical axis, click
[Flip Vertically] in the [Flip] group.
• To flip the pattern along a horizontal axis, click
[Flip Horizontally] in the [Flip] group.

Programmable Stitch Creator Window

Programmable Stitch Creator Window
3
1

4

2
6

7
Programmable Stitch Creator

5

8
1

Application button

2

Ribbon

3

Quick Access Toolbar

4

Help button

5

Preview window (cc p. 272 )
Shows how the pattern will be sewn.

6

Design Page

7

Work area

8

Status Bar
cc "Understanding Windows" on page 11
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Opening a Template

Opening a Template
Opening an image in the
background
1
2

3

Click the [View] tab.

Changing the density
background image
1

Drag the slider in the [Template] group, or
click

Click [Open Template] in the [Template]
group.

Select the drive, the folder and the file, and
then click [Open] or double-click the file's
icon.

or

.

Hide (off)

50%

25%

100%

75%

b

b
• Only one image can be added to the work area.
If you try to display a different image, it will
replace the previous one.
• There are many different types of files that can
be opened.
cc "Image file formats" on page 150
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• This function is not available if no template
image has been imported into the work area.
• Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying
it faded at each density (75%, 50% and 25%) to
hiding the image (Off).

Preview Window

Preview Window
1
2

Click the [View] tab.

Saving Patterns
Overwriting

To switch between displaying and hiding the
[Preview] window, select or unselect the
[Preview Window] check box in the [View]
group.

Click
, and then select [Save] from the
command list.

Saving with a new name
In Fill/Stamp mode

The files are saved as.pas files in Fill/Stamp mode,
and as .pmf files in Motif mode.

1

2

Click
, and then select [Save As] from the
command list.

Select the drive and the folder, and then type
in the file name.

 When saving a motif pattern, specify the
size beside [Default Size]. Click [mm] or
[inch] to select the measurement units.
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 If no file name has been specified or if the
file cannot be found, the [Save As] dialog
box appears.

In Motif mode

Changing the Settings
3

Click [Save].

b
Saved files can be used in Layout & Editing or
Design Center.
cc "Using the edited fill/stamp stitch patterns in
Layout & Editing" on page 263 and "Using the
edited motif stitch pattern in Layout & Editing"
on page 268

Changing the
Settings
Changing the grid settings
1
2

Click the [View] tab.
Select the desired spacing of the grid lines
from [Interval] in the [Grid] group.

None
No grid is displayed.
Narrow
The spacing of the grid lines is changed to 1/
32 of the Design Page width.
Medium
The spacing of the grid lines is changed to 1/
16 of the Design Page width.
Wide
The spacing of the grid lines is changed to 1/8
of the Design Page width.
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Font Creator

User-defined fonts can be created using Font
Creator. These fonts can be recalled to be used in
Layout & Editing.

Basic Font Creator Operations

Basic Font Creator Operations
With Font Creator, user-defined font characters that can be used in Layout & Editing can be created and
edited. Using these custom characters, original embroidery patterns can be created.

Step 1

Selecting a character to be created

Step 2

Opening a background image

Step 3

Creating a font character pattern

Step 4

Creating other font character patterns

Step 5

Save the font character pattern

Step 6

Creating an embroidery pattern using the created font characters

Step 1 Selecting a character to be
created
1
2
3
4

Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.

Step 2 Opening a background
image
1
2

Click the [View] tab.
Click [Open] in the [Template] group, and
then select [Select Image File] from the list.

Click [Font Creator] under the title [Palette
Ver.10] in the screen.
Click the [Home] tab.
Click the [Select Character] box in the
[Character] group, and then select "T" from
the list.

3

Import the Capital_T.bmp.

The image file can be found at the following
location.
Documents (My documents)\Palette
Ver.10\Sample\Font Creator\Font Template
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Basic Font Creator Operations
6

b
There are many different types of files that can be
opened.

Click
in the [Tools] group, and then drag
the red triangle icons to move the set lines so
that they are aligned with the left and right of
the character.

cc "Image file formats" on page 150

4

Move the character so that the top aligns with
the [Capital Line]. To adjust the height of the
character, drag a handle to adjust the height
between the [Capital Line] and the [Base
Line].

1
2

1
1 Set Line
3

7

Click the [View] tab.

8

In the [Template] group, drag the slider (or
click
or
) to change the density of the
template image to "25%".

4
Capital Line
Handles
Base Line
Set Line

Font Creator

1
2
3
4

b
• Red lines are added above, below and to the left
and right of the sample image. Use these lines
as guides for adjusting the [Base Line], [Capital
Line] and [Set Lines].
• If the handles have disappeared, right-click the
image, and then click [Modify Template] in the
menu that appeared.

5

Click the [Home] tab.

Hide (off) 50%

100%

25% 75%

b
• This function is not available if no template
image has been imported into the work area.
• Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying
it faded at each density (75%, 50% and 25%) to
hiding the image (Off).

Step 3 Creating a font character
pattern
1

Click the [Home] tab.
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Basic Font Creator Operations
2

Click the [Manual Punch] in the [Tools]
group, and then select the desired tool from
[Manual Punching Tools].

3

Click

, and then click in the Design Page

to specify points (1) (start point) through (4).
1

3

2

4

: Straight block-type punching patterns
(region sewing).
(Shortcut key: <Z>)
: Curved block-type punching patterns

4

Click [Manual Punch], select

, and then

click point (5) through (7).

(region sewing)

7

5

(Shortcut key: <X>)

6

: Semi-automatically created straight
block-type punching pattern
By semi-automatically tracing, points
can be specified along the lines of a
template.
(Shortcut key: <C>)
: Running-type punching pattern (line
sewing)
(Shortcut key: <V>)
: Feed-type punching pattern (jump

5

Click [Manual Punch], select
click points (8) through (10).
9

stitches)
(Shortcut key: <B>)

b
• When entering points, you can switch between
the various tools. This is very easy if the shortcut
keys are used.
• A template image is needed in order to use the
semi-automatic block-type punch tool. If there is
no image, this tool will create a punching pattern
like the straight block-type punch tool. In
addition, this tool cannot be used if a TrueType
font is used as the template.
• Once the pattern is drawn, you can still
transform straight block-type patterns into
curved block-type patterns and vice versa.
cc For details, refer to "To Straight/To Curve" on
page 288
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10

8

, and then

Basic Font Creator Operations
6

Click [Manual Punch], select

, and then

click point (11).

Step 4 Creating other font
character patterns
1
2

11

7

Click [Manual Punch], select

, and then

click points (12) through (13).

3

Click the [Home] tab.
Click the [Select Character] box in the
[Character] group, and then select "g" from
the list.

Import file Small_g.bmp in the same way that
"T" was imported.

12

4

13

Double-click point (14) (the last point of the
entire pattern), or click point (14) and press the
<Enter> key.

14
1
1 Set Line

b
To remove the last point that was entered, rightclick the mouse button, or press the
<BackSpace> key.

If the red lines are not shown, change the
density of the template image.

278

Font Creator

8

In the same way that "T" was adjusted,
change the character size and position, and
then drag the red triangle icons to move the
set line so that they are aligned with the left
and right of the character.

Basic Font Creator Operations
5

Click
in the [Tools] group, and then drag
the blue triangle icons to move the mean line
and descender line so that they are aligned
with the top and bottom of the character.

7

Click [Manual Punch], select

, and then

click points (8) through (24).

16

1

15
8

13
11 9
14

10
12

2

1 Mean Line
2 Descender Line

6

20
18

Click [Manual Punch], select

22

, and then
17

click points (1) through (7).

19
21
23

24

1
7

2
3

6
4

5

8

Click [Manual Punch], select
click points (25) through (26).
26
25
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, and then

Basic Font Creator Operations
9

Click [Manual Punch], select

, and then

click points (27) through (33).
27
29

Step 5 Save the font character
pattern
1

28

31

30

33

32

2
10

Click [Manual Punch], select

, and then

Click
, and then select [Save] from the
command list.

Select the [MyFont] folder at the following
location.

click points (34) through (38).

34

37
36

11

35

And then type in the file name. For this
example, type in the name "My font 1".

Click [Manual Punch] and select

47

46
40 44
42
41

43

45

Click [Save].

Next,

click points (39) through (46), and then
double-click point (47) (end point), or click
point (47) and press the <Enter> key.

39

Font Creator

For example, (Drive where Palette was
installed)\Program Files (x86)\Baby
lock\Palette Ver.10\MyFont.

38

a
• The created font is saved in the [MyFont] folder
at the following location.
• The font will not be usable in the Layout &
Editing if it's stored in a different folder.
For example, (Drive where Palette was
installed)\Program Files (x86)\Baby
lock\Palette Ver.10\MyFont.
• If any part of the character pattern extends off
the Design Page, a message appears. Edit the
character pattern so that no part extends off the
Design Page, and then save it again.

b
If the background image is displayed, the
information for the background image will be
saved with the font file. The next time that the font
file is opened, the background image is displayed.
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Step 6 Creating an embroidery
pattern using the created
font characters
1

5

Click in the Design Page.
Input the text, and then press <Enter> the key
or click the Design Page.

Start up Layout & Editing.

a
If Layout & Editing is already started, exit it, and
then start it again. The new font is detected when
the application starts up.

2

Click the [Home] tab.

3

Click [Text] in the [Tools] group, and then
select

4

from [Text Tools].

Click in the Font selector, and then select
"My font 1".

Fonts created in Font Creator appear with the
icon in front of the font name.

b
Since fonts for only "T" and "g" were created in the
previous examples ("A", "B", "C", etc. were not
created), only these characters appear in the
sample when [Font] selector is clicked.
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cc "Creating Embroidery Patterns
Containing Text" on page 100

Font Creator Window

Font Creator Window
3
1

4

2
6

7
8

5
9

1

Application button

2

Ribbon

3

Quick Access Toolbar

4

Help button

5

Preview Window (cc p. 289)
Shows how the stitch pattern will be sewn.

6

Design Page

7

Guidelines (fixed) (cc p. 283)

8

Guidelines (movable) (cc p. 283)

9

Work area

Font Creator

10

8

10 Status Bar
cc "Understanding Windows" on page 11
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Font Creator Window

About the Design Page
guidelines

b

The standard guidelines for creating fonts are
shown in the Design Pages. The contents of each of
the guidelines are as shown below.
e

b

c

a
d

f

g

1

1 Triangle icon
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a

Base Line

b

Capital Line
The font's standard height will be from the
Base Line to the Capital Line line. These
line cannot be moved.

c

Mean Line
When in lower case, the standard height
of the font will be from the Base Line to
this line. It can be moved by dragging the
triangle icon on the right edge.

d

Descender Line
This line is the standard for characters
with parts that hang down (descenders)
such as "g" and "y". It can be moved by
dragging the triangle icon on the right
edge.

e

Ascender Line
This line is the standard for characters
with parts that extended above
(ascenders) such as the accent mark. It
can be moved by dragging the triangle
icon on the right edge.

f

Set Line (Left)

g

Set Line (Right)
This line will be the font width. The font
width can be adjusted by dragging the
triangle icon on the bottom edge.

• The heights and widths specified for the [Base
Line], [Capital Line] and [Set Lines] are the
reference mask for creating the font character.
• When characters created with Font Creator are
imported into Layout & Editing, the width and
height of the characters will be in the following
area.
 Character height: from Base Line a to
Capital Line b
 Character width: from Set Line (Left) f to Set
Line (Right) g
• In order to align the height of the characters, the
[Ascender Line], [Mean Line] and [Descender
Line] appear the same with all characters.
Therefore, if the height of any of these lines is
changed, the setting is maintained, even when a
different character is selected to be edited.
• The widths of the [Set Lines] can be set
separately for each character.

Opening a File

Opening a File
Creating a new font
Click
list.

, and then select [New] from the command

Opening a font file
1

2

The created font is saved in the [MyFont]
folder at the following location.
(Drive where Palette was installed)\Program
Files (x86)\Baby lock\Palette
Ver.10\MyFont

To open a file, select it, and then click [Open],
or double-click the file's icon.
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3

Click
, and then select [Open] from the
command list.

Selecting a Character and Preparing the Template

Selecting a Character and Preparing the
Template
Selecting the character to
be created
■ Selecting from the selector
1 Click the [Home] tab.
2

Click the left or right arrow buttons of the
[Select Character] box in the [Character]
group to select a character before or after the
one that is currently displayed.

■ Selecting from a character list
1 Click the [Select Character] box in the

b
• Characters where pattern has already been
created appear with a blue background.
• The blank box in the upper-left corner is a space.
Click this box to select a space.

a
If any part of the character pattern extends off the
Design Page when a different character is
selected, a message appears. Before selecting a
different character, edit the character pattern so
that no part extends off the Design Page.

■ Adding/deleting registered
characters
1 Click [Add/Remove Characters] in the
[Character] group.

[Character] group.

2

2
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Click the character to be created.

From the keyboard, enter the character to be
registered.

Selecting a Character and Preparing the Template
3

4

Click [Add].

3

From the [Font] selector, select the font. From
the [Style] selector, select the character style.
And then click [OK].

To delete a registered character, select the
character, and then click [Remove].
The box is selected in red. Each click of the
character switches between selecting and
deselecting it.

5

When the settings can be applied, click [OK].

b
If a character is registered even though a font has
not been created, the information for the registered
character is saved in a font file.

Opening a template
(TrueType font)
1
2

Click the [View] tab.

b

Click [Open] in the [Template] group, and
then select [Select TrueType Font] from the
list.

• If the character selected in the [Select
Character] box is not available in the TrueType
font, "?" appears as the template.
• If a TrueType font was selected as the template,
it cannot be moved or resized.
• In this case, it can automatically be converted to
a font character pattern.
cc "Automatically converting TrueType fonts" on
page 287.
• In addition, the character cannot be drawn with
the semi-automatic block-type punch tool.
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While working on a character in a font, the
same TrueType font appears until a different
template is selected for the background. Each
time a different character is selected in the
[Select Character] box, the template of the
character in the same TrueType font appears.

Creating a Font Character Pattern

Creating a Font Character Pattern
Automatically converting
TrueType fonts
1

Open the TrueType font to be used as a
template.
cc "Opening a template (TrueType font)" on
page 286.

2
3

4

To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

b
• You can also select patterns by dragging the
pointer across the pattern.
• Hold down the <Ctrl> key and click a selected
pattern to deselect it.

Click the [Home] tab.
Click [Convert from TrueType] in the [Edit/
Arrange] group.

■ Moving patterns
Selected patterns can be dragged to move them.

b
4

If a TrueType font has not been selected for
the template, the [Select TrueType Font]
dialog box appears.

Editing Font Character
Patterns

■ Scaling patterns

■ Selecting patterns
1 Click the [Home] tab.
2

3

• To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.
• Pressing the arrow keys moves the selected
pattern one grid mark in the direction of the
arrow on the key. If the grid is not displayed, the
pattern moves a distance smaller than the
smallest grid interval in the direction of the arrow
on the key.

Drag a handle of the selected pattern to adjust its
size. Drag the rotation handle to rotate the pattern.

Click
in the [Tools] group to use the
[Select] tool.

b
• If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.
• Click [Flip] in the [Edit/Arrange] group, and
then select [Flip Vertically] to flip the selected
pattern(s) up/down.
Select [Flip Horizontally] to flip the selected
pattern(s) left/right.

Click the pattern.
1
2

• Using commands other than those mentioned
above, selected patterns can be edited in other
ways, for example, duplicated or deleted.
cc "Menus/Tools" of "Font Creator" on page 318.
1 Rotation handle
2 Handles
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Editing the Points of a Font Character Pattern

Editing the Points of a Font Character
Pattern
Editing points and
reshaping patterns

To Straight/To Curve
1

1

Click the [Home] tab.

2

Click [Select Point] in the [Tools] group.

3

Click the pattern.

4

To edit a point, click the point to select it.

2

Select the point(s).
Click [Point] in the [Edit/Arrange] group, and
then select the desired command from the list.

cc For details on the commands To Straight,
To Curve, To Smooth, To Symmetry and
To Cusp, "Transforming straight lines
into curves or curves into straight lines"
on page 70 and "Changing the curve
type" on page 70.

2

a
1
1 Unselected point
2 Selected point

• To move the point, drag it to the new
location.
• To insert a point, click the line to add a new
point.
 A new point appears selected (as a
small black square or circle).
• To delete the point, click
the <Delete> key.

or press
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These commands are not available with patterns
entered using the [Running] or [Feed] tools.

Checking the Created Font Patterns

Checking the Created Font Patterns
Checking and editing the
sewing order
1
2

Click the [Home] tab.
Click [Sewing Order] in the [Edit/Arrange]
group.

frame.

3

4

Select a pattern in the [Sewing Order] dialog
box.

The sewing order can be changed by
selecting the frame containing the pattern that
you want to move, then dragging the frame to
the new location. A vertical red line appears,
indicating the position where the frame is
being moved.

An alternative method for moving the frames is by
clicking the buttons at the bottom of the dialog box.

289

:

To move to the beginning of the
sewing order.

:

To move ahead one position in the
sewing order.

:

To move to the end of the sewing
order.

Previewing the embroidery
pattern
2

Click to enlarge each pattern to fill its

To move back one position in the
sewing order.

To change the sewing order, click [OK].

1

:

:

Click the [View] tab.
To switch between displaying and hiding the
[Preview Window], select or unselect the
[Preview Window] check box in the [View]
group.

Checking the Created Font Patterns

Checking and selecting
from the list of created
characters
A list of characters included in the font file currently
being edited can be viewed.

1
2

Click the [Home] tab.
Click [Browse Characters] in the
[Character] group.

Font Creator

To select a character, click the character, and then
click [Select].
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Saving Font Character Patterns

Saving Font Character Patterns
Overwriting

2

Select the [MyFont] folder at the following
location.

Click
, and then select [Save] from the
command list.

 If no file name has been specified or if the
file cannot be found, the [Save As] dialog
box appears.

a

a
If any part of the character pattern extends off the
Design Page, a message appears. Edit the
character pattern so that no part extends off the
Design Page, and then save it again.

Saving with a new name
The font character patterns are saved as .pef files.

1
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For example, (Drive where Palette was
installed)\Program Files (x86)\Baby lock\Palette
Ver.10\MyFont
And then type in the file name, then click [Save].

Click
, and then select [Save As] from the
command list.

• The font will not be usable in the Layout &
Editing if it's stored in a different folder.
• The created font is saved in the [MyFont] folder
at the following location.
• Saved files can be used in Layout & Editing.
cc "Creating an embroidery pattern using the
created font characters" on page 281
• If Layout & Editing has already started up when
a new character is saved in Font Creator, that
character will not appear in the [Font] selector
list in Layout & Editing. In this case, exit Layout
& Editing, and then start it up again.

Changing the Settings

Changing the Settings
Changing the drawing
mode
There are two drawing modes in Font Creator.

Scaling/Moving the
background image
Click [Modify Template] in the [Template] group.

• Fill mode
Blocks appear filled in. In this mode, the
overlapping positions of patterns can be
viewed better.
 The background image is selected.
The background image can be moved or
resized in the same way that font character
patterns are edited.
cc "Editing Font Character Patterns" on
page 287.

b
• Outline mode (Fill mode Off)
Blocks do not appear filled in. In this mode,
points can be edited more easily.

The background image cannot be scaled or moved
if a TrueType font is used as the template.

Font Creator

Perform the operation described below to switch
between these modes.
Click the [View] tab.
Click [Fill Mode] in the [View] group.
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Changing the Settings

Changing the grid settings
1

Click the [View] tab.

2

Specify the grid settings in the [Grid] group.
a

c

b
d

a

To display the grid, select the [Show
Grid] check box.

b

To display the grid as solid lines, select
the [with Axes] check box.

c

In the [Interval] box, select the grid
spacing.

d

To input the font in a uniform thickness or
match vertical and horizontal positions,
select the [Snap to Grid] check box.

b
The pointer will move by the amount set in
[Interval] box.
The snap feature works whether or not the grid is
displayed.
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This section provides hints and detailed
techniques for creating even more attractive
embroidery.

For Basic Operations

For Basic Operations
Enlarging/Reducing Stitch
Patterns
Imported stitch patterns can be enlarged or reduced
in Layout & Editing in the following three ways.
1

Stitch patterns can be simply enlarged/reduced.

2

Stitch patterns can be enlarged/reduced while
the <Ctrl> key is held down.

3

Using the [Convert to Blocks] tools, stitch
patterns can be enlarged/reduced after being
converted to a group of shape patterns with
multiple sewing direction lines.

With method 1, the stitching will become more
dense or light without the number of stitches sewn
changing. In other words, greatly enlarging or
reducing the pattern changes the quality of the
embroidery since the thread density is adjusted.
Use this method when only slightly enlarging/
reducing the stitch pattern.
With method 2, the size of the pattern is changed
while maintaining the thread density and needle
drop point pattern. However, if the original thread
density and needle drop point pattern in the stitch
pattern are not uniform, the thread density and
needle drop point pattern may not be maintained,
even by using this method. Enlarge/reduce the
pattern while checking the preview. Do not use this
method when only slightly enlarging/reducing the
stitch pattern.
With method 3, the thread density is maintained
while the pattern is enlarged/reduced. However, the
needle drop point pattern is not entirely maintained.
Use this method when you wish to change the
stitching or shape. Do not use this method when
only slightly enlarging/reducing the stitch pattern.

a
This software allows you to create a wide variety of
embroidery patterns and supports wider ranges for
the setting of the sewing attributes (thread density,
sewing pitch, etc.). However, the final result also
depends on your particular embroidery machine
model. We recommend that you make a trial
sewing sample with your sewing data before
sewing on the final material. Remember to sew
your trial sample on the same type of fabric as your
final material and to use the same needle and the
same machine embroidery thread.
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Sewing Direction
In order to limit pulling or puckering, select a stitch
direction perpendicular to the larger edge of the
area.

Pulling or puckering more likely to occur

Pulling or puckering less likely to occur

Sewing Order
After creating an embroidery pattern made of
several different parts (in Layout & Editing or Design
Center), be sure to check the sewing order and
correct it if necessary.
With Layout & Editing, the default sewing order is
the order in which the elements are drawn.
With Design Center, the default sewing order is the
order in which the sewing attributes are applied.
Be careful when changing the sewing order since
overlapping areas may be incorrectly positioned.

For Basic Operations

Sewing Wide Areas
• For best sewing results, set [Under sewing] to
[On] when sewing wide regions.
cc For more details, refer to "Under sewing"
on page 331.
• Changing the [Sewing Direction] setting
prevents pulling-in or puckering of the stitching.
• When embroidering, use stabilizer material
specifically for embroidering. Always use
stabilizer material when embroidering lightweight
or stretch fabrics, otherwise the needle may bend
or break, the stitching may pull and pucker, or the
pattern may become misaligned.
• When satin stitching is sewn in a wide area, the
stitched area may shrink after sewing, depending
on the material and the type of thread used. If this
happens, switch to this alternate method: Select
the fill stitch and use stabilizer material on the
reverse side of the fabric.

Pattern

Supplement

After sewing
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On Settings

On Settings
Jump Stitch and Jump
Stitch Trimming

If necessary, change settings for the
following.
• Automatically turning off trimming when the
jump stitch length is less than that
specified.

■ Machine thread trimming
according to settings specified in
Layout & Editing
If

cc "Jump Stitch Trimming" on page 87 and
"About Minimum jump stitch length for
thread trimming" on page 87

is selected in the [Design Settings] dialog

box of Layout & Editing, trimming can be turned on
or off at each jump stitch location.
These settings are saved in embroidery data files
(.pes).
If you are using our multi-needle embroidery
machine with the Jump Stitch Trimming function
turned on to embroider this imported .pes file, the
machine will trim the thread according to the PES
data settings.

• Default setting for turning on/off jump stitch
trimming when a new embroidery pattern is
created.
cc "Adding jump stitch trimming to new
patterns" on page 302
Stitching

Jump stitch

Stitching

a
For details on the jump stitch trimming function of
the machine, refer to the Operation Manual
provided with your embroidery machine.

■ Specifying trimming settings in
Layout & Editing
1

Select

in the [Design Settings] dialog

box.
cc "Specifying the Design Page Settings" on
page 14

2

Display the trimming locations in Layout &
Editing.
cc Memo of "Changing the display of the
embroidery design" on page 78

3

Turn on/off jump stitch trimming for each
embroidery pattern.
cc "Jump Stitch Trimming" on page 87
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a
These settings are applied only when
embroidering with our multi-needle embroidery
machines. These settings are not applied with any
other embroidery machine.

Changing Various Settings

Changing Various Settings
Customizing the window

■ Quick Access Toolbar commands

■ Quick Access Toolbar/Ribbon
A menu appears when
Toolbar] is clicked.

in the [Quick Access

The first time this application is started up, the
following commands appear in the Quick Access
Toolbar (A).

Click [More commands] to add or remove the
commands appearing in the list of the [Quick
Access Toolbar].
Click [Show Below the Ribbon] to move the
[Quick Access Toolbar] below the Ribbon. To
return it to its original position, display the menu as
described above, and then click [Show Above the
Ribbon].
If a check mark appears beside [Minimize the
Ribbon], the Ribbon is minimized. When a tab is
clicked, the Ribbon appears. After a command is
selected, the Ribbon is minimized again. To restore
it to its original display, clear the check mark.
Example: With [Show Below the Ribbon] selected
and a check mark beside [Minimize the Ribbon]

: New

: Undo

: Open

: Redo

: Save

: Wizard

: Zoom in
Click , then select or unselect the check boxes
beside the commands to switch between displaying
and hiding them. When the check mark is cleared,
the command is hidden. Alternatively, changes to
the commands listed in the [Quick Access
Toolbar] can be specified in the [Options] dialog
box and all applied at the same time.

■ Import/Color/Sewing Attributes/
Text Attributes pane, Sewing
Order pane and Stitch Simulator
pane
Floating
Each tab or the entire pane can be undocked to
become a dialog box that can be moved around the
screen.
• Double-click the title bar of the pane, or tab.
• Right-click the pane or tab, and then click
[Floating].
• Drag a tab out of the pane.
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cc "Customizing Quick Access Toolbar" on
page 300

Changing Various Settings
■ Using access keys

Docking
Each pane can be docked back to the window.
• Double-click the title bar.
• Right-click the pane, and then click [Docking].
• Drag the title bar to the location where the pane
will be docked.

When the <Alt> key is pressed, a KeyTip (label
showing the letter of the access key) appears on
each command. On the keyboard, press the key
corresponding to the command that you wish to use.

Hide
When a tab or a pane is no longer needed, it can be
hidden.
• Click
box.

in the upper-right corner of the dialog

• Right-click the tab or dialog box, and then click
[Hide].

To stop using the access keys and hide the
KeyTips, press the <Alt> key.

• To hide the tab, click [View] tab in the Ribbon,
and then click the name in the [View] tab. To
display the tab again, perform the same
operation.
Auto Hide
When a pane is temporarily not needed, it
can be moved to the side bar, then
displayed by clicking it or positioning the
pointer over it. The pane is automatically
hidden again when it is no longer being
used, for example, when you click
anywhere outside of the pane.
• Right-click the tab or the title bar of the pane, and
then click [Auto Hide].
• In the upper-right corner of the pane, click

.

To cancel Auto Hide, right-click the title bar, and
then click [Auto Hide], or simply click
bar.

in the title

b
• The Stitch Simulator pane cannot be temporarily
hidden (Auto Hide).
• These panes can be returned to their default
displays.
cc "Customizing Shortcut keys" on page 301
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Changing options settings
From the [Options] dialog box, the commands
appearing in the [Quick Access Toolbar] and
settings for the application's appearance can be
selected, and also the settings on shortcut keys,
jump stitches, thread charts can be specified or
changed. Follow the procedure described below to
display the [Options] dialog box.
Click
, and then click [Options] on the bottom of
the window.

1

Click [Customize].
a

c

A
e

b

f

g

2

d

Repeat the following operations until the
desired commands are displayed.
a

Choose commands from selector
Select a command category.

b

Commands list
Select the command to be added.

c

Add button
Selected command is added.
The command appears in A.

d

Remove button
Selected command is removed.
The command is removed from A.

e

Select an icon in A, and then click the
buttons at to move it to the desired
position.

b
The [Options] dialog box can also be displayed
using either of the following methods.

f

Reset button
Reverting to the default commands.

Settings for the following can also be specified
from this dialog box.
g

■ Customizing Quick Access
Toolbar
3

Show Quick Access Toolbar Below the
Ribbon
Select where the Quick Access Toolbar is
displayed. Select the check box to display
the Quick Access Toolbar below the
Ribbon.

After the settings have been specified, click
[OK] to apply them.

1
1 Quick Access Toolbar
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• Click
at the right end of the Quick Access
Toolbar, and then click [More Commands].
• Click [Option] in the upper-right corner of the
window, and then click [Options].

Changing Various Settings
■ Customizing Shortcut keys
1 Click [Customize] in the command list, then
[Customize] beside [Keyboard shortcuts].

5

Click [OK] in the [Options] dialog box.

■ Editing user thread charts
For detailed instructions, see "Editing user thread
color lists" on page 192.

■ Specifying the number of jumps in
embroidery design of the DST
format
With the DST format, you can specify whether or not
the jump stitches are trimmed according to the
number of jump codes. The number of codes differs
depending on the embroidery machine being used.

2

In the [Categories] list, select a command
category. Then, in the [Commands] list,
select the command whose shortcut keys are
to be specified.

a

Click [DST Settings] in the command list, specify
the number of jumps, and then click [OK].
To specify a setting for importing, enter a value
beside [DST Import Setting]. To specify a setting
for exporting, enter a value beside [DST Export
Setting].

b

c

d

e
f

 The default shortcut keys appear in the
[Current Keys] box a.

3

Use the keyboard to record the new shortcut
keys in the [Press new shortcut key] b box,
and then click [Assign] d. The new shortcut
keys appear in the [Current Keys] box a.
 Usage information about the entered key
combination appears. If the key
combination has already been assigned to
another command, the name of that
command appears at c.
To remove the default or specified shortcut
keys, select the shortcut keys in a, and then
click [Remove] e.
To revert to the default settings, click [Reset
All] f.

4
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Repeat steps 2 and 3 until the desired shortcut
keys have been specified for the commands,
and then click [Close].

DST Import Setting
If the number of consecutive jumps in the DST
file is less than the number of jumps specified
here, those consecutive jumps will be
replaced with a stitch.
If the number of consecutive jumps in the DST
file is greater than or equal to the number of
jumps specified here, those jumps will be
replaced with a jump stitch where the thread is
trimmed.
DST Export Setting
When .pes files are output, jump stitches with
thread trimming are replaced with more
consecutive jump codes than the specified
number of jumps.

Changing Various Settings
■ Adding jump stitch trimming to
new patterns
When creating a new embroidery pattern for our
multi-needle embroidery machines, you can specify
whether or not to add jump stitch trimming to the
pattern.

■ Changing the system unit
For detailed instructions, see "System unit" on
page 20.

■ Adjusting the screen calibration
For detailed instructions, see "Adjusting on-screen
measurements (Screen Calibration)" on page 19

a
These settings are applied only when
embroidering with our multi-needle embroidery
machines. Before these settings can be specified,
select
under [Machine Type] in the
[Design Settings] dialog box.
Click [Jump Stitch Trimming] in the command list,
select the [Add jump stitch trimming to the
entered patterns.] check box, and then click [OK].

When the check box is selected, scissors
icon appear beside the frames to indicate
jump stitch trimmings are applied.

■ Customizing User Interface
Settings
The color scheme of the applications can be
selected.
Click [User Interface Settings] in the command list,
select the desired color scheme from [Application
Color], and then click [OK].

With the [Show Status Bar] check box, select
whether to display or hide the status bar. To display
the status bar, select the check box.

1

1 Scissors icon
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If the [Reset Pane Position] button is clicked, the
docked panes ([Import]/[Color]/[Sewing
Attributes]/[Text Attributes] panes, [Sewing
Order] pane and [Stitch Simulator] pane) return to
their default displays after the application is
restarted.

For Making an Effective Use of This Application

For Making an Effective Use of This
Application
Converting Characters
(Japanese, Chinese,
Korean, etc) to Embroidery
Patterns

7

Paste the characters into the text field in the
[Text Attributes] pane, and then press the
<Enter> key.

Embroidery patterns can be created from various
characters, such as Japanese, Chinese, Korean
etc, using TrueType fonts.
For this example, we will create an embroidery
pattern from Japanese characters.

1
2
3

4

Start up Layout & Editing.
Select a Text tool, and then select a Japanese
TrueType font (for example, "MS Gothic").
Display a character code table different from
the one that appeared in step 2. ([Start] – [All
Programs] – [Accessories] – [System
Tools] – [Character Map])
Select [MS Gothic] from the [Font] list in
[Character Map], and then select the
[Advanced view] check box. Next, select
[Windows]: [Japanese] from the [Character
set] list, select the desired character, and then
click [Select].
(This example shows the Japanese hiragana
for the word meaning "Good Afternoon".)

b
If Japanese or Korean can be entered directly from
the computer keyboard, those characters can be
entered directly into the [Edit Text Letters] dialog
box.

Fonts Suitable for
Embroidering
■ When converting TrueType fonts
to embroidery patterns
For best results when converting TrueType fonts to
embroidery patterns, select a font where all lines are
as thick as possible, such as with a Block font.

5
6

303

After selecting all of the desired characters,
click [Copy] to copy the characters.
Click in the Design Page where you want to
enter the text.

For Making an Effective Use of This Application

Displaying the embroidery
designs in PES format as
thumbnails
Embroidery files in PES format can be viewed as
thumbnails with Explorer (Windows® Explorer in
Windows® 7 and File Explorer in Windows® 8.1). It
helps you to manage embroidery designs more
easily.

To display information on embroidery files, click
.
To display embroidery files by using thumbnails,
click

.
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Menus/Tools and Reference

This section lists the various Ribbon commands
and tools in each application window. For details
on each command and tool, refer to the
corresponding page in this manual.
This section also contains font samples and
information on the various sewing attributes.

Layout & Editing

Layout & Editing
Application button menu
No.

Menu

Reference

1

1

New

p. 90

2

2

Open

p. 90

3

3

Save

p. 95

4

4

Save As

p. 95

5

5

Print

p. 96

6

Design Property

p. 88

7

Design Settings

p. 14

8

Fabric Selector

p. 17

6
7
8

9

Wizard

p. 10

9

10

Export

p. 95

0

Ribbon menu tabs
■ Home tab
2

5

13
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No.

0A B

7
Menu

8

9

C

D

J

G

E

FH

Reference

No.

p. 31

13

I

KL
Menu

M
Reference

1

Select Tools

2

Cut

—

3

Copy

—

4

Paste

p. 55

16

Arrange

p. 32

5

Duplicate

—

17

Emboss/Engrave

p. 57

6

Arrange Copy Tools

7

Delete

Pan

p. 77

14

Measure

p. 78

15

Import Patterns

p. 91

p. 35

18

Modify Overlap

p. 40

—

19

Group

p. 39

8

Text Tools

p. 106

20

Applique Wizard

p. 161

9

Shapes Tools

p. 60

21

Embroidered Patch Wizard

p. 167

10

Zoom in

p. 77

22

Cutwork Wizard

p. 170

11

Zoon out

p. 77

23

Sew Embroidery

p. 201

12

Other Zoom Tools

p. 77
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Layout & Editing
■ Image tab
2

5

13

4

6

No.

7

8

9

Menu

0

A

B

Reference

No.

p. 150

7

Menu

Reference

1

Open Image

Delete Image

p. 153

2

Save Image

p. 153

3

Modify Image

p. 152

8

Auto Punch Wizard

p. 132

9

Cross Stitch Wizard

p. 135

4

Background Image Density

p. 152

10

Photo Stitch 1 Wizard

p. 139

5

Rotate Right

p. 153

11

Photo Stitch 2 Wizard

p. 144

6

Rotate Left

p. 153

12

Import to Design Center

p. 149

■ View tab
4

1

2

8

3 5

No.

6
Menu

79
Reference

D

A

0

B

E

C

No.

F
Menu

Reference

Solid View

p. 78

9

Import Pane

p. 13

2

Stitch View

p. 78

10

Reference Window

p. 81

3

Realistic View

p. 79

11

Show Grid

p. 18

4

View Thread Trimming

p. 79

12

Show Grid with Axes

p. 18

5

Realistic View Settings

p. 79

13

Snap to Grid

p. 18

6

Sewing Order

p. 82

14

Grid Spacing

p. 18

7

Stitch Simulator

p. 80

15

Ruler

p. 18

8

Attributes Setting

p. 29

16

Guideline

p. 19
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1

Layout & Editing
■ Text tab (Text)
3

1

24

No.

5 6

7

Menu

8

9

C

0

A

BD

Reference

No.

p. 31

9

1

Select Tools

2

Text Tools

p. 106

3

Font

p. 107

E
Menu

Reference

Text Outline Sew Type

p. 117

10

Region color

p. 117

11

Text Body Sew Type

p. 117

4

Text Size

p. 109

12

Edit Text

p. 107

5

Font Filter

p. 108

13

Convert to Blocks

p. 115

6

Font Filter Settings

p. 108

14

Convert to Stitches

p. 71

7

TrueType Font Attribute Setting

p. 110

15

Convert to Outline

p. 116

8

Line color

p. 117

■ Outline tab (Shapes (Outline))

1

234 8

9

567 0

A

No.

Menu

Reference

No.

Menu

Reference

1

Select Tools

p. 31

7

Pencil (Open Curve)

p. 63

2

Closed Straight Line

p. 63

8

Line color

p. 65

3

Closed Curve

p. 63

9

Line sew type

p. 65

4

Pencil (Closed Curve)

p. 63

10

Region color

p. 65

5

Open Straight Line

p. 63

11

Region sew type

p. 65

6

Open Curve

p. 63
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Layout & Editing
■ Outline tab (Shapes (Rectangle))

1

2

No.

3

4

5

6

Menu

Reference

No.

1

Select Tools

p. 31

4

2

Edge radius

p. 61

3

Line color

p. 65

Menu

Reference

Line sew type

p. 65

5

Region color

p. 65

6

Region sew type

p. 65

■ Manual Punch tab (Shapes (Manual Punch))
2

13

4

No.

5

6

No.

Menu

Reference

Select Tools

p. 31

5

Feed

p. 197

2

Straight Block

p. 197

6

Region color

p. 65

3

Curved Block

p. 197

7

Block sew type

p. 65

4

Running

p. 197

Menus/Tools and Reference

Reference

1

Menu

7
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Layout & Editing
■ Shapes tab (Shapes (Shapes/Circle/Arc))
3

1

6

24

5

No.

7

8

0

C

A

B

D

E

Reference

No.

Select Tools

p. 31

9

Line color

2

Split Outline

p. 42

10

Line sew type

p. 65

3

Add Direction Line

p. 52

11

Region color

p. 65

4

Delete Direction Line

p. 53

12

Region sew type

p. 65

5

Reverse Direction Line

p. 53

13

Convert to Stitches

p. 71

1

Menu

9

Menu

Reference
p. 65

6

Edit Point

p. 70

14

Create Offset Lines

p. 44

7

Delete Point

p. 67

15

Create Floral Pattern

p. 42

8

Split at Point

p. 67

Reference

No.

Menu

■ Stitches tab (Stitches)

1

2

3

No.

4
Menu

5

6

7
Reference

1

Select Tools

p. 31

5

Split at Point

2

Split Stitch Data

p. 74

6

Convert to Blocks

p. 75

3

Change Color

p. 71

7

Convert to Outline

p. 76

4

Divide by Color

p. 75
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p. 73

Design Center

Design Center
Application button menu
No.

Menu

Reference

1

1

Wizard

p. 222

2

2

New Line Image

p. 225

3

3

New Figure Data

p. 227

4

4

Open

p. 223

5

Save

p. 237

6

Save As

p. 237

5
6

Ribbon menu tabs
■ Original Image tab

1

2

No.
1

Menu
Open Image

No.

—

2

Reference

No.

Menu
To Line image

Reference
p. 224

■ Line Image tab

1

2

3

No.

4
Menu

5

6
Menu

Reference

1

Pen Tools

p. 213

4

Pan Tool

p. 214

2

Eraser Tools

p. 213

5

To Original image

p. 222

3

Zoom Tools

p. 214

6

To Figure handle

p. 227
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Reference

Design Center
■ Figure Handle tab
6

1

2

3

4

No.

5 7

9

8

B

0

Menu

AC

D

Reference

No.

p. 214

10

E

F

G
Menu

Delete

H
Reference

1

Select Tools

p. 216

2

Edit Point Tool

p. 215

11

Split at Point

p. 216

3

Line Tool

p. 215

12

Flip vertically

p. 228

4

Zoom Tools

—

13

Flip horizontally

p. 228

5

Pan Tool

—

14

Numerical Setting

p. 228

6

Cut

—

15

Import Figure

p. 227

7

Copy

—

16

Design Page Settings

p. 227

8

Paste

—

17

To Line image

p. 224

9

Duplicate

—

18

To Sew setting

p. 217

Reference

No.

p. 228

4

Show Grid

p. 230

■ View tab
2

4

1
No.

3
Menu

5

6
Menu

Reference

1

Reference Window

2

Modify Template

p. 230

5

Show Grid with Axes

p. 230

3

Background Image Density

p. 230

6

Grid Interval

p. 230

313

Design Center
■ Sew Setting tab

1

2

3

No.

4

5

Menu

6

7

8
Reference

9

0

A

No.

B
Menu

C

D
Reference

1

Region Tool

p. 231

8

Sew Type

p. 232

2

Line Tools

p. 232

9

Sewing Order

p. 236

3

Hole Sew Tool

p. 235

10

Preview

—

4

Stamp Tools

p. 236

11

Realistic Preview

—

5

Zoom Tools

—

12

Stitch Simulator

p. 237

6

Pan Tool

—

13

To Figure handle

p. 226

7

Color

p. 232

14

To Layout & Editing

p. 220

Reference

No.

p. 228

2

■ View tab

1
No.
1

2
Menu
Reference Window

Menu
Sewing Attributes

Reference
p. 233
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Design Database

Design Database
List of menus
■ File menu
Menu

Toolbar

Reference

Open in Layout & Editing

—

p. 245

Import Into Layout &
Editing

—

Create New Folder

Menu

Toolbar

Reference

Print Setup

—

p. 255

p. 245

Print Preview

—

—

—

p. 243

Print

—

p. 255

Convert Format

—

p. 252

Create HTML

—

p. 256

Delete

—

p. 244

Create CSV

—

p. 256

Search

—

p. 251

Exit

—

—

Toolbar

Reference

Toolbar

Reference

■ Edit menu
Menu
Cut

Menu
Paste

p. 243

p. 243
Copy

Select All

—

—

Toolbar

Reference

■ Display menu
Menu

Toolbar

Reference

Large Thumbnails

Small Thumbnails

Property

p. 244

Details

Preview
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Menu

p. 253

p. 253

Refresh

—

—

Toolbar

—

p. 241

Status Bar

—

—

Design Database
■ Option menu
Menu

Toolbar

Reference

—

p. 20

Link

—

p. 250

DST Settings

—

p. 301

Toolbar

Reference

Instruction Manual

—

p. 4

Customer Support

—

p. 5

Select
System Unit

mm
inch

Menu

Toolbar

Reference

—

p. 302

Toolbar

Reference

—

—

Blue
Application
Color

Black
Silver
Aqua

■ Help menu
Menu

Menu
About Design Database

Menus/Tools and Reference
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Programmable Stitch Creator

Programmable Stitch Creator
Application button menu
No.
1

Menu

Reference

1

New Fill/Stamp Pattern

2

2

New Motif Pattern

—

3

3

Open

p. 260

4

4

Save

p. 272

5

5

Save As

p. 272

p. 266

Ribbon menu tabs
■ Home tab
7

1

2

3

No.
1

4

5

6 8

Menu
Select Tool

B

0

9

A

C

Reference

No.

p. 264

8

Menu
Copy

Reference
—

2

Edit Point Tool

p. 264

9

Paste

—

3

Draw Line Tool

p. 261

10

Duplicate

—

4

Region (Reset) Tool

p. 262

11

Delete

p. 269

5

Region (Engrave) Tool

p. 262

12

Flip vertically

p. 264

6

Region (Emboss) Tool

p. 262

13

Flip horizontally

p. 264

7

Cut

—

■ View tab

1
No.

2

3

4
Menu

5
Reference

No.

p. 271

4

Show/Hide Status Bar

p. 270

5

Show Grid

p. 273

1

Open Template

2

Background Image Density

p. 271

3

Show/Hide Preview window

p. 272
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Font Creator

Font Creator
Application button menu
No.

Menu

Reference

1

1

New

p. 284

2

2

Open

p. 284

3

Save

p. 291

4

Save As

p. 291

3
4

Ribbon menu tabs
■ Home tab
6

1

2

3

No.

4
Menu

57

9

8

A

0

D

BC

E

H

F

Reference

No.

p. 287

11

G

I

J

Menu
Previous Character

Reference

Select Object Tool

p. 285

2

Edit Point Tool

p. 288

12

Select Character

p. 285

3

Manual Punch Tool

p. 277

13

Next Character

p. 285

4

Zoom Tool

—

14

Browse Characters

p. 290

5

Pan Tool

—

15

Add/Remove Character

p. 285

6

Cut

—

16

Sewing Order

p. 289

7

Copy

—

17

Convert TrueType Font to Data

p. 287

8

Paste

—

18

Point Edit

p. 288

9

Duplicate

—

19

Flip

p. 287

10

Delete

p. 288

20

Align

—
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1

Font Creator
■ View tab
2

1
No.

5

3

4

7

6

Menu

8

9

0

Reference

No.

Menu

Reference

1

Open Template

p. 275

6

Show/Hide Status Bar

p. 282

2

Modify Template

p. 292

7

Show Grid

p. 293

3

Background Image Density

p. 292

8

Show Grid with Axes

p. 293

4

Fill Mode

p. 292

9

Snap to Grid

p. 293

5

Preview Window

p. 289

10

Grid Spacing

p. 293

319

Sewing Attributes

Sewing Attributes
The sewing attributes for each sew type are first set to their default settings; however, by changing the settings
of the sewing attributes, you can create custom stitching.
cc For more details, refer to "Line sewing attributes" on page 325 and "Region sewing attributes" on
page 331.

Line sew types
Running Stitch/Triple Stitch (cc p. 325)

Motif Stitch (cc p. 326)

Stem Stitch (cc p. 327)

Candlewicking Stitch (cc p. 327)

E/V Stitch (cc p. 328)

Chain Stitch (cc p. 329)

Cutting (cc p. 329)

Menus/Tools and Reference

Zigzag Stitch (cc p. 325)
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Region sew types
Satin Stitch (cc p. 331)

Fill Stitch (cc p. 333)

Programmable Fill Stitch (Prog. Fill Stitch)
(cc p. 333)

Piping Stitch (cc p. 336)

Motif Stitch (cc p. 337)

Cross Stitch (cc p. 338)

Concentric Circle Stitch (cc p. 338)

Radial Stitch (cc p. 338)

Spiral Stitch (cc p. 338)

Stippling Stitch (cc p. 338)

Net Fill Stitch (cc p. 339)

Zigzag Net Fill Stitch (cc p. 339)
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Motif Stitch Pattern
Motif
Name

Pattern

Motif
Name

Motif
Name
Pattern

Pattern

Motif
Name

motif039

motif059

motif040

motif060

motif041

motif061

motif020

motif002

motif021

motif003

motif022

motif042

motif062

motif004

motif023

motif043

motif063

motif005

motif024

motif044

motif064

motif006

motif025

motif045

motif065

motif007

motif026

motif046

motif066

motif008

motif027

motif047

motif067

motif009

motif028

motif048

motif068

motif010

motif029

motif049

motif069

motif011

motif030

motif050

motif070

motif012

motif031

motif051

motif071

motif013

motif032

motif052

motif072

motif014

motif033

motif053

motif073

motif015

motif034

motif054

motif074

motif016

motif035

motif055

motif075

motif017

motif036

motif056

motif076

motif018

motif037

motif057

motif077

motif019

motif038

motif058

motif078

Menus/Tools and Reference

motif001

Pattern
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Motif
Name

Pattern

motif079

Motif
Name

Pattern

Fill
Pattern
Name

Pattern

Fill
Pattern
Name

motif085

motif080

stamp2_

stampJ

stamp3

stampK

stamp3_

stampL

stamp4

stampM

stamp4_

stampN

stamp5

stampO

stamp5_

stampP

stamp6

stampQ

stamp6_

stampR

stamp7

stampS

stamp7_

stampT

stampA

stampU

stampB

stampV

stampC

stampW

stampD

stampX

stampE

stampY

stampF

stampZ

stampG

tatami1

stampH

tatami2

stampI

tatami3

motif086

motif081

motif087

motif082

motif088

motif083

motif089

motif084

Prog. Fill Stitch Pattern
Fill
Pattern
Name
net1

Pattern

Fill
Pattern
Name
pat9

net2

pat10

net3

pat11

net4

pat12

pat1

pat13

pat2

pat14

pat3

pat15

pat4

pat16

pat5

pat17

pat6

stamp1

pat7

stamp1_

pat8
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Pattern

stamp2

Pattern

Sewing Attributes

Fill
Pattern
Name

Pattern

Fill
Pattern
Name

tatami4

wave2

tatami5

wave3

wave1

wave4

Pattern

Menus/Tools and Reference
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Sewing Attributes
■ Line sewing attributes
The available attributes differ depending on the selected sew type.
cc "Specifying sewing attributes" on page 54

Zigzag Stitch
Off

On

Narrow

Wide

Coarse

Fine

Off

On

Under sewing

Zigzag width

Density

Half Stitch
The inside stitching is dense.

The stitching is adjusted to a
more even density.

Sharp Corners
Connection
Points

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Running Stitch
Run pitch

Specify the length of one stitch.

Run time(s)

Specify the number of times the outline is sewn.

Connection
Points

Short

Long

1 time

5 times

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Triple Stitch
Short
Run pitch

Specify the length of one stitch.

Connection
Points

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116
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Long

Sewing Attributes
Motif Stitch
Select a pattern for the motif stitch.
Click

to display the [Browse] dialog box. Select a folder, and then select the desired pattern

(.pmf file) from the list of patterns that appears.
Specify the pattern size. The pattern can be
enlarged or reduced while maintaining the width-toheight proportion.
1

2

1 Height
(vertical length)

Specify the pattern height.

2 Width
(horizontal
length)

Specify the pattern width.

Smaller

Larger

Short

Tall

Short

Long

Maintain aspect
ratio

When selected, the height-to-width proportions of the pattern are maintained.

H-Arrange
(horizontal
arrangement)

Specify the arrangement of the patterns along a
horizontal axis.
All patterns or each pattern can be flipped along the
horizontal axis.

Normal
Mirror
Alternate

Normal
V-Arrange
(vertical
arrangement)

Specify the arrangement of the patterns along a
vertical axis.
All patterns or each pattern can be flipped along the
vertical axis.

Mirror
Alternate

0.0 mm

Offset: 4.5mm

Spacing

Narrow

Wide

Run pitch

Specify the length of one stitch.

Short

Feed

Menus/Tools and Reference

Offset

Long

Run

Start/End Type
cc
Connection
Points

"If the entry/exit points of sewing have been changed" on page 330

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116
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Sewing Attributes
Stem Stitch
Width

Spacing

Angle

Stitch Type

Narrow

Wide

Narrow

Wide

45°

135°

Triple

Single

Feed

Run

Start/End Type
cc
Connection
Points

"If the entry/exit points of sewing have been changed" on page 330

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Candlewicking Stitch
Density

Size

Spacing

Dense

Medium

Light

Smaller

Larger

Narrow

Wide

Feed

Run

Start/End Type
cc
Connection
Points
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"If the entry/exit points of sewing have been changed" on page 330

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Sewing Attributes
E/V Stitch

Select the E Stitch or the V Stitch.
E Stitch
1

2

Narrow

Wide

Short

Long

Narrow

Wide

1 time

5 times

1 time

3 times

1 Interval

2 Stroke width
3
3 Run pitch

Run time(s)

Specify the number of times the line
is sewn.

Stroke time(s)

Specify the number of times each
stroke is sewn.

Arrange

Connection Points

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

V Stitch
2

Narrow

Wide

Short

Long

Narrow

Wide

1 time

5 times

Menus/Tools and Reference

1

1 Interval

2 Stroke width
3
3 Run pitch

Run time(s)

With the V stitch, the line and the
strokes are sewn the same number
of times.

Arrange

Connection Points

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116
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Sewing Attributes
Chain Stitch
Stitch Type

Size

Time

Triangular

Diamond-shaped

Smaller

Larger

1 time

6 time

Feed

Run

Arrange

Start/End Type
cc
Connection
Points

"If the entry/exit points of sewing have been changed" on page 330

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Cutting

Leave uncut
sections

Specify whether or not sections of the cutting
line are to be left uncut.
This prevents the fabric from moving out of
place during cutting.
If it is set to [On], cut them with scissors after
the cutting step is finished.

Use

For more cleanly cut edges, for example, on
patches, select [Cutting only]. If the cut edge
will be embroidered, for example, on appliqués,
select [Cutting for covering edge of fabric].
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Off

On

Cutting only

Cutting for covering
edge of fabric

Sewing Attributes
■ If the entry/exit points of sewing have been changed
If the entry/exit points of line sewing with the motif stitch, stem stitch, candlewicking stitch or chain stitch have
been changed or optimized, select a setting for [Start/End Type] in the line sewing attributes.
cc "Start/End Type" on page 326 and "Moving entry/exit points, the center point and stitch pattern
reference point" on page 50
If [Feed] was selected under [Start/End Type], jump stitches are entered at the beginning or end of pattern
stitching (with a motif stitch, stem stitch, candlewicking stitch or chain stitch). If [Run] was selected under
[Start/End Type], running stitches following the path are entered at the beginning of and between pattern
stitching.

Before the entry/exit points are changed

Path of actual stitching

Entry point/Exit point

When the entry point is moved

Feed

Entry point
Jump stitch

Menus/Tools and Reference

Exit point

Run

Entry point
Running stitch

Exit point

a
• After changing the Start/End Type, check the stitching with the stitch simulator.
cc "Checking the stitching with the Stitch Simulator" on page 80
• Embroidery patterns where the Start/End Type of line sewing with the motif stitch, have been changed or
optimized in an application earlier than version 8 are opened or imported with this stitching specified as
jump stitches.
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Sewing Attributes
■ Region sewing attributes
The available attributes differ depending on the selected sew type.
cc "Specifying sewing attributes" on page 54

Satin Stitch
To specify underlay stitching, select the check box, and then specify settings for the following attributes.
Specify the type of underlay stitching to be sewn.
• For text patterns or for shape patterns with
multiple sewing direction lines

Under
sewing

• For shape patterns with a single sewing direction
line

Edge only

Single

Region only (single layer of zigzag
shaped stitches)

Double

Region only (single layer of piping
stitches)

• For regions in Design Center

Edge and region (single layer of
zigzag shaped stitches)

Single

Region only (double layer of zigzag
shaped and piping stitches)

Double

[Density]
Select [Dense], [Medium] or [Light] as the density for the underlay stitching.

Density

[Gradation]
This cannot be specified under the following
conditions.
• The sewing direction is set to [Variable]
• Text pattern
• When a feathered edge is specified
Click [Pattern] to set the gradation pattern.
cc "Creating a gradation/blending" on page 47
This cannot be specified for text pattern.
[Manual]: Sews at a fixed angle.

Direction

Coarse

Fine

Off

On

[Manual]

Drag
or select a value to specify the angle. If
there are multiple sewing direction lines, a value
cannot be specified for the angle.
[Auto]
[Auto]: Automatically varies the sewing direction
according to the shape of the region.
Off

Half Stitch
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To specify half stitching, select the check box.
This cannot be specified if the sewing direction is
set to [Manual] and there is only one sewing
direction line.

The inside stitching is
dense.

On

The stitching is
adjusted to a more
even density.

Sewing Attributes

Inside of region

Running
Stitch Path

The inside of region setting is not available if the
[Gradation] check box is selected.
This cannot be specified under the following
conditions.
• The sewing direction is set to [Auto].
• Text patterns
• When a feathered edge is specified

Along outline

On outline
No compensation
Pull compensation

Lengthen the sewing region in the sewing direction
to adjust for pattern shrinkage during sewing.

Connection
Points

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116

Longest compensation

Specify the edge
of the stitching
where the
feathered edge is
to be applied.
Top side of pattern
For <pattern11>

Top edge only

Bottom edge only

to display the [Browse] dialog box.

Bottom side of pattern
For <pattern18>
Top and bottom edges

Select the desired pattern from the list of patterns
that appears.
This sewing attribute is available only when a
shape pattern is selected. In addition, this attribute cannot be selected under the following conditions.
• When a gradation is specified
• When the sewing direction is set to [Auto]
• When hole sewing is specified
Short

Long

Specify the width of the
feathered edge

Feathered edge settings not specified

Feathered edge settings specified
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Feathered
edge

Click

Sewing Attributes
Fill Stitch
Under
sewing
Density

cc

"Satin Stitch" on page 331

Direction

Stitch Type

Specify the shape of the returning ends of the stitching.
This cannot be specified if the sewing direction is set to
[Auto].

Half Stitch
Running
Stitch Path

Step pitch

cc

"Half Stitch" on page 331 and "Running Stitch Path" on page 332
Short

Long

0%

50%

Specify the length of one stitch.

Frequency

Pull compensation
Connection
Points
Feathered
Edge

cc

"Pull compensation" on page 332

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116
cc

"Feathered edge" on page 332

Programmable Fill Stitch (Prog. Fill Stitch)
Under sewing
Density
Direction
Half Stitch

cc

"Region sewing attributes" on page 331 and 332

Running Stitch Path
Pull compensation
Connection Points
Feathered Edge

This sewing attribute is available only when a text pattern is selected.
cc "Selecting connection point positions in a text pattern" on page 116
cc

"Feathered edge" on page 332

b
cc "Satin Stitch" in the "Region sewing attributes" on page 331
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Sewing Attributes

Programmable fill
Click

to display the [Browse] dialog box. Select a folder, and then select the desired

pattern (.pas file) from the list of patterns that appears.
Specify the pattern size. The pattern can
be enlarged or reduced while maintaining
the width-to-height proportion.
1

2

Maintain aspect ratio

1 Height
(vertical
length)

Specify the pattern
height.

2 Width
(horizontal
length)

Specify the pattern
width.

Larger

Short

Tall

Short

Long

When selected, the height-to-width proportions of the pattern are maintained.
135°

Direction

90°

45°

180°
225°

Offset

Smaller

row

0%

column

Row 50%

Base Sewing

0°
270°

315°

Column 50%

To specify base stitching, select the check box, and then specify settings for the following
attributes.

Step pitch

Specify the length of one stitch.

Short

0%

Menus/Tools and Reference

Stitch Type

Specify the shape of the returning ends
of the stitching.
This cannot be specified if the sewing
direction is set to [Auto].
Long

50%

Frequency

Pattern

Area where the embossing or
engraving effects are applied

This area is sewn with the stitching settings
specified for the base sewing of the
programmable fill stitch.

This area is sewn with the stitching settings
specified by the pattern file.
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Sewing Attributes
Notes on programmable fill stitches and stamps
In some case of the sew type and pattern directions setting of a programmable fill stitch or a stamp, lines will
not be sewn.
Use the Realistic View to view exactly how the stitch pattern will be sewn. To get an even better view, make
test samples of different settings.
Examples of programmable fill stitching:

Example 1
Stitch direction: 45° (default)

Example 2
Stitch direction: 90°

Example 3
Stitch direction: 0°

cc "Changing the display of the embroidery design" on page 78, and "Programmable Stitch Creator"
on page 258
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Sewing Attributes
Piping Stitch
Stitching is created to run through the length of blocks.
135°

This cannot be specified for patterns
with multiple sewing direction lines.

Direction

90°

180°
225°

45°
0°

270°

315°

Specify settings for the following if the motif stitch pattern is not used.
Coarse

Fine

Density

Run pitch

Frequency

Use Motif

Short

Long

0%

50%

Specify the length of one stitch.

Specify the shift in the stitches.

To use a motif stitch in the pattern, select the check box, and then specify settings for
the following attributes.

Motif
cc

"Motif Stitch" in the "Region sewing attributes" on page 337

cc

"Motif Stitch" in the "Line sewing attributes" on page 326

cc

"Motif Stitch" in the "Region sewing attributes" on page 337

Pattern1/Pattern2
Pattern and size of the
motif stitch patterns
H-Arrange
V-Arrange

Menus/Tools and Reference

H-Offset
V-Offset
H-Spacing
V-Spacing
Row offset
Run pitch
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Sewing Attributes
Motif Stitch
Motif

[Pattern1 only]
Select the pattern to be used for the motif stitch.

[Pattern1 and 2]

Pattern1/Pattern2
Pattern and size of
the motif stitch
patterns Maintain
aspect ratio

Specify settings for each pattern.

cc

"Motif Stitch" in the "Line sewing attributes" on page 326

H-Arrange
V-Arrange
H-Offset
(horizontal spacing)

0.0 mm

2.5 mm

0.0 mm

2.5 mm

Narrow

Wide

Narrow

Wide

V-Offset
(vertical spacing)

H-Spacing
(horizontal spacing)

V-Spacing
(vertical spacing)

135°
Direction

90°

180°
225°
Smaller

45°
0°

270°

315°

Larger

Row offset

Run pitch
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cc

"Motif Stitch" in the "Line sewing attributes" on page 326

[Pattern2 only]

Sewing Attributes
Cross Stitch
Smaller

Larger

Single

Triple

Size

Times

Concentric Circle Stitch, Radial Stitch and Spiral Stitch
For details on moving the center point of the concentric circle stitch and the radial stitch, refer to "Moving the
center point and stitch pattern reference point" on page 51.
Concentric Circle Stitch Coarse

Concentric Circle Stitch Fine

Radial Stitch Coarse

Radial Stitch Fine

Spiral Stitch Coarse

Spiral Stitch Fine

Density

Run pitch

Specify the length of one stitch.

Short

Long

Stippling Stitch

Run pitch

Narrow

Wide

The pattern is finer.

The pattern is coarser.

Long
The turns are more
angled.

Spacing

Use Motif

To use a motif stitch in the pattern, select the check box, and then specify settings for the
following attributes.

Pattern and size of the
motif stitch patterns
H-Arrange
V-Arrange

cc

"Motif Stitch" in the "Line sewing attributes" on page 326

Offset
Spacing
Run pitch
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Short
Specify the length of one stitch.
This cannot be specified if the motif stitch is
The turns are
used.
smoother.

Sewing Attributes
Net Fill Stitch

Pattern

Specify the pattern to be used for the net fill
stitch.

Fine

Coarse

Spacing
The pattern is finer.
Direction

cc

The pattern is coarser.

"Motif Stitch" in the "Region sewing attributes" on page 337

Zigzag Net Fill Stitch

Pattern

Specify the pattern to be used for the
zigzag net fill stitch.

Under sewing

To specify underlay stitching, select the
check box.

Off

Zigzag width

cc

"Zigzag Stitch" in the "Line sewing attributes" on page 325

Density

cc

"Zigzag Stitch" in the "Line sewing attributes" on page 325

Fine

Coarse

Spacing
The pattern is finer.

The pattern is coarser.

H-Offset

cc

"Motif Stitch" in the "Region sewing attributes" on page 337

V-Offset

cc

"Motif Stitch" in the "Region sewing attributes" on page 337

Direction

cc

"Motif Stitch" in the "Region sewing attributes" on page 337
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Font List

Font List
Text
Text Outlines

Text Outlines

Min.
size

No.

Font Name

Min.
size

021

Gothic 04

10 mm
(0.39")

Font Name

001

Serif 01

10 mm
(0.39")

022

Decorative 04

10 mm
(0.39")

002

Script 01

10 mm
(0.39")

023

Decorative 05

8 mm
(0.31")

003

Gothic 01

10 mm
(0.39")

024

Gothic 05

10 mm
(0.39")

004

Serif 02

10 mm
(0.39")

025

Decorative 06

10 mm
(0.39")

005

Script 02

10 mm
(0.39")

026

Gothic 06

10 mm
(0.39")

006

Serif 03

8 mm
(0.31")

027

Block 07

10 mm
(0.39")

007

Block 01

9 mm
(0.35")

028

Gothic 07

10 mm
(0.39")

008

Block 02

10 mm
(0.39")

029

Brussels Demi
Outline

10 mm
(0.39")

009

Gothic 02

10 mm
(0.39")

030

Calgary
MediumItalic

10 mm
(0.39")

010

Block 03

10 mm
(0.39")

031

Istanbul

10 mm
(0.39")

011

Decorative 01

10 mm
(0.39")

032

Los Angeles

10 mm
(0.39")

012

Block 04

10 mm
(0.39")

033

Saipan

10 mm
(0.39")

013

Block 05

9 mm
(0.35")

034

San Diego

10 mm
(0.39")

014

Script 03

10 mm
(0.39")

035

Sicilia Light
Italic

10 mm
(0.39")

015

Decorative 02

20 mm
(0.79")

036

Alaska

10 mm
(0.39")

016

Decorative 03

10 mm
(0.39")

037

Bayern Book

10 mm
(0.39")

017

Script 04

10 mm
(0.39")

038

Belgium

10 mm
(0.39")

018

Gothic 03

10 mm
(0.39")

039

Bengal

10 mm
(0.39")

019

Script 05

10 mm
(0.39")

040

Bergen

10 mm
(0.39")

020

Block 06

9 mm
(0.35")

041 Berlin Regular

10 mm
(0.39")
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No.

Font List

Min.
size

No.

Font Name

Bermuda
Script

10 mm
(0.39")

065

Haiti

9 mm
(0.35")

043

Blackstone

10 mm
(0.39")

066

Helsinki
Narrow Bold

10 mm
(0.39")

044

BR-OCRA

10 mm
(0.39")

067

Hungary

10 mm
(0.39")

045

Brougham
Bold

9 mm
(0.35")

068

Jakarta

10 mm
(0.39")

046

Brougham
Condensed
ExtraBold

9 mm
(0.35")

069

Jawa

10 mm
(0.39")

047

Brunei

10 mm
(0.39")

070

Kentucky

10 mm
(0.39")

048

Brussels Light

10 mm
(0.39")

071

Kingston
Regular

10 mm
(0.39")

049

Cairo

10 mm
(0.39")

072

Letter Gothic
Bold

10 mm
(0.39")

050

Calgary
BoldItalic

10 mm
(0.39")

073

Lillehammer

10 mm
(0.39")

051

Calgary
BoldItalic LS

10 mm
(0.39")

074 Liverpool Italic

10 mm
(0.39")

052

Canberra

10 mm
(0.39")

075

Maryland

10 mm
(0.39")

053

Connecticut

10 mm
(0.39")

076

Miami Roman

9 mm
(0.35")

054

Cordoba

10 mm
(0.39")

077

Montreal

10 mm
(0.39")

055

Cyprus

10 mm
(0.39")

078

Panama Bold

8 mm
(0.31")

056

Equador

9 mm
(0.35")

079 Princeton Italic

10 mm
(0.39")

057

Epsom
Expanded

9 mm
(0.35")

080

Riesa

10 mm
(0.39")

058

Epsom

10 mm
(0.39")

081

Salamanca

10 mm
(0.39")

059

Firenze Bold
Expanded

10 mm
(0.39")

082

Seattle
BoldItalic

10 mm
(0.39")

060

Florida
Medium

8 mm
(0.31")

083

Sofia Bold

9 mm
(0.35")

061

Frankfurt Bold

9 mm
(0.35")

084

Helsinki

10 mm
(0.39")

062

Frankfurt
Medium

10 mm
(0.39")

085

Tennessee
ExtraBold

10 mm
(0.39")

063

Germany

10 mm
(0.39")

086

Themes

10 mm
(0.39")

064

BR Symbol

10 mm
(0.39")

087

Tianjin

10 mm
(0.39")

No.

Font Name

042
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Text Outlines

Min.
size

Font List

Min.
size

No.

Font Name

Tirol

10 mm
(0.39")

110

Modula
Outlined

19 mm
(0.75")

089

US Roman

10 mm
(0.39")

111

Modula Round
Serif Ultra

17 mm
(0.67")

090

Venezia

10 mm
(0.39")

112

Modula Sans
Bold

10 mm
(0.39")

091

Vermont

10 mm
(0.39")

113

Not Caslon
Two

30 mm
(1.18")

092

Wellington

10 mm
(0.39")

114

Remedy
Double

25 mm
(0.98")

093

Künstlerschreibschrift

10 mm
(0.39")

115

Sabbath Black
Regular

13 mm
(0.51")

094

Toms
Handwritten

10 mm
(0.39")

116

Senator Ultra

13 mm
(0.51")

095

Luedickital

10 mm
(0.39")

117

Soda Script
Bold

10 mm
(0.39")

096

Atranta Book

10 mm
(0.39")

118

Suburban
Light

10 mm
(0.39")

097

Atranta Demi

10 mm
(0.39")

119

Totally Gothic

10 mm
(0.39")

098

Montana

10 mm
(0.39")

120

Vista Sans Alt
Regular

10 mm
(0.39")

099

Base 900
Sans Heavy
Italic

10 mm
(0.39")

100

Base
Monospace
Wide Bold

10 mm
(0.39")

101

Blockhead
Alphabet
Darkside

15 mm
(0.59")

102

Dalliance
Roman

10 mm
(0.39")

103

Dalliance
Script

10 mm
(0.39")

104

Dogma Script
Bold

10 mm
(0.39")

105

Elliotts Apollo
Venus Dioxide

10 mm
(0.39")

106

Exocet
Medium

107

No.

Font Name

088

Text Outlines

Text Outlines

Min.
size

Small Text
Font Name

Text Outlines

Size

01

Utah Bold S

5-6 mm
(0.200.24")

02

Belgium S

5-6 mm
(0.200.24")

03

Calgary
MediumItalic S

5-6 mm
(0.200.24")

04

Utah SR

3-4 mm
(0.120.16")

13 mm
(0.51")

05

Calgary
MediumItalic
SR

3-4 mm
(0.120.16")

Los Feliz Bold
Italic

9 mm
(0.35")

06

Script 01 SR

4-6 mm
(0.160.24")

108

Mason Serif
Bold

12 mm
(0.47")

07

Block 03 S

109

Matrix Inline
Extra Bold

17 mm
(0.67")

5-6 mm
(0.200.24")
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No.

Font List

No.

Font Name

Text Outlines

Size

08

Block 07 SR

4-6 mm
(0.160.24")

09

Germany S

5-6 mm
(0.200.24")

10

Riesa S

5-6 mm
(0.200.24")

Monogram
Symbol

Font Name
Diamond

Script
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Troubleshooting

Troubleshooting
If a problem occurs, click
or [Help], then [Customer Support] in the menu to visit the following Web site,
where you can find causes and solutions to various problems and answers to frequently asked questions.
If you have a problem, check the following solutions. If the solutions suggested do not correct the problem,
contact your Baby Lock retailer.
Problem

The software is not installed
correctly.

The message "No Palette
Software Key is connected.
Please connect a Palette
Software Key." appeared.

When trying to upgrade from
an older version, the message
"Cannot connect to the
Internet." or "The server could
not be connected to. Wait a
while, and then try connecting
again." appeared and "Palette
Software Key" could not be
upgraded.

Estimated Cause

Solution

Page

An operation not described
in the installation procedure
was performed. (For
Follow the instructions as the software
example, Cancel was
installs to correctly install the software.
clicked or the "Palette
Software Key" was
removed before the
procedure was completed.)

The "Palette Software Key"
is not connected.

The information on the
"Palette Software Key" is
corrupted.

Check that the "Palette Software Key"
appears in the computer's list of
removable storage devices. If it does
not appear, unplug the "Palette
Software Key", and then plug it in again.

See "Reference
Guide".

Leave it plugged in, and uninstall, then
re-install Palette Ver.10.

To upgrade "Palette Software Key", the
computer with "Palette Software Key"
The computer with
connected to its USB port must connect
"Palette Software Key"
to the Internet. If firewall software is
connected to its USB port being used, it must be temporarily
could not establish a
disabled during the upgrade. If a
connection to the Internet. connection to the Internet cannot be
established, contact your Baby Lock
retailer.

Menus/Tools and Reference
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Troubleshooting

Possible Cause
Problem
Cause

When opening an embroidery
pattern
(Application button > [Open])

The error message
"Unexpected file format"
appears.
or
Your embroidery pattern or
image cannot be opened.

When importing embroidery
patterns
([Home] tab > [Import
Patterns] > [from File])

When opening a background
image
([Image] tab > [Open])
or When opening an image
for Stitch Wizard
(Auto Punch, Photo Stitch 1
and 2, and Cross Stitch)

When importing an image as
an embroidery pattern
([Home] tab > [Import
Patterns] > [from Vector
Image])

345

File Format

Solution

.pes

The data may be corrupted.

.phc (machine embroidery
format)

The file cannot be opened,
but it can be imported.
→ ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Other manufacturers'
compatible formats
(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,
.xxx, and .shv)

The file cannot be opened,
but it can be imported.
→ ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Incompatible formats

The file cannot be used.

.pes, .phc,
Other manufacturers'
compatible formats
(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,
.xxx, and .shv)

The data may be corrupted.

Incompatible formats

Convert the file to a
compatible format, such as
PES, and then use it.

.bmp, .tif, .jpg, .wmf, .png,
.eps, and .gif

The data may be corrupted.

Images in formats other than
those listed above

The file cannot be opened.
→ Use an image in one of
the formats listed above.

.wmf, .emf, and .svg

The data may be corrupted.

Vector images in a format
other than .wmf, .emf, or
.svg

Convert the file to the .wmf,
.emf, or .svg format, and
then import it.

Raster images (.bmp, .jpg,
etc.)

Currently, these files cannot
be imported. Open them in
the background and use
them for tracing.

New Features of Palette Ver.10

New Features of Palette Ver.10
New Palette Security
Device
• The Palette Software Key replaces the card writer
as the security device for Palette Ver.10. (cc p. 7)

Displaying Thumbnails of
Embroidery Files
• Embroidery (PES) files can be displayed as
thumbnails in Windows® Explorer. (cc p. 304)

Improved Functions for
Editing Patterns as
Outlines
• Multiple lines indicating the sewing directions of
an outline pattern can be specified. Sewing
direction lines can be added, moved, deleted and
reversed without changing the shape of the
outline pattern. (cc p. 51)
• Blocks entered with Manual Punch tools can be
edited as outline patterns. (cc p. 197)
- In this way, gradations, entry/exit points, under
sewing and line sewing can be specified for
blocks.

Enhanced Functions for
Creating Stitching
Variations
• The stitching variations available for line sewing
(Line sew type) has been increased. (cc p. 329)
- Chain Stitch
- Cutting
• The stitching variations available for region
sewing (Region sew type) has been increased.
(cc p. 339)

• Convert to Outline commands for stitch patterns
have been added. These commands convert
stitch patterns to shape patterns. (cc p. 76)
• The functions for editing points in stitch patterns
have been improved.
- The Split at Point command splits one stitch
pattern into two. (cc p. 73)
- The Connect Points command connects two
stitch patterns to create a single one. (cc p. 73)
• The functions for editing points in shape patterns
have been improved.
- The Split at Point command splits one open
shape pattern into two and splits one closed
shape pattern into an open one. (cc p. 68)
- The Connect Points command connects two
shape patterns to create a single one and
connects the two end points of an open pattern
to create a closed one. (cc p. 69)
• The Split Outline tool has been added. This tool
splits off the part of the shape pattern enclosed by
the specified points. (cc p. 42)
• The Fabric Selector command has been added.
This command allows you to change the current
sewing attribute settings to the recommended
settings for the selected fabric type. (cc p. 17)
• The Matrix Copy command has been added.
This command creates copies of the selected
pattern at an equal distance apart. (cc p. 37)
• The Paste Attributes command has been added.
This command allows the colors, sew types and
sewing attributes from the copied pattern to be
pasted to the selected pattern. (cc p. 55)
• EMF and SVG files can also be converted to
embroidery data. (cc p. 93)
• The Gradation Pattern Setting dialog box has
been improved. The gradation of patterns can
more easily be adjusted. (cc p. 47)
• Patterns can be imported from Design Center into
Layout & Editing as shape patterns. (cc p. 94)

- Net Fill Stitch
- Zigzag Net Fill Stitch
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- In addition, blocks can be edited using shapeediting functions, such as the Remove Overlap/
Merge, Set Hole Sewing and Create Offset
Lines commands as well as the Applique
Wizard.

• The Optimize Sewing Order command has been
added. This command adjusts the sewing order
and entry/exit points to reduce the number of
thread color changes and jump stitches.
(cc p. 83)

New Features of Palette Ver.10

Additional and Enhanced
Wizards
• The Embroidered Patch Wizard has been
added. This wizard creates satin stitches and
cutting lines around the original selected pattern.
(cc p. 166)
• The Cutwork Wizard has been added. With this
wizard, a cutwork pattern can easily be created.
(cc p. 169)
• The Applique Wizard has been enhanced.
(cc p. 161)
- This wizard can be used with combination
patterns that include both stitch patterns and
text patterns.
- This wizard can also create appliqué patterns
around the original selected pattern.
• The Startup Wizard has been enhanced. This
wizard enables access to the desired functions
and files with a single click. (cc p. 10)
• Functions in the Photo Stitch 1 have been
improved. (cc p. 142)

Improved User Interface Is
Easier To Use
• RichFaces Context menus from right-clicking
have been incorporated into the advanced user
interface. These menus allow users to easily find
the desired commands.
• The Guideline function has been added. This
function helps you align the embroidery patterns.
(cc p. 19)
• The Show Stitched Objects command has been
added. This command allows embroidery
patterns to be displayed or hidden in the Design
Page. (cc p. 82)
• The Hide Objects Not Stitched command has
been added. This command allows frames
containing patterns that will not be sewn to be
displayed or hidden in the Sewing Order pane.
(cc p. 85)
• The function for displaying entry/exit points has
been improved. This function also displays the
entry/exit points of next (or previous) patterns in
the sewing order. (cc p. 50)
• The color list can be set to display Color changes
or Total colors. (cc p. 88, 97, 255)
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• The Import pane has been enhanced. From this
pane, embroidery patterns can be easily added to
the Design Page. (cc p. 13)
• The Measure tool has been improved. (cc p. 78)

Enhanced Lettering
Functions
• Font/character variations have been increased
and improved. (cc p. 340)
- The number of regular built-in text fonts has
been increased to 120 types.
- The number of built-in Small Text fonts has
been increased to 10 types.
- The number of symbols and accented
characters has been increased for some regular
built-in fonts.
- The characters for some regular built-in fonts
have been improved. In addition, the character
spacing and the size of characters have been
adjusted.
• The user interface for selecting the font has been
improved.
- The names of built-in fonts appear in the Font
selector. (cc p. 107)
- The recommended minimum size of regular
built-in fonts appears in the Font selector.
(cc p. 107)
- The Font Filter command has been added.
This command filters the fonts in the Font
selector to list the selected font types.
(cc p. 108)

Others
• Embroidery sample variations have been
increased.
• A new embroidery frame setting (240 × 360 mm
frame) is available in the Design Settings dialog
box. (*Availability depends on the embroidery
machine model.) (cc p. 15)

Index
A
Access key ................................................................ 299
Advanced stitch wizard ............................................. 147
Aligning
Embroidery patterns ............................................ 32
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